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Predmluva

Publikace ,, Uvod do matematického modelovdni s vyuZitim Maple* vznikla v souvislosti
s feSenim projektu ESF ¢&. CZ.1.07/2.2.00/07.0318 ,VICEOBOROVA INOVACE STUDIA
MATEMATICKE BIOLOGIE, ktery si klade za cil inovovat naplii a provazanost predméti
z kmenového souboru predmétii oboru ,,Matematicka biologie*, studijniho programu ,,Biolo-
gie* Prirodovédecké fakulty MU, profilujicich studijni obor a zajisfovanych pracovniky IBA
MU.

Oproti koncepci az dosud pouzivaného ucebniho textu: ,,Jird Hrebicek, Michal Skrdla:
Uvod do matematického modelovdni* zaméfeného spise na obecné metody matematického
modelovani, je predklddand monografie orientovana vice do oblasti praktického feSeni bi-
ologickych modeli pomoci systému pocitacové algebry Maple, véetné reseni problematiky
neurcitosti a citlivosti parametri modelu.

Publikace prinasi vhodné postupy a metody pro feseni vybranych biologickych modelfi.
Je mozné ji vyuzivat ve studiu matematického modelovani dvéma zptisoby. Studenttim, kteri
maji vétsi matematické a informatické znalosti (naptiklad v oboru ,,Matematicka biologie®,
pfipadné dalsich studijnich obort a programi MU) bude poméhat v tom, jak pouzivat a
vytvaret modely v systému pocitacové algebry Maple. K tomu jim budou slouzit vSechny
kapitoly publikace. U studenti s niz$imi matematickymi a informatickymi védomostmi (ty-
picky studenti dalsich biologickych ¢&i zdravotnickych oborii, piipadné dalsich programi MU)
nebude tfeba studovat kapitolu popisuji systém Maple. Bude jim stacit nastudovat demon-
strativni praktické ptriklady v systému Maple k lepsimu pochopeni metodiky matematického
modelovani.

Vytvoreny text pomiize zkvalitnit vyuku jednoho z kmenovych predméttt oboru ,,Ma-
tematicka biologie“ pomoci vybranych specialnich prikladt feseni problémt matematického
modelovani, kde se vyuziva novych e-learningovych vlastnosti Maple. To umozni pouzivat
tuto publikaci rovnéz vysokoskolskym ucitelim ke zlepSeni jejich pedagogické dovednosti
pomoci efektivniho vyuzivani systému Maple pti vyuce feSeni ilustrativnich prikladid mate-
matického modelovani v biologii.
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1 Uvod do matematického modelovani
a jeho ¢lenéni

Matematické modelovani proniklo do rtiznych obort pfirodnich, technickych, ekonomic-
kych i socialnich véd a stalo se dilezitym néastrojem pfi modelovani a simulacich systémii,
analyzach a predvidani riznych procesti, jevil, chovani druhtl a stavti spolecenstev apod. V
dalsim textu se zaméfime na matematické modelovani systémi, kde systémy budeme chapat
jako urcité abstrakce realného svéta (objektivni reality), které si lidé vytvareji v procesu jeho
poznani. Jako systém budeme zjednodusené uvazovat (nasledujici vycet je netiplny) napf.:

a)

Proces, komplex procesi, (napt. pohyb kyvadla, tok elektrického proudu v obvodu,
rozmnozovani bunék a organismii, apod.), jimz rozumime zékonité, na sebe navazujici
a vnitiné propojené zmény néjakého objektu. Proces lze Casto ¢iselné vyjadrit casovym
pribéhem néjaké hodnoty, resp. skupin hodnot. Miizeme davat pfednost obecnéjsimu
vyjadreni, kde misto ¢isel vystupuji prvky néjaké mnoziny. Pak systémem nazyvame
kazdy objekt (konkrétni nebo abstraktni), jenz vstupnimu procesu urcitého typu pii-
fazuje vystupni proces téhoz nebo jiného typu. Toto prifazeni, které popisuje reakce
vystupi na vstupy, se nazyva chovanim systému, a proto se tato definice nazyva beha-
vioristickd (behaviour - angl. chovani). Misto slova ,pfifazeni“ ¢asto pouzivame i slovo
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tému opravdu transformuje vstupni procesy na vystupni, tj. pretvaii je.

Takovy objekt (ptirozeny ¢i umély), ktery v kazdém ¢asovém okamziku mé na vstupu
néjaky vstupni prvek, na vystupu néjaky vystupni prvek a kromé toho je vzdy v néja-
kém vnitinim stavu, pricemz jsou dany jednoznacné zavislosti

e stavajiciho vystupniho prvku na stavajicim stavu a vstupnim prvku,

e nasledujiciho stavu na stavajicim stavu a vstupnim prvku.

Tato definice se nazyva stavovd a je ekvivalentni s prvni definici, tj. kazdy objekt
vyhovujici definici prvni vyhovuje i definici druhé a naopak.

Soubor nejakych prvki a vazeb mezi nimi, napt. souziti dravce a jeho koftisti; vyroba
jefabu s predepsanou nosnosti, minimalizace spotfeby vozidla na danou vzdalenost
apod. S pouzivanim této definice vSak nastavaji urcité potize. Neni snadné interpre-
tovat slovo ,vazba“, a ne kazdy objekt, ktery 1ze intuitivné zcela zfejmé povazovat za
systém, je komponovan z nékolika jasné odlisitelnych prvki.

Soubor informacnich, requlacnich a Fidicich ¢innosti vztahujicich se k a) — ¢), napf.: in-
formacni systém, fidici systém, komunikacni systém, regulac¢ni systém.

Abstraktni myslenkovou konstrukci, vyrokovou konstrukci, konstrukci matematickych
vyrazi apod. zavadéném na a) — d).



f) Abstraktni mySlenkovou konstrukei atd. vytvafenou bez pfimého vztahu k a) — d).

Pouziti matematického modelu systému prinasi fadu vyhod:

e Umoznuje zjistit informace o chovani systému, i kdyz z skute¢ného systému je to ne-
mozné nebo obtizné.

e Urychluje proces poznani objektivni reality. Procesy, které ve skutecném systému pro-
bihaji pozvolna a dlouhodobé, 1ze pomoci modelu sledovat zrychlené béhem simulace
(vypoctu), ktera zavisi na pouzité informacni a komunikaéni technologii (ICT).

e Usnadnuje a racionalizuje proces poznani. Matematicky model systému dava pte-
hledna, stru¢na zobrazeni objektivni reality a umoznuje postup pii feSeni problému
podle potifeby uzivatele. Modely vnaseji nové poznani do naseho mysleni.

e Umoznuje variantni feseni, tj. simulaci a propocet celé fady variant moznych vysledkt
feSeni.

e Identifikuje vznik chybného poznani objektivni reality (na rozdil od experimentu v re-
alném systému).

Modelovani byva vétsinou pojiméno jako transdisciplindrni ¢innost, nebot se na ném
mohou podilet poznatky z matematiky a fyziky, teorie systémii, teorie pravdépodobnosti,
informatiky, kybernetiky ¢i kognitivnich véd, opera¢niho vyzkumu a jinych. Matematické
modelovani ziskava v poslednich letech velky vyznam v praxi, ale také ve vyuce studenti na
vysokych skolach prirodovédného, technického i ekonomického zamétreni. Do matematického
modelovani, stejné jako i do jinych odvétvi védy, proniklo jiz od Sedesatych let minulého
stoleti vyuziti informacnich a komunika¢nich technologii (ICT). Nyni si bez jejich vyuziti
neumime matematické modelovani predstavit. Pozadavky na tyto pocitacové aplikace —
symbolické a numerické vypocty, na jejich vysokou presnost, vizualizaci a interaktivni ko-
munikaci s feSitelem atd. — vedly k vytvoreni komplexnich aplika¢nich programt jako jsou
napf. komeréni programy: Matlab od firmy Mathworks Inc.!, Maple od Maplesoft Inc.?,
MathCAD od MathSoft Inc.?, Mathematica od Wolfram Reasearch, Inc.*, MuPAD?® vyvi-
jeny universitou Paderhorne a firmou SciFace Software GmbH® atd. Podrobné&jsi informace
1ze nalézt na webu’.

Z volné ptistupnych (open source) programi zminime napi. programy: MAXIMA pro sym-
bolické vypocty®, OCTAVE pro numerické vypocty’ a R pro statistické vypoéty!. Tyto
aplikac¢ni programy lze vyuzit v matematickém modelovani béhem celého vyvojového pro-
cesu, tj. identifikace, analyzy, vyvoje, implementace, feSeni a ovéfovani, piipadné modifikace
matematického modelu. Volné pristupné zdroje odborné literatury k této problematice lze
nalézt na webu'l.

‘http://www.mathworks.com
2http://www.maplesoft.com
3http://www.mathsoft.com
‘http://www.wolfram.com
Shttp://research.mupad.de/
Shttp://www.sciface.com/
"http://www.symbolicnet.org/www-sites.html
8http://maxima.sourceforge.net/
http://www.gnu.org/software/octave/index.html
Ohttp://www.r-project.org/
Uhttp://www.symbolicnet.org/lit.html
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V soucasné dobé se pouzivaji nékteré vyse uvedené systémy (napt. Maple, Matlab a Mathe-
matica) na vysokych skolach pro demonstraci probirané latky na cvi¢enich, pfipadné jsou
vyuzivany studenty pfi individualni pripravé, analyze a feseni problémii, které jim zadavaji
jejich ucitelé nebo vyplyvajicich z jejich zavérecnych praci.

Charakteristickym rysem inovace vyuky matematického modelovani ve studijnich pro-
gramech vysokych kol v Ceské i Slovenské republice, Evropské unii a v zemich OECD se
v poslednich deseti letech stava pouzivani novych ICT (napf. Grid Computing!?, Cloud
Computing'®) v ramci budovani nového védniho oboru ,,Computational Science® a ,,Mathe-
matical Modelling® [7].

Cilem stale vice vysokych skol je ovSsem zafadit do vyuky pfedmét seznamujici studenty
s praci ve vySe uvedenych systémech, na které maji zakoupenu licenci, a vyuzit jejich moz-
nosti pfi navrhu, analyze, feSeni a testovani netrividlnich matematickych modeld. To je
rovnéz cilem této publikace, kde nejprve uvedeme, co je matematicky model a metodologie
matematického modelovani. Na praktickych piikladech ukazeme vyuziti systému Maple pro
matematické modelovani.

Pristup k matematickému modelovani s vyuzitim ICT lze rozdélit do ,black-box“ mode-
lovani'*, ,white-box“ modelovani a ,shadow-box“ modelovani, podle toho, v jakém rozsahu
jsou pfedem znamy informace o systému a zptisobu jeho feseni.

Black-box model je systém, o kterém neni zndma a priori informace. White-box model
je systém, kde jsou znamy vsSechny potiebné informace. Prakticky vSechny znamé zptisoby
matematického modelovani s vyuzitim ICT nalezi mezi black-box a white-box feseni modeli.
Nedavno bylo zavedeno tzv. shadow-box modelovani, kdy uzivatel vyuziva jako zakladni
black-box modelovani a muze si zvolit alternativné white-box modelovani pri feSeni modelu
systému. Toto umoznuje pravé systém Maple, ktery je v tomto sméru nejvice rozvinut.

Obvykle je lepsi pouzivat co nejvice a priori informaci, pokud je to mozné, a vytvorit
mnohem presnéjsi matematicky model systému. Tudiz white-box modely jsou obvykle po-
vazovany za vhodnéjsi, protoze pokud se pouzily informace o systému spravné, pak model
i jeho feseni se budou chovat spravné. Casto je apriorni informace dana v podobé znalosti
typu funkci tykajici se jejich riznych proménnych. Naptiklad, kdyz chceme vytvorit model,
jak 1ék funguje v lidském organismu (systému), vime, Zze obvykle mnozstvi 1éku v krvi v ¢ase
je exponencialné klesajici funkce. Vime vsak, ze jsou zde jesté dalsi nezndmé parametry urcu-
jici, jak rychle se mnozstvi léku v krvi vstieba, a jaké je ptivodni mnozstvi léku v krvi. Tento
priklad tedy neni typu white-box model. Jeho parametry musi byt odhadnuty prostfednic-
tvim néjakych jinych lékarskych metod, a teprve poté je mozné pouzit model s exponencialné
klesajici funkci.

1.1 Matematicky model

Matematicky model je abstraktni model'®, ktery vyuzivd matematického jazyka k
popisu chovani systému. PouZiva se pfevazné v piirodnich (fyzika, biologie, chemie apod.)
a technickych (strojirenstvi, elektrotechnika, stavebnictvi apod.) védach, ale také ve spolecen-
skych védach (ekonomie, sociologie, politické védy apod.). Matematicky model transformuje
systém do matematického zapisu, ktery ma nasledujici vyhody:

2http://en.wikipedia.org/wiki/Grid_computing

Bhttp://en.wikipedia.org/wiki/Cloud_computing

Ynhttp://en.wikipedia.org/wiki/Black_box_(systems)

15 Abstraktni model (nebo konceptualni model) je teoreticka konstrukce, ktera reprezentuje fyzikalni, bio-
logicky nebo socidlni ¢i ekonomicky proces. Sestdva z mnoziny proménnych a mnoziny logickych nebo kvan-
titativnich vztahi mezi proménnymi.
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e formalizaci zdpisu danou historickym vyvojem (v soucasné dobé je vyvinuta uznévand
mezinarodni standardizace),

e presna pravidla pro manipulaci s matematickymi symboly a strukturami,

e moznost vyuziti ICT pro zpracovani a feseni vytvoreného modelu.

I pres velky potencial matematického zapisu jim neni mozné popsat realné systémy, ob-
jekty ¢i procesy, které jsou velmi komplikované. Proto musime nejdiive identifikovat nej-
dtlezitéjsi casti zkoumaného systému, jenz budeme modelovat, a ty musi vytvareny model
popisovat. Ostatni prvky systému muzeme bud podstatné zjednodusit, nebo zcela vyloucit.

1.1.1 Zakladni prvky matematického modelu

Matematicky model obvykle popisuje systém s pomoci mnoziny vstupnich a vystupnich
proménnych, dale parametrii a mnoziny rovnic, které urcuji stavy systému a vztahy mezi
proménnymi a parametry. Hodnoty proménnych mohou byt napft. redlnd nebo celd ¢isla,
néjaké vlastnosti systému, napft. vystupy mérenych systémi casto ve tvaru signald, vzor-
kovanéa data, hodnoty poditadla, vyskyt dané udélosti ¢i jevu (ano/ne) apod. Na model se
miizeme divat také jako na mnozinu funkci, které popisuje vztahy mezi riznymi proménnymi.

V kazdém matematickém modelu mizeme rozlisit tii zakladni skupiny objekti, ze kterych
se model sklada. Jsou to:

e proménné a parametry,

matematické struktury,

feSeni.

7Z hlediska ICT miiZzeme proménné a parametry v modelu uvazovat jako:

e Identifikované (pojmenované) proménné a parametry. Identifikovana proménna
nebo parametr predstavuje konkrétni vlastnost realného objektu, pojmenovanou na-
zvem a fyzikalni jednotkou, v niz se méri.

Priklady: x) je vimeéra psSenice ozimé v hektarech, x, produkce psenice ozimé na parcele
,U kiizku“ v tunach, ¢;;, vzdalenost dodavatele D; od spotiebitele S v kilometrech.

¢ Neidentifikované (pomocné) proménné a parametry. Slouzi pro formalizaci ma-
tematického zapisu, implementaci algoritmt apod. Obvykle se uvazuji v bezrozmérnych
jednotkach.
Priklad: U linearniho programovani se zavadéji pomocné proménné, které umozni zme-
nit ,nerovnice na rovnice“.

e Nekontrolovatelné proménné. Predstavuji procesy v systému, jejichz miry nelze
zjistit (jedna se o dalsi typ neurcitosti).
Priklady: V modelech kilmatu ,,ad hoc“ jsou charakteristiky pocasi nekontrolovatelné
parametry nebo promeénné, protoze nelze vyuzit poctu pravdépodobnosti pro jejich
popis. Velikost miry inflace v chaotickych a nestandardnich trznich podminkach nelze
popsat ani pomoci pravdépodobnosti ani pomoci fuzzy funkce.



1.2 Klasifikace matematickych modela

Béhem identifikace a analyzy modelovaného systému je vhodné urcit, do jaké kategorie
matematicky model spadé, coz nam umozni snadnéji rozpoznat zakladni vlastnosti a struk-
turu hledaného modelu.

Podle toho, zda zahrnujeme do modelu nahodné veli¢iny, lze modely rozdélit do dvou
skupin: deterministickych a stochastickych modelu. Dale 1ze tyto skupiny rozdélit dle vztahu
k pribéhu casu (dynamicke, statick€) nebo spojitosti (spojité, diskrétni).

Matematické modely obsahuji proménné, jez jsou abstrakci hledanych prvkta systému
a operatord nad témito proménnymi. Operatory mohou reprezentovat algebraické operace,
funkce, funkcionaly, diferencialni operatory atd. Pokud jsou operatory v matematickém mo-
delu linedrni, hovotime o linedrnich modelech, v opacném pripadé o nelinedrnich modelech.

Mizeme také uvazovat modely se soustiedénymi (u homogennich modeltt) a distribuova-
nymi (u heterogennich modelii) parametry. Mezi témito skupinami lezi mnoho jinych typt
modeld, déale tridénych podle mnoha dalsich kriterii, které 1ze vyuzit.

Matematické modely se pouzivaji prakticky ve vsech védach a rozvoj jednotlivych véd
je na jejich vyuzivani bezprostifedné zavisly. Stupen ,matematizace* védniho oboru je uzna-
vanym méfitkem jeho kvality a zarukou rozvoje. V oblastech pfirodnich a fyzikalnich véd,
technice, ekonomii, managementu, marketingu, socidlnich a spolecenskych védach se pou-
ziva velké mnozstvi riznych typtd matematickych modelti, které mtzeme klasifikovat podle
riznych hledisek. Nejobecnéjsi klasifikace déli matematické modely do dvou skupin:

e Modely deskriptivni. Slouzi k zobrazeni prvki a vztahil v systému a k analyze za-

kladnich vlastnosti systému. Nezajima nas urcité cilové chovani systému, ale pouze
systém sam o sobé. Pomoci téchto typt modelt se odvozuji dalsi vlastnosti systému,
urcuje se jeho rovnovazny stav, stabilni stav, vliv zmén uvnitt i ve vnéjsim okoli sys-
tému na jeho chovani.
Priklady: Rovnice E = mc?, soustava diferencidlnich rovnic modelujici procesy na-
rozeni a umrti, simula¢ni model modelujici vyskyt sktidcti porostu, rovnice nabidky
a poptavky v konkurenc¢nim prostiedi, ekonometricky meziodvétvovy model , Input-
Output® atd.

e Modely normativni. SlouZi k analyze a Fizeni systému tak, aby byl splnén néjaky
cil nebo mnozina cili. Zajima nas cilové chovani systému. Normativni model byva
¢asto doplnén tzv. cilovou (celovou) funkei nebo soustavou takovych funkei. Nutnou
sou¢asti normativniho modelu je extremdlni (minimalni/maximéalni{) feSeni, které dava
navod, jak pozadovaného cile (resp. cili) dosdhnout. Normativni modely, jejichz cilem
je nalezeni optimalniho feSeni, se nazyvaji optimalizacni modely.

Modely deskriptivni i normativni jsou déale déleny podle typu systému, k jehoz modelovani
slouzi, nebo podle typu matematickych slozek (proménné, struktury, feseni), jez obsahuji:

e Modely statické. Model popisuje a analyzuje systém bez zietele k jeho ¢asovému vy-
voji. Zobrazeni se tyka zpravidla uréitého ¢asového intervalu (tyden, mésic, rok apod.).

e Modely dynamické. Model popisuje a analyzuje systém v pribéhu ¢asu. Zobrazeni
miize byt typu ,ex post® nebo ,ex ante“ a respektovat kratky ¢i delsi casovy horizont.

e Modely dynamizované. Zpravidla se jedna o zahrnuti faktoru ¢asu do dosud static-
kého modelu pomoci specialnich modelovych technik. Dynamizované modely se pouzi-
vaji v pripadé, kdy odpovidajici dynamicky model je velmi slozity nebo jej nedovedeme

7



soudobymi modelovymi technikami spolehlivé konstruovat.
Priklad: U linearniho programovani k pravé strané maticové rovnice A - x < b pridame
casovy vektor u(t).

e Modely deterministické. Vsechny proménné, parametry a funkce v modelu jsou
deterministické (nenédhodné) veli¢iny nebo funkce.

e Modely stochastické. Alespon jedna proménna, parametr nebo funkce v modelu je
nadhodna veli¢ina nebo nahodna funkce.

e Fuzzy modely. Nékteré proménné a parametry jsou ,fuzzy“ (nepfesné ohrani¢ené,
neostré, neurcité, vagni). Funkce ptislusnosti ve fuzzy logice jim umoziuje pfifadit pii-
slusnost k mnozindm v rozmezi od 0 do 1, véetné obou hrani¢nich hodnot. Uplatnéni
fuzzy modelovani je ucelné ve vSech ptfipadech, kdy se fesi problém spojeny s neurci-
tosti, s nepresnosti a musi se pracovat s neurc¢itymi daty a pouzivani presnych popist
by vedlo k idealizovani skutecnosti redlného svéta a tedy k odklonu od reality.

Podle povahy problému se modely pouzivaji individualné nebo v kombinacich. Pro reseni
znamych problémi lze pouzit tzv. standardni modely. Pro feseni novych problémi je tfeba
konstruovat nové modely.

1.3 Modelovani neurcitosti, nejistoty a rizika

1.3.1 Modelovani neurcitosti

Neurcitost zde chapeme jako vlastnost systému, kdy jej nelze presné matematicky popsat
nebo kdy matematicky popis neumozinuje dostatecné presné predikovat jeho budouci chovani.
Obecné se da fici, ze zdrojem neurcitosti je nedostatek informaci. Problémem je, Ze informace,
ze kterych pii tvorbé modelu vychazime mohou byt nekompletni, vzajemné si odporujici,
nespolehlivé, vagni nebo jinak nedostacujici. Tyto nedostatky v potfebnych informacich maji
za nasledek rizné druhy neurcitosti. Nejistotou pfi transformaci systému do matematického
modelu rozumime situaci, kdy nemame k dispozici vSechny potfebné informace nebo kdy
nékteré z informaci jsou nespolehlivé.

Pro jednoduchost miizeme neurcitosti ovliviiujici model rozdélit na t¥i spolu souvisejici
kategorie [31]:

a) neurcditost v matematickém popisu modelu je vysledkem nedostatecné znalosti
chovani modelovaného systému, netiplnych exaktnich dat, ¢i zjednoduseni, které bylo
nutné provést pro matematicky popis. V literatuie je mozné setkat se s pojmy struk-
turdlni (konstrukéni) chyba, konceptuélni chyba, neurcitost v konceptualnim modelu,
nebo chyba/neurcitost modelu, které ¢astecné ¢i zcela odpovidaji tomuto druhu neur-
¢itosti.

b) datova neurcitost neboli neurcitost v datech je zpisobena chybami méfeni, nepfes-
nosti analytickych metod a omezenym mnozstvim vzorki pii sbéru a zachazenim s daty.
Datovou neurcitost nékdy nazyvame odstranitelnou neurcitosti, nebot je mozné ji dal-
§im studiem (méFenim) minimalizovat. Specidlné pro tento druh neurcitosti pouzivame
v Cestiné termin nejistota.

c¢) neurditost v aplikaci modelu vyjadiuje neurcitost (chybu), ktera vznikne pouzitim
modelu. V tomto piipadé se jedna zejména o FeSeni matematickych rovnic popisujicich
model pomoci nastroji ICT.



Analyza neurcitosti vySetifuje zminéné neurcitosti ve vstupu a jejich vliv na vystup mo-
delu. Zpravidla se sklada z nasledujicich krok:

e charakterizace vstupnich neurcitosti -—— odhad neurcitosti ve vstupu a parametrech al-
goritmu modelu;

e Sitent neurcitosti -— odhad neurcitosti ve vystupu zpiisobené neurcitostmi na vstupu
modelu;

e charakterizace neurcitosti modelu -— charakterizace neurcitosti spojend s jinymi struk-
turami algoritmu modelu a formulacemi modelu;

e charakterizace neurcitosti v predikcich algoritmu modelu -— vychéazi z neurcitosti ve vy-
hodnocenych datech.

Neurcitost ma (nejméné) dvé vzajemné komplementarni stranky: vdgnost a nejistotu.
Véagnost lze modelovat napt. pomoci teorie fuzzy mnozin, zatimco nejistotu napt. pomoci te-
orie pravdépodobnosti a popi. dalsich teorii, jako je teorie moznosti, rizné miry vérohodnosti
apod. Mizeme tedy Tici, ze pravdépodobnost nam odpovida na otazku, zda ,néco nastane®,
zatimco teorie fuzzy mnozin nam odpovida na otazku, ,,co vlastné nastalo“. Je ziejmé, ze pii
matematickém modelovani systému s neurcitostmi se vyskytuje jak nejistota, tak vagnost.
Ze studijnich uceli vsak lze obé tyto stranky oddélit a zabyvat se pouze jednou z nich.

Podle [24] muZeme Fici, Zze , Predmétem teorie pravdépodobnosti je studium a modelo-
vani nejistoty. Ta nastdva tehdy, jestlize se setkdvdme s néjakym jevem, ktery miZe, avsak
nemusi nastat. Nemdme tedy jistotu, Ze jev opravdu nastane. Zdakladnim pojmem v teorii
pravdepodobnosti je rozdeleni pravdépodobnosti. To charakterizuje zpiusob nastani jevi vybi-
ranych z néjaké mnoziny ruznych jevi, o nichZ vime urcité jen to, Ze jeden z nich nastane.
Pravdépodobnost nam pak ddvd informaci o tom, zda nastdni nékterého z uvaZovanych jevi
muzZeme ocekdvat s vétsi jistotou, neZ nastdni jineho jevu.“

Naproti tomu uvazujme napt. objekty s urcitou vlastnosti a na otazku, jakou maji ,,vlast-
nost* odpovime, ze by ji mohly mit, nez, Ze ji maji ¢i ne. Jde totiz o vymezeni vlastnosti
a nikoliv toho, zda ji jev ma ¢i ne. Zakladnim pojmem je zde fuzzy mnozina objektt a funkce
prislusnosti objektu do ni. To znamena, ze prvek patii do mnoziny s jistou mirou pfislusnosti
— stupném pfislusnosti. Funkce, ktera kazdému prvku universa prifadi stupen pfislusnosti,
se nazyva funkce prislusnosti. Funkce prislusnosti, stejné jako pravdépodobnosti, mohou na-
byvat hodnot z intervalu [0, 1]. To je vSak jen vnéjskova shoda s teorii pravdépodobnosti.

Fuzzy logika umoznuje zahrnout nepresnost a pomérné jednoduchym zpusobem pracovat
s vyznamy slov prirozeného jazyka. PouZiva vagne charakterizované expertni znalosti. Tedy
pravy opak toho, co se vZdy poZadovalo — vétsi presnost. NardzZime na redlny rozpor, jehoz
reseni neezistuje. Jde o vztah mezi relevanci a presnosti informace. Princip, ktery L. A. Za-
deh nazval principem inkompatibility“, lze charakterizovat takto: Chceme-li popsat realitu,
pak musime rozhodnout mezi relevanci informace, kterd bude meéné presnd, nebo presnosti
informace, ktera vsak bude meéené relevantni. Pri zvysovdani presnosti se dostaneme k bodu,
kdy presnost a relevance se stdvaji vzdjemné se vylucujicimi charakteristikami.” [24]

Priklad: Instrukce k zaparkovani auta: ,pooto¢ kola o 19° 25.32" a popojed o 368.1256
mm dozadu“ — jednak by se tato informace zdlouhavé a slozité chystala a také by bylo
obtiZzné ji presné splnit. Staci Fict: ,pooto¢ kola mirné doleva a popojed o maly kousek
dozadu.” K vyjddrent relevantni informace je nezbytné pouzit prirozeny jazyk. Je to dosud
jediny dokonaly prostredek, ktery nam umozniuje efektivné pracovat s vagnimi pojmy.“ [24]

Ukazuje se, Ze presnost matematického modelu je pouze iluze, nebot je principidlné ne-
dosazitelna. Snaha o absolutni presnost nas vzdy dovede ke sporu. Neni vSak tifeba litovat,



nebot vagnost, kterou pfirozeny jazyk umi dokonale vyuZit, je jeho hlavni silou, nikoliv
nedostatkem.

Castd namitka, ze to, co je feseno pomoci fuzzy logiky, lze fesit i bez ni, neobstoji.
Rozdil mezi klasickym fesenim a fesenim pomoci fuzzy logiky je v ¢ase a s tim souvisejicich
nakladech. Trvalo by to mnohem déle, abychom dosahli stejného efektu (spravnosti). Nalezeni
matematického popisu miize byt v praxi velmi obtizné. Casto je popis velmi sloZity, a nasledné
pouziti modelu neni zrovna snadné. Proto se bud pouzivaji pfiblizné metody nebo se pfijimayji
rizna zjednoduseni a vysledek pak nemusi byt uspokojivy.

Pfi feSeni pomoci fuzzy logiky je navic vétsi jistota, ze dané feSeni (model systému) bude
robustnéjsi vzhledem k ndhodnym poruchédm a nepfedvidanym situacim, které pochopitelné
lze ocekévat.

K vyjadfeni relevantni informace je mozné pouzit pfirozeny jazyk. S pocéitacem vSak neni
mozné komunikovat v pfirozeném jazyce, a proto jsou nezbytna jista zjednoduseni. Obvykly
zptisob je pouziti pravidel typu JESTLIZE-PAK. Tato pravidla jsou zakladem vSech tvah
a zdkladem c¢innosti vSech algoritm.

Priklad: JESTLIZE sklon svahu je velky a srazky jsou intenzivni, PAK se svah velmi
rychle sesune.

Modelovani pfi riziku predpoklada, ze nékteré informace jsou ndhodné veli¢iny, nebo
ze nékteré procesy jsou popsany nahodnymi funkcemi. V pfipadé modeli s rizikem mizeme
velikost rizika pii pfijeti feSeni popsat pomoci pravdépodobnostnich charakteristik [24].
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2 Metodologie matematického
modelovani

Na obrazku 2.1 je znazornén proces zkoumani systému, ktery zacind monitoringem a
sbérem dat o systému, pokracuje jejich vstupem do matematického modelu a na zakladé
analyzy vysledku feseni modelu (porozuméni, predikce a kontrola jeho chovéni), je provedena
pripadna tuprava modelu a pfizptisobeni sbéru dat. Pokud to nevede k uspokojivému feseni,
provedou se na zkoumaném systému nové experimenty, piipadné se modifikuje matematicky
model.

pOroZUuman

7

'“m I I —I- predikce

kantrola

Obrazek 2.1: Proces zkoumdni systému s vyuZitim matematického modelovdni

2.1 Obecné zasady matematického modelovani

Matematické modelovani je odborna a kvalifikovana ¢innost vyzadujici tymovou spolu-
praci odbornikti z riznych oblasti: odbornika z oblasti oboru fesené problematiky, specialistu
v oblasti matematiky, specialistu z oblasti informatiky apod. Pro tspésné matematické mo-
delovani musi byt splnény nasledujici predpoklady:

e Zmalost metod a prostiedkid matematické a funkcionalni analyzy, algebry a diskrétni
matematiky — dilezité pro volbu spravné metody feSeni a modelu.

e Znalost techniky modelovéani a zdroji informaci o modelu. Usili vynaloZené na kon-
strukei a vyuziti ur¢itého modelu z literatury musi byt imérné jeho prinosu.

e Tymova spoluprace. Musi existovat dostatecny prostor pro vlastni vyvoj matematic-
kého modelu (iniciativa) a musi byt zainteresovanost (studijni, vyzkumna) na vyuziti
modelové techniky (motivace).
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e Vypocetni zékladna. VSechny tii slozky ICT (tj. hardware, software a komunikace)
musi byt Tesitelskému tymu k dispozici a musi byt v rovnovaze.

e Informacni a datova zékladna. Kazdy model je tfeba ovérit pomoci vstupnich pro-
ménnych, parametrt a dat, které vychéazeji z konkrétnich hodnovérnych informaci, dat
a zdtvodnénjch odhadii parametr. Udaje musi byt ve vhodné formé pro ovéfovani
modelu. Je vhodné vytvéret specidlni informaéni systémy (napi. banky dat), jez ucho-
vavaji data.

e Experimentalni zédkladna. U slozitych matematickym modeld by méla byt k dispozici
i experimentalni zakladna, kde se feseni modelu ovéri v praxi.

Metodologie matematického modelovani se vyviji jako samostatna odborna specializace,
ktera se v soucasné dobé zarazuje do studijnich programi Matematického a pocitacového
modelovani na vysokych skolach. Systém uvazujeme jako usporfadanou mnoziny prvku, mezi
nimiz pisobi vzajemné vazby. Obecné zasady, jez je tfeba pii matematickém modelovani sys-
témi respektovat, 1ze velmi zjednodusené popsat nasledujicimi kroky, které pak podrobnéji
popiseme v dalsi kapitole:

1. Identifikace systému z hlediska matematického modelovani sestava z:

e Rozhodnuti, zda se jedné o standardni systém (problém), jiz FeSeny a volba stan-
dardniho modelu.

e Rozhodnuti, zda se jedna o novy, dosud neznamy systém, a zda pouzijeme upra-
veny standardni model nebo vytvorime model novy. K tomu je tieba zpravidla
vytvorit tviréi odborny tym.

e Rozhodnuti, zda model bude staticky, dynamicky, dynamizovany, deterministicky,
stochasticky. Zda bude deskriptivni, nebo normativni. Zda systém bude modelo-
van jednim modelem ¢ vice modely a jak budou vzajemné usporadény (propo-
jeny).

Realny objekl
Systém nekonedné sloZitosti

Systém definovany na objekiu
- jeho matemalticky model

Pozorovani, zkoumani objekiu pomoci
systamu, matematickeho modelu

Obrdzek 2.2: Identifikace systému

Identifikace systému je pojem, ktery se obvykle pouzivany k popisu matematickych na-
stroju a algoritmi, které vytvari dynamické modely z naméfenych dat. V této publikaci
jej budeme uvazovat v obecné€jsim smyslu.
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2. V kroku specifikace modelu systému je nutno urcit:

Prvky systému: tj. elementarni ¢ast systému pii dané rozlisovaci tirovni dale ne-
délitelna

Vazby: vzajemné zavislosti mezi prvky systému, tj. kauzalni vztahy: pricina-
nasledek, zpisoby spojeni mezi prvky, souvislosti mezi jevy, informac¢ni vazby,
matematicky formulované vztahy atd.

Strukturu systému: je ddna prvky a vazbami mezi nimi.

Stavy systému: tj. popsat stavy chovani systému a pfechodu mezi nimi u dyna-
mickych systémil apod.

Okoli systému: tj. mnozinu prvki, které nejsou prvky systému, ale maji k nému
vyznamné vazby

Organizaci dat v systému: tj. jejich strukturu, zpasobu ulozeni, vstup a vystup
dat atd.

Verifikaci modelu systému: tj. ovéfeni matematickych predpokladii, stability, kon-
zistence a konvergence feseni atd.

Konkrétni specifikace ¢i formulace matematického modelu je zékladem celého matema-
tického modelovani a zalezi do zna¢né miry na schopnostech fesitelského tymu spojit
teoretické poznatky s informacemi o konkrétnim problému nebo systému, ktery je pred-
métem analyzy. V této fazi matematického modelovani musi byt vénovana pozornost i
tomu, zda vstupni data skutec¢né odpovidaji proménnym zahrnutym do modelu. V né-
kterych ptipadech je totiz vhodnéjsi dat prednost relativné jednoduse specifikovanému
modelu pred slozitym, casto zavadéjicim modelem.

3. Vypocet feseni modelu sestava z:

Volby algoritmu feSeni.

Vybéru variant feseni.

4. Vybér dostatecné vhodnych reseni sestava z:

Vybéru vhodnych feseni v rdmci algoritmu reSeni.
Vybéru vhodnych reseni provadénych specialistou v fesené problematice.

Vybéru vhodnych feseni provadénych skupinou expertti.

5. Experimentovani s vybranym fesenim sestava z:

,What-if“ analyzy, tj. analyzy ,,Co se stane, kdyz“ pouzivané vétSinou pfi nu-
merické simulaci slouzici k odhaleni, jak je model citlivy na odhad vstupnich
parametri, jez by mély lezet v néjakém vhodném intervalu.

,Goal seeking“ problému, tj. ,,Cilovym hledanim problému“, ktery souvisi s tim,
ze v praxi se vytvari matematicky model metodou postupnych krokt 1épe aproxi-
mujicich feSeny systém. Toho se dosahuje lokalnim hledanim dostatec¢né presného
feseni. Tento problém je v anglické literatufe nazyvan jako ,satisfying problem*,
yfeasibility problem*“, nebo také ,goal seeking* problém.

Scénait, tj. vhodnou volbou parametrt modelu se zkoumaji rizné feseni (scé-
nare), z nich se pak vybere nejvhodnéjsi feseni.
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6. Vybér optimalniho feseni, tj. na zakladé pfedem stanovenych kritérii se vybere opti-
malni feseni.

7. Implementace, tj. model je nutno implementovat ve vhodném softwarovém prostiedi
(vyvojové prostfedi, programovaci jazyk, vizualizace feSeni apod.). Pfitom je nutno:

e Sledovat postup implementace modelu.

e Pripravit experimentalni data s cilem ovérit implementovany model a provést
jejich validaci.

e Analyzovat pocitacové vystupy feseni modelu a mit zpétnou vazbu na parametry
modelu pri volbé scénar.

e Na zakladé ziskanych vysledkl provést ipravy modelu a jeho novou implementaci.

2.2 Matematické modelovani s vyuzitim ICT

Postup pfi matematickém modelovani realného problému s ICT je uveden na obrazku
2.3 a sestava z nékolika krokid. Jde o permanentni interaktivni proces s ¢etnymi zpétnymi
vazbami, ktery se nékolikrat opakuje [11]. Nejprve je nutno vyjasnit si cile, které chceme
dosdhnout. Ty urci smér feseni ve dvou bodech:

e Na jaké trovni podrobnosti chceme zkoumat objekt.

e Za druhé musime vytvofit hranici mezi modelovanym systémem a jeho prirozenym pro-
stifedim. Toto rozdeéleni je spravné, pokud prostiedi ovliviiuje chovani systému, ale mo-
delovany systém neovliviiuje toto prostiedi.

2.2.1 Identifikace modelu

Identifikace (stanoveni) jednotlivych prvkia matematického modelu s vyuzitim odborné
literatury (knihy, ¢asopisy, Internet), spolupraci s odbornou a védeckou komunitou a dale
s vyuzitim ICT k vyhledani a sdileni znalosti o feSeném problému je prvnim krokem, ktery mu-
sime udélat pfi vytvareni matematického modelu. Spravna matematicka formulace zkouma-
ného problému je velmi dilezitd pro dalsi postup feSeni. Je tfeba vyjit z analyzy systému,
z jeho celkového chovani a stanovenych cilti feseni. Realita je slozitd, je tfeba ji vymezit a
pro ucely modelu zjednodusit. Proto definujeme v ramci objektivni reality systém, tj. prvky,
vazby, vstupy a vystupy, procesy, stavy a funkce. Dale provadime zjednoduseni (simplifikaci)
feseného problému, kdy nepodstatné oddélujeme od podstatného.

Tvorba predpokladi

Kdyz jsme rozhodli o modelovaném systému, musime vytvorit zékladni strukturu mo-
delu, ktera musi reflektovat nase predpoklady a domnénky o tom, jak systém funguje. Tyto
domnénky mohou byt uvedeny do formy zakladnich predpokladii. Budouci analyzy systému
vzdy zachéazi s témito predpoklady jako s pravdivymi, ale vysledky téchto analyz budou
validni, pouze pokud tyto predpoklady jsou platné.

Newton predpokladal, ze hmotnost je obecné konstantni, kdezto Einstein uvazoval hmot-
nost jako promeénlivou. To je jeden z elementarnich rozdili mezi klasickou mechanikou a teo-
rii relativity. Aplikaci vysledku klasické mechaniky na objekt pohybujici se rychlosti blizkou
rychlosti svétla vede k nesrovnalostem mezi teorii a pozorovanim. Pokud jsou predpoklady
dostatecné precizni, mohou okamzité vést pfimo k matematickym rovnicim popisujicim mo-
delovany systém.
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Obrdzek 2.3: Matematické modelovani s vyuzitim ICT

2.2.2 Sestaveni modelu

Sestaveni modelu (vyvoj matematickych rovnic a formuli) véetné matematické analyzy
(korektnost, konzistence, stabilita a konvergence feseni) je dalsim dilezitym krokem v ma-
tematickém modelovani. Pro konstrukci modelu je rozhodujici ucel, ktery sledujeme. Ten
rozhoduje o tom, co budeme ve skutecnosti pokladat za vyznamné (co zahrneme do modelu)
a co jako podruzné ponechame mimo model a mimo nase tvahy. Dilezita je zde analyza cit-
livosti jednotlivych parametr modelu a minimalizace jeho neurcitosti. Tvorba modelt patii
k tvarci ¢innosti a vyjadiuje kromé dobré znalosti modelové techniky také dobrou znalost
vécné problematiky. Kazdy model musi vychézet z konkrétni hypotézy odvozené z objektivni
reality (skute¢nosti).

Vybér matematickych rovnic

Poté, co bylo rozhodnuto o struktufe modelu, musi byt vybrany matematické rovnice
k popsani modelovaného systému. Je velmi rozumné vybrat tyto rovnice peclivé, protoze
mohou nepfedvidatelné ovlivnit chovani matematického modelu.
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Matematické rovnice z odborné literatury a Internetu

Miize se stat, Zze nékdo dalsi publikoval matematické rovnice tykajici se problému, o
néjz se zajimame. To poskytuje dobry vychozi bod, ale je nezbytné postupovat s témito
informacemi obezietné. Problémy, s nimiz se muzeme setkat, jsou nasledujici:

e Rovnice jsou odvozené z dat v oblasti vysvétlujicich proménnych, kterda neobsahuje
oblast nutnou pro aplikaci modelu.

e Experimentélni podminky (prostiedi) se podstatné 1isi od podminek vyskytujicich se
v nasem modelovaném problému.

e Rovnice popisuji chovani vétsiny dat, aniz by uvazovaly znamé odchylky na koncich
oblasti dat, nebo jejich variabilitu (promeénlivost).

Nékteré oblasti védy jsou dostatecné dobfe prostudované, a tak odpovidajici formulace
analyz se staly standardem. Proto je relativné bezpeéné uvazovat podobné analyzy (a proto
i struktury rovnic) za feSeni podobnych problému.

Casto nejsou rovnice v literatufe vyjadfeny v piesné formulaci pro hledany model. Po-
jmenované a pomocné proménné mohou byt presunuty béhem regrese. Rovnice také miize
popisovat zménu vahy zvirat vzhledem k c¢asu, prestoze model potiebuje znat zménu poctu
jedinct v Case. V jiném pripadé miizeme prijmout parametr pouze odhadujici ptibliznou
hodnotu, protoze neni nejdtlezitéjsim pro nase potieby.

2.2.3 Implementace modelu

Implementace modelu s vyuzitim ICT (naprogramovéni v pfislusném programovacim
jazyce, jeho odladéni a verifikace, analyza jeho vypocetni slozitosti, vyuziti prislusného hard-
ware atd.). Zde se vyplati vyuzit modernich ladicich technik, ptipadné i pouzit jiz vyvinuté
a dostupné (open source) knihovny, sluzby i moduly z Internetu.

2.2.4 ResSeni modelu

Reseni implementovaného modelu s vyuzitim ICT néstrojt (analytické, numerické atd.).
Naplnéni modelu konkrétnimi parametry a daty. Je tieba dbat na jejich hodnovérnost. Exis-
tuji dva zptisoby odvozeni feseni z modelu:

a) Analytické (explicitni) feSeni spociva v nalezeni pfesného feSeni pomoci analytickych
matematickych metod (FeSeni soustav rovnic, feSeni tlohy na vazany extrém apod.).

b) Numerické (pfiblizné) feseni se pouziva pii feseni modeld, u kterych neumime problém
fesit analyticky, nebo v pfipadech, kdy je analytické FeSeni obtizné a slozité (metody
Monte Carlo, simulace na pocitaci apod.). Pfi numerickém feSeni musime uvazovat
jeho numerickou stabilitu, konvergenci a chybu, kterd nam vznikne.

2.2.5 Analyza reseni modelu

Verifikace teseni (kontrola, zda vysledky souhlasi s chovanim objektu), jeho vizualizace
atd. a publikace vysledki. Model je jen pfibliznym obrazem objektivni reality. Je dobry,
jestlize umozni presné sledovat disledky zmén ve vstupech do systému na vyslednou efek-
tivnost systému. Cilem testovani modelu je provéfeni jeho spravné struktury, vypovidaci
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schopnosti, formalnich kvantitativnich vlastnosti véetné odstranéni forméalnich chyb. Tes-
tovani modelu provadime tak, Ze modely naplnime empirickymi ¢iselnymi tdaji, dosazené
vysledky analyzujeme a porovnavame s realitou. Ovéfovani lze promitat i do minulosti (,.ex
post“) i do budoucnosti (,ex ante“). Interpretacni analyza predstavuje prevod vysledki do
realného systému. Je to aktivni proces, pri kterém je tieba provadét neustale logickou kon-
trolu smyslu feseni, vyhnout se nebezpe¢i mechanického pouzivani modelové techniky. Vy-
znamnym prvkem interpretace je promitnuti vychozich hypotéz a predpokladii do vysledku
feSeni. Shrnuti ziskanych poznatkil vcetné vsech aspekti, které nebyly do matematického
modelu zahrnuty.

2.2.6 Modifikace modelu

Modifikace modelu a jeho vylepseni. V pripadé, ze dosazené feSeni neni v dostatecném
souladu s objektivni realitou, je nutno zacit znovu postupovat od kroku 1 a opakovat cely
predesly postup matematického modelovani do té doby, dokud nedosahneme uspokojivého
feSeni zkoumaného problému.

Metody prezentace modelu jeho potencidlnim uzivateliim zavisi na znalostech uzivatele
modelu a matematického modelovani obecné. Pokud chce uzivatel védét radéji méné o de-
tailech modelu, je vhodné ukazat mu vsechny relevantni informace o vystupech modelu.
To umozni uzivateli (ktery neni programatorem) vytvorit si objektivnéjsi pohled na feSeni
modelu a jeho interpretaci. Je dobré zkontrolovat, zda predikce feseni zahrnuji skryté extra-
polace. Tyto extrapolace mohou hrat tilohu bud vzhledem k pouzitym dattim pii vytvéareni
modelu, nebo vzhledem k datiim pouzitym pii testovani modelu.
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3 Populacni modely

Teorii matematického modelovani popsanou v iivodnich kapitolach nyni aplikujeme na kon-
krétnim pripadé tzv. popula¢nich modeli. Budeme vytvaret modely populaci zivych orga-
nismt, které ziji v daném case a prostiedi. Nasim cilem bude vytvorit model odpovidajici
na otazku, kolik jedincii bude mit populace v daném case t > 0, jestlize zname tento pocet
na pocatku (v ¢ase t = 0).

Modely rtstu populace patii k nejrozsifenéjsSim a nejznameéjsim, tudiz bychom mohli
nyni pfevzit néjaky jiz vytvofeny model z odborné literatury (napi. [15]) nebo ze zdroju
na Internetu (napf. [19], [27]). Pfedpokladejme vSak, ze zadny takovy model jesté vytvoren
nebyl a popiseme podrobné jednotlivé kroky jeho tvorby.

3.1 Raust populace Zivych organismu

3.1.1 Identifikace a sestaveni modelu

Nejprve budeme modelovat rist jedné populace. Cil modelu jsme jiz stanovili. Nyni mu-
sime specifikovat jednotlivé prvky modelu a definovat predpoklady, za nichz bude model
platit. Modelujeme riist jedné populace P v case t, ktera sestava z poc¢tu N jedinct a na po-
¢atku (v ¢ase t = 0) méla NO jedinciu. Pfedpoklddejme, Ze zména velikosti N populace
P v case je zpiisobena pouze plozenim novych jedincti a umiranim jinych. Pfitom pocet
nové narozenych, respektive zemfelych, jedincii bude primo tmérny velikosti populace. Pro
jednoduchost budeme uvazovat, ze na populaci P neptsobi zadné dalsi vlivy.

Hledejme feseni modelu, tj. velikost N populace P v daném c¢ase t. Cas ¢ budeme uva-
zovat jednak jako diskrétni veli¢inu nabyvajici celo¢iselnych hodnot (mohou ptedstavovat
napiiklad roky), nebo jako spojitou veli¢inu.

Na zakladé vyslovenych predpokladt jsme schopni sestavit rovnici modelu. Oznac¢me:

N(t) ... funkci pFedstavujici pocet jednotlivet populace (velikost populace) v case ¢

a ... koeficient porodnosti populace (podil nové narozenych jedinci ke vSem
jedincim za jednotku ¢asu)

b ... koeficient umrtnosti populace (podil zemfelych jedinci ke vSem jedincim
za jednotku ¢asu)

h ... kladné realné cislo predstavujici casovy interval

Vzhledem k smysluplnosti modelu predpokladame, ze vSechny vyse uvedené proménné
mohou nabyvat pouze redlnych nezapornych hodnot, navic b < 1 (nemize zemiit vice jedinct,
nez kolik jich je v populaci). Pocet jedincii N(t) vypocitany pro dany ¢as ¢ nemusi byt
celé cislo, pfi interpretaci vysledki jej proto budeme zaokrouhlovat. Navic predpokladame,
ze modelujeme rust populace od casu t = 0, v némz zndme hodnotu velikosti populace
N(0) = NO.
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Pocet nové narozenych jedincii za ¢asovy interval [t, ¢+ h] je pfimo tmérny poctu jedinct
N(t) populace v ¢ase t a délce h tohoto intervalu, tj:

a-N(t)-h,

kde koeficientem pfimé imeérnosti a je koeficient porodnosti. Analogické tvrzeni plati pro
pocet zemfelych jedinci za dany casovy interval, tj:

b-N(t)-h,

kde koeficientem piimé iimérnosti b je koeficient imrtnosti.
Nyni jiz mtzeme formulovat rovnice modelu.
Diskrétni pripad

Cas t v tomto pifpadé nabyva pouze celodiselnych hodnot, takZe h bude rovnéz celé
kladné ¢islo. Pro jednoduchost zvolme h = 1. Rovnice modelu mé pak tvar!:

N(t+1) = N@t) + a-N@#)-1 — b-N@#)-1 = (1+a—b)-N(). (3.1)

s pocatecni podminkou

N(0) = No. (3.2)

Spojity pripad
Necht A je nyni kladné realné ¢islo. Potom méa rovnice modelu tvar:

N(t+h) = N{t) + a-N(t)-h — b-N(t)-h. (3.3)

Jelikoz uvazujeme spojity ¢as, tak mizeme predpokladat, ze Casovy interval [t,¢ + h] je
nekone¢né maly. Proto upravime rovnici (3.3) na tvar:

N(t+h) — N(t)
h

=a-N(t)—=b-N(t)=(a—b)- N(t).
A odtud limitnim pfechodem (h — 0) dostaneme:

N(t+h) — N(t)

}lliII(l) = (a—0b)- N(t). (3.4)
Vyraz na levé strané rovnice (3.4) je derivace funkce N (t) podle proménné ¢, takze vysledna
rovnice modelu mé tvar!™!8:

6 Tomuto typu rovnic fikdme rovnice rekurentni (piipadné diferenéni) [17].
1"Tomuto typu rovnic fikdme rovnice diferencilni [16].
8Derivaci funkce podle ¢asu budeme déle znacit apostrofem, tj. 4 N(t) = N'(t).
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SN@) = (a—b)- N(t) (3.5)

s pocatec¢ni podminkou

N(0) = NO. (3.6)

Z biologického hlediska 1ze limitné prejit k diferencidlni rovnici (3.5) pouze, pokud jsou
splnény néasledujici podminky [9]:

e kvantovact podminka: populace je tak velka, Ze neni tieba pocitat s jedinci,

e vzorkovaci podminka: vSichni jedinci v populaci jsou identi¢ti (populace je homogenni
z hlediska jedinct v produkénim véku).

3.1.2 Implementace modelu a jeho reseni

Reseni vyge uvedeného matematického modelu (rovnic modelu) mtizeme vypoditat sami
na zakladé svych znalosti, vétsinou vsak vyuzivame vhodnych informacnich technologii. My
budeme pouzivat systém pocitacové algebry Maple'® (vice o préaci v systému v kapitole 5
Maple). Uvedme si tedy, jak implementujeme vytvofeny model a jak ziskdme FeSeni.

Diskrétni piipad

V systému Maple zapiSeme rovnici (3.1) s poc¢ateéni podminkou (3.2). Klikneme na ni
pravym tlac¢itkem mysi a zvolime z nabidky prikaz na feseni rekurentnich rovnic: Solve
Recurrence > N(t), viz obrazek 3.1. Ziskame tak feSeni na obrazku 3.2.

Spojity pripad

Zcela analogicky zapiSeme v systému Maple rovnici (3.5) s poc¢ateéni podminkou (3.6).
Poté na ni klikneme pravym tlacitkem mysi a z nabidky vybereme piikaz na feSeni diferen-
cialnich rovnic: Solve DE > N(t), viz obrazek 3.3. Ziskame Teseni na obrazku 3.4.

3.1.3 Analyza feseni

Nyni mtizeme pfistoupit k analyze vysledkt feseni modelu. Vyuzijeme k tomu grafické
moznosti systému Maple.

19Konkrétné se jedna o verzi Maple 14. U starsich verzi systému je nutné nékteré kroky feseni provést jinak
(zpravidla pouzit piikazy jazyka Maple namisto tlacitka mysi) k ziskan{ stejného vysledku. Kvili jednotnému
zapisu oddélovace desetinnych mist u ¢isel budeme v textu pouzivat vzdy desetinnou tecku.

20



MNie+1]=(1+a—&)- Nr), ¥[0) = N

Tid

! i
oy s SR
Tt Chriay
Evalupts
Tvgkints i Duplsy I T
Esplng
Aoy & Comnard
Evaashs of & Poirt
M Corwead Cmin
Sastech, Bt "
gy B
& an Dol e !
Cominutots ¥
CofvEars F
oty E
Io0 M B
Tabis .

Obrdzek 3.1: Reseni rovnice (3.1) v systému Maple

solve recurrence

N(t+1)=(14a—b) N(t), N(0) =ip—TCrW w0 (1+ 0 —b)°

Obrdzek 3.2: Reseni rovnice (3.1) s pocdtecni podminkou (3.2)
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Obrdzek 3.3: Reseni rovnice (3.5) v systému Maple
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A ) = (a = b)-N(2), N(0) = N0 —PE, () =np (@)1

Obrdzek 3.4: Reseni rovnice (8.5) s pocdtecni podminkou (3.6)

Diskrétni piipad

Abychom mohli vykreslit feseni v diskrétnim pripadé, je nutné prifadit parametrim
modelu N0, a, b konkrétni numerické hodnoty. Uvazujme proto populaci zajice polniho.
Z literatury [23] zjistime, Ze samice zajice polniho vrha 3—4 krat do roka 1-7 mladat a Ze se
zajic polni doziva 10-12 let.

Na zakladé téchto idaji odhadneme hodnoty koeficient porodnosti a tmrtnosti. Pied-
pokladame pfitom, Ze samic je v populaci stejny pocet jako samct a plozeni novych jedinci
je prumeérné. Samice zajice tedy 3.5krat v roce vrhne 4 mladata. To je celkem 14 nové naroze-
nych jedincti za rok. Jelikoz je v populaci samic polovina, pomér nové narozenych vzhledem
k celkovému poctu jedincti populace bude ,pouze® 7. Jak zjistime dale, tato hodnota je
velmi vysoké. Proto pro vétsi prehlednost prejdeme k délce kroku rovnou jednomu mésici.

Koeficient porodnosti tak bude dvanictina z ptivodné vypoéitané hodnoty, tj. a = =

12

Podobné odvodime koeficient imrtnosti. Zajic polni se doziva primérné 11 let, za rok

tedy zemfe 1—11 jeho populace. Opét prejdeme k mési¢nimu kroku a ziskdme b = ﬁ Necht

pocatecni velikost populace NO je 100 jedinci. Pro ¢asovy krok rovny jednomu meésici celkem
mame:

7 1
NO=100, a=—, b= ——.
’ 12’ 11-12

Reseni vykreslime nasledujicim postupem. Vypoéitdme hodnoty FeSeni pro ¢asové body,
které nas zajimaji (napf. t = 1,2,...,10), a pfikazem plot pro vykreslovani je zobrazime.
Piikazu plot dale nastavime nékolik nepovinnych parametra (symbol, symbolsize, labels,
font, labelfont) pro lepsi vzhled a popis soufadnych os. Ukézku zdrojového kédu s vysledky
poskytuje obrazek 3.5.

Spojity pripad

Ve spojitém priipadé lze s vyhodou vyuzit pomocnika pro vykreslovani Plot Builder
a zkoumat zavislost feseni na hodnotach parametri modelu. V systému Maple zapiseme
ziskané Teseni na obrazku 3.4, klikneme na néj pravym tlacitkem mysi a z nabidky vybereme
zminéného pomocnika pfes Plots > Plot Builder. Na obrazovce se nam objevi okénko,
v némz nastavime, co nas zajima. Zcela nahofe vybereme z rolovaciho seznamu moznost
Interactive Plot with 3 parameters. Nésledné zvolime v nize umisténém ramecku 2-D
plot (tato moznost by méla byt zvolena standardné, tudiz neni nutné nic ménit).

Nakonec nastavime rozpéti hodnot parametrim modelu tak, jak chceme. Nejprve pfi-
fadime ose x proménnou ¢ a ostatni pole vyplnime zbylymi parametry s jejich pozadova-
nymi rozsahy. N4 zdkladé difve uvedenych udaja zvolme: ¢ € [0,10], NO € [50,500], a €
[0,1.17], b € [0.007,0.0083], pfi¢emz piipustime, Ze koeficient porodnosti muize byt i nulovy,
abychom mohli pozorovat vyvoj feSeni i v pripadé, kdy je koeficient porodnosti nizsi nez
koeficient imrtnosti. Horni mez koeficientu porodnosti odpovida situaci, kdy samice zajice
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Obrdzek 3.5: Reseni diskrétniho pripadu modelu ristu populace.

vrhne 4krat do roka 7 mladat. Analogickou tivahou jako diive dospé&jeme k ,mési¢ni“ hod-
noté % = 1.17. Meze koeficientu amrtnosti odpovidaji situacim, kdy se zajic polni dozije 10
a 12 let. Podobu vyplnéného okénka podle predchoziho postupu ilustruje obrazek 3.6.

Néslednym kliknutim na tlac¢itko Plot pfejdeme na okénko se zobrazenim feseni pro
nastaveni parametrti a,b, NO. Toto nastaveni je mozné ménit posuvniky po pravé strané
okénka. PTi zméné libovolného parametru se automaticky prizptisobi vykresleni feseni nové
hodnoté parametru. Okénko s vykreslenim feseni poskytuje obrazek 3.7.

Po stisknuti tlac¢itka Done umistime graf z vykreslovaciho okénka do zapisniku systému
Maple a soucasné tim vykreslovaci okénko zavieme.

7 predeslého zkoumani zavislosti feseni na parametrech modelu mtizeme dospét k nasle-
dujicim zavérim. Pokud bude koeficient porodnosti vyssi nez koeficient timrtnosti, velikost
populace bude exponencialné rist. Pokud budou hodnoty koeficientti totozné, populace bude
mit stale stejnou velikost. A jestlize bude koeficient timrtnosti vyssi nez koeficient porod-
nosti, populace bude vymirat. Pocatecni velikost populace nemé na zminéné chovani feseni
zadny vliv (pokud je vySsi nez nula).

V diskrétnim p¥ipadé je situace prakticky totozna. ReSeni se chova kvalitativné stejné,
,malé* rozdily muzeme pozorovat v hodnotach velikosti populace v jednotlivych ¢asovych
bodech.
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Obrdzek 3.7: Vykresleni spojitého feseni.
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3.1.4 Modifikace modelu

Nyni porovname vysledky modelu s pozorovanim a kriticky zhodnotime model. Je zfejmé,
vylepseni modelu, které jej vice priblizi realité.

Velikost populace se nemiize exponencialné zvysovat do nekonecna. Prostor, v némz po-
pulace Zije, je omezeny, podobné jako mnozstvi zivin, které ma k dispozici. Dopliime proto
predpoklad modelu, Ze imrtnost se bude zvySovat se zvétsujici se populaci. Nejjednodussi
zpusob zavislosti je linearni zavislost. Koeficient imrtnosti tedy nebudeme jiz chapat jako
konstantni ¢islo, ale jako rostouci linearni funkci.

Koeficient tmrtnosti: b+ c- N(t) , kde b, ¢ jsou realnd nezdporna ¢isla.

Podobné jako drive ziskdme rovnice modelu.
Diskrétni p¥ipad: N(t+1)=(1+a—b) - N(t) —c- N(t)%, N(0) = NO
Spojity pripad: N'(t) = (a —b)- N(t) — c- N(t)?, N(0) = NO

V diskrétnim pfipadé se ndm nepodaii ziskat analytické feseni modelu jako diive (obrazek
3.2), z rekurentniho ptedpisu vSak miZzeme uréit velikost populace v libovolném case t.
Zaméime se nejprve na spojity pripad, v némz je analyza feseni jednodussi.

Reseni rovnice modelu v systému Maple obdrzime zapsanim rovnice, kliknutim pravého

tlacitka mysi a zvolenim prikazu pro feseni diferencialnich rovnic Solve DE. Vysledek tohoto
postupu je znazornén na obrazku 3.8.

LNy = (a— B) W) — e W) N(0) =W0—20Es py(n) = - Mg 8)
-WNie+ e '® Mane — e @

di bt

g+e @By

Obrdzek 3.8: Reseni modifikované rovnice modelu — spojity pripad

Analyzu feSeni provedeme znovu za pomoci Plot Builderu. V systému Maple zapiseme
pted chvili ziskané Feseni (mtizeme zkopirovat) a po kliknuti pravym tlacitkem mysi vybereme
z nabidky Plots > Plot Builder. Naprosto totoznym zptsobem jako driive nastavime
rozsahy parametri a zkoumame zavislost feseni na jejich hodnotach ovladanim posuvnik.

Rozsahy vSech driive pouzitych parametri nechame stejné, hodnota parametru c zavisi
na prostiedi, v némz populace zije. Necht v naSem piipadé nabyva tento parametr stej-
ného rozsahu jako parametr b. Obrazek 3.9 ilustruje vykreslovaci okénko spolu s nastavenim
parametri pomoci posuvniki.

Nastavovanim rtznych hodnot parametrim pomoci posuvniki v Plot Builderu zjis-
time, Ze velikost populace se vZdy (po ,dostatecné“ dlouhém case) ustali na néjaké hodnoté,
pfi niz je populace v dynamické rovnovaze s prostfedim (neroste ani nevymird). Tuto hod-
notu mizeme urcit z rovnice modelu poloZenim levé strany rovné nule, tj. derivace (zména)
velikosti populace v ¢ase je nulova:

0= (a—0b)-N(t)—c-N()> (3.7)
Rovnice (3.7) ma jediné nenulové feSeni, a to:

a—>b
-

N(t) =
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Obrazek 3.9: Vykresleni veseni modifikované rovnice modelu — spojity pripad

Pokud a > b, velikost populace se ustali na hodnoté =2 (tj. tlim N(t) = =2). Pokud

a < b, populace vymfe (stejné jako v predchézejicim modelu). Zminéné chovéani plati pro
libovolnou nenulovou pocatecni velikost populace.

Pravé odvozenou ustalenou hodnotu velikosti populace (
kapacitou) prostredi a znac¢ime pismenem K. Oznacme déale

a—b

- ) nazyvame uzivnosti (resp.

r=a—>.

Tento parametr, tj. rozdil koeficientd porodnosti a tmrtnosti, se nazyva vnitini koeficient
rustu populace.

P¥i tomto oznaceni muZeme spojity piipad rovnice puvodniho modelu (3.5) pfepsat na
tvar:

N'(t) =r- N(t) (3.8)

a spojity piipad rovnice modifikovaného modelu na tvar:

N'(t) = - (1 _ %) N(D). (3.9)

Chovani teseni v pripadé modifikovaného modelu zavisi na pocatecni velikosti populace.
Velikost populace v ¢ase klesa, pokud N(0) > K, roste, pokud N(0) < K, pfipadné ztstava
konstantni. Zavislost feSeni na pocatecni velikosti populace dokumentuje obrazek 3.10, v
némz K = 76 a NO € {15,30,...,150}. Pomoci for-cyklu je vygenerovano 10 feSeni pro
jednotliva NO, ktera jsou vykreslena v jednom grafu prikazem display z baliku plots.
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Obrdzek 3.10: Vykresleni zdvislosti feseni na pocdtecni velikosti populace

Vratme se nyni k diskrétnimu pfipadu modifikovaného modelu, ktery je mozné po zave-
deni parametri K a r prepsat do tvaru:

N(t+1) = N(t) +7- N(t) - (1 - %) , N(0) = NO.

vvvvvv

pripadé. Pro jednoduchost uvazujme situaci, kdy je nenulova pocatecni velikost populace NO
nizsi nez uzivnost prostredi K pro tuto populaci. V zavislosti na velikosti vnitiniho koefici-
entu ristu r mizeme pozorovat ¢tyfi (kvalitativné) riiznd feseni (viz [27]): velikost populace
monoténné roste k hodnoté uzivnosti prostiedi (obrazek 3.11), pfiblizuje se k ni s tlumen-
nymi oscilacemi (obrazek 3.12), kolisa kolem této hodnoty pravidelné (obrazek 3.13), nebo
kolem této hodnoty kolisa nepravidelné, chaoticky (obrazek 3.14). D¥ive pouzitym hodnotam
parametri r a K (u spojitého piipadu) odpovida prvni situace (obréazek 3.11).
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Obrdzek 3.11: Reseni diskrétniho pripadu modifikovaného modelu mistu populace pro 0 < r < 1.

Rovalce modelut N{r+ 1] =N{1) -Ir'-.'ﬁ"[r]-{l- %ﬂ-]

Mastaven parametra msdels: M0 0= 20; rom L5 Kow Th;
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Veldos| 1] = N
for ¢ from 2 to |3 do
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ead da
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Obrdzek 3.12: Reseni diskrétniho pripadu modifikovaného modelu ristu populace pro 1 < r < 2.
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Obrdzek 3.13: Reseni diskrétniho pripadu modifikovaného modelu ristu populace pro 2 < r < 2.8.

Rovolce mesdeluz Nir4 1) =N(2) 'I-r-."f[l']-['l.- %}

Nastavem! parametra modedn: N0 = 20 poe 3: Koo TH:

Vipodet velibosti populace v casovich bodech = 1, 15

Fedshon 1] = No:

for i from 2 ta 13 do

Velikort] 1] = wvalf| Velikon]i = 1] + r- Feldhost] i = ||-[1- &“:}ﬂ”

emil doc

Vyivedeni posloupaosil bodmot Feteniz

| poslouprmen o= gegd 1, Fafdkoatr 4 1 )], r=0.12):

L' i Peiend;

plot( | posfouprart |, snde = poin, pmbal = solideancle, symbolste = 20, Lobels = [ 1 [ meuice |7,
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Obrdzek 3.14: Reseni diskrétniho pripadu modifikovaného modelu mistu populace pro r > 2.8.
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3.2 Populace pod tlakem nespecializovaného predatora

3.2.1 Identifikace a sestaveni modelu

V predeslém prikladu jsme modelovali rist populace, ktera neni ovlivnéna svym okolim.
Nyni prejdeme k situaci, kdy je v prostiedi, v némz se uvazovana populace vyviji, také ne-
specializovany predator. Nespecializovany predator je takovy, ktery neni zavisly na koristi
z uvazované populace, mé i alternativni zdroje obzivy. Velikost jeho populace tedy mizeme
povazovat za konstantni a do modelu ji nemusime zahrnovat.

Prvni predpoklad pfi tvorbé modelu bude pfirozeny: predatori ulovi takové mnozstvi
koristi, které je tmérné dobé lovu, tj. mnozstvi ulovené kotisti za casovy interval délky h
je rovno p - h. Parametr p se nazyva intenzita predace a vyjadiuje predacni tlak vyvijeny
na uvazovnou populaci, pfesnéji feceno: mnozstvi kotisti, které predatori ulovi za jednotku
¢asu. Intenzita predace zavisi na velikosti N populace kofisti, tj. p = p(IN). Abychom tuto
zavislost vyjadrili, prijmeme dalsi dva prirozené predpoklady:

e pokud neni uvazovana populace pritomna, predatofi nic neulovi a zivi se alternativni
potravou,

e pokud je uvazovand populace velikd (vétsi nez predatori dokazi snist), lovi predatoii
jen omezené mnozstvi jedinct, které predstavuje jakousi hladinu nasycent.

Tyto predpoklady zapiseme ve tvaru rovnosti:
p(O) = 07 p(N) =5 pro N > Nkrit7

kde parametr S predstavuje hladinu nasyceni, Ny kritickou hodnotu velikosti populace
(je-li velikost uvazované populace vétsi nez kriticka, predatori jsou nasyceni). Zvolme za p
nejjednodussi funkci, ktera splinuje uvedené predpoklady, tedy funkci linearni na intervalu
[0, Nirit], jinak konstantni:

‘N . N < N,
p(N) = (3.10)

S N > Nkrit-

U predeslého modelu jsme v diskrétnim pripadé dospéli k rovnici

N({t+1) = N(t) —|—7"-N(t)-( —%), N(0) = NO (3.11)
a ve spojitém pripadé k rovnici
N'() = 1 N(#)- ( _ %) . N(0) = No. (3.12)

Obé tyto rovnice lze za pouziti ¢asového kroku h vyjadrit ve tvaru

N(t+h) = N(t) + r-N(t)-( ‘%) -h, N(0) = NO. (3.13)



Vyraz

oty (1- X0

lze interpretovat jako prirozeny pfirtistek velikosti populace za ¢asovy interval délky h. Rov-
nice (3.11) je rovnici (3.13) pro h = 1, rovnice (3.12) je meznim p¥ipadem rovnice (3.13) pro
h — 0.

Nyni vyjadrime zménu velikosti populace za casovy interval délky h jako prirozeny prirts-
tek populace zmenseny o mnozstvi ulovenych jedinct. Rovnici (3.13) tedy dale modifikujeme
a dostaneme model ristu populace pod tlakem nespecializovaného predatora ve tvaru

N

N(t+h) = N(t) + r-N(1)- (1— -

)-h — p(N(¥)) -h, N(0)=NO, (3.14)

kde funkce p je ddna rovnosti (3.10). Pro h = 1 dostaneme model diskrétni:

N(t+1) = N(t) + r-N(t)-( ‘%) — p(N(#)), N(0) = NO, (3.15)

limitnim pfechodem h — 0 dostaneme model spojity:

N()

N'(t) = r-N(t)-(l— e

) — p(N(t)), N(0)= No. (3.16)

3.2.2 Implementace modelu a jeho reseni

S rostouci slozitosti modelu vzrista i naro¢nost vypoctu reseni. Podobné jako v predcho-
zim modifikovaném modelu nejsme schopni urcit feseni diskrétniho ptipadu (3.15), z reku-
rentniho predpisu vSak miZeme (pii znalosti numerickych hodnot parametrit modelu) urcit
hodnotu velikosti populace v libovolném case t. Ve spojitém piipadé je mozné rovnici (3.16)
rozlozit na dva piipady (podle (3.10)) a v Maple jiz znamym postupem (Solve DE > N(t))
nalézt feSeni pro kazdy piipad zvlast. Tento postup je vSak mozny jediné tehdy, kdy je veli-
kost populace stéle ,,pod hladinou“ Ny, nebo stale nad ni (pfipoustime i rovnost).

V obecném piipadé je nutné fesit rovnici (3.16) za pomoci numerickych metod, k ¢e-
muz musime znat numerické hodnoty vsSech parametri modelu. MiZzeme opét uvazovat
populaci zajice polniho, na jehoz tizemi nyni zije i liSka obecna jakozto nespecializovany
predator. Musime vsak zjistit hodnoty pouzitych parametri. Od této chvile se pro zbytek
textu odklonime od konkrétnich hodnot namétenych v praxi a pro jednoduchost a nazornost
budeme volit ,,vymyslené“ (avSak realistické) nastaveni parametrii. V grafech proto déle ne-
budeme uvadét jednotky (které se mohou lisit pro rizné modelované populace), nebot nam
jde o kvalitativni chovani populaci. V tuto chvili zvolme naptiklad nasledujici nastaveni:

S =300, r=1, K =1000, Ny = 200, NO = 500.

V systému Maple nastavime proménnym prislusné hodnoty a zapiSeme rovnici ve tvaru
zndzornéném na obrazku 3.15. K zapisu dvou moznych piipadt pro funkci p(N(t)) pfitom
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MNastaveni parametra: S5 := 300 r= 1. &= 1000: MNkrt:= 200: ANO:= 500:

3 N(t) > Nkrit
Rovnice modelu: iN[:] =r-N(t)- [1 — —] — 5

N0
df . = it
Nicrit NI:I:I NI:I:I Mt

Obrdzek 3.15: Zapis rovnice (3.16).

f13 ODE Analyzer Assistant |

~Differential Equations ~Conditions—————— Parameters
d _ 1 M(0) =300
W () = (1) [1- = N(:)]

Edit: | Edit: |
Solve Numerically Solve Symbolically | Classify I Help | Quit |

Obrazek 3.16: ODE Analyzer Assistant.

vyuzijeme symbolu tvaru oteviené slozené zavorky v paleté Exression reprezentujici vyraz
definovany po castech.

Po kliknuti pravym tlac¢itkem mysi na rovnici a zvolenim Solve DE Interactively
se nam zobrazi okénko ODE Analyzer Assistant s upravenym tvarem rovnice a pocatec¢ni
podminkou (obréazek 3.16). V tomto okénku je mozné rovnici dale upravovat, ménit pocatecni
podminky, zavadét a rusit parametry modelu atd. Mame jiz vSe ptipravené, a tak klikneme
na tlacitko Solve Numerically pro numericky vypocet reseni.

Prejdeme tak do dalsiho okénka, jez po levé strané nabizi numerické metody, které mi-
Zeme pouzit k nalezeni feSeni, a nastaveni absolutni a relativni chyby vypoctu. Vyuzijeme
standardniho nastaveni (tj. nebudeme nic ménit) a klikneme na tlacitko Plot pro vykresleni
feSeni. Okénko s vykreslenym fesenim poskytuje obrazek 3.17. Po stisknuti tlacitka Quit se
vratime zpét do zapisniku Maple, do néjz bude vlozen graf feseni.

3.2.3 Analyza reseni

Vime, ze v pripadé, kdy modelovanou populaci neohrozuje zadny predator, se velikost
populace ustali na hodnoté K predstavujici izivnost prostiedi. Podivejme se, na jaké hodnoté
se ustali velikost populace nyni.
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b3 Solve Numerically |

~Parameters roukput
{+ Runge-Kutta-Fehlberg 4-5th order Show Function values at t = Solve |
0,000000
" Drverk 7-8th order Iinterpulant vI I
" Gear single step extrapalation Irational - l
Plak Options |
" Rosenbrock stff 3-4th order
500+
" Livermore stiff Iadams iterative - l 1
4001
" Boundary Yalue Problemn solver |
- - - 300+
Itrapezuldal ;"rlchardsan extrapolation LI N |
2004
Range of £ ID e} |1IZI |
" Taylor series Ilaz'f setiEs vl 100
J -
(" Modified Extended BOF Innplicit h 2' clt 6‘ BI IIEI
t
" Fixed skep methods
Show Maple commands [~
|.53—2 IForward Eular ;I
Absolute: II.DDDDDDE—D? default |
Relative: Il.DDDDDDe-DG default |
0n Quit, Return IF‘Int LI Clear | Help | Back. | Quit |

Obrdzek 3.17: Numerické Tesent rovnice (3.16).

Obé rovnice (3.15), (3.16) vyjadfuji zménu velikosti populace v ¢ase. Ustélend hodnota
feSeni je pfitom takova, kterd se v ¢ase neméni, tj. v diskrétnim ptipadé pro ni plati:

N({t+1)—N()=0 (3.17)
a ve spojitém:
N'(t) =0. (3.18)
Oboji vede na rovnici

r-N(t).( —¥> — p(N(®) =o. (3.19)

Rovnici (3.19) vyfesime v systému Maple pro oba pfipady (viz (3.10)). Jelikoz hleddme
ustélenou (konstantni) hodnotu funkce N (t), pouzijeme v zapisu rovnice symbol N (namisto
N(t)). Na rovnici klikneme pravym tla¢itkem mysi a zvolime Solve > Solve for Variable
> N. Vysledek poskytuje obrazek 3.18.
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Obrdzek 3.18: Reseni rovnice (5.19).

Ziskana nenulova TeSeni jesté upravime a oznacime:
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se zminime pozdéji.

V zavislosti na hodnoté pocatecni velikosti populace a vztahu mezi parametry modelu
se velikost populace v case ustali na jedné ze tii pravé nalezenych hodnot N1, N2, N3,
pfipadné populace vymie (jeji velikost se ustali na hodnoté 0). Celkem je mozné rozlisit 5
riznych kvalitativnich situaci. Pro kazdou z nich nésleduje obrazek feseni s vytvorujicim
kédem v systému Maple.

Pro nalezeni feseni modelu je pouzit pfikaz dsolve s parametrem numeric, jenz za-
jisti numerické feseni prislusné diferencialni rovnice. Grafy feSeni jsou vytvoreny piikazem
odeplot patficiho do baliku plots a ukladany do pole (s nédzvem graf), které je nésledné
vykresleno najednou piikazem display z baliku plots. Ptikazu odeplot jsou (podobné jako
diive) nastaveny nékteré nepovinné parametry pro lepsi vzhled grafu a popis souradnych
0s.20

1. S>--r- K

I,

n

a) Nkrit S -
r

Predator vyhubi uvazovanou populaci pti jakékoliv pocateéni hodnoté NO > 0
— obrazek 3.19 pro nastaveni parametri:

S =300, r =1, K = 1000, Nz = 200, NO € {50,100, ..., 1000}

20Parametrem numpoints specifikujeme, v kolika bodech mé byt vypocitano FeSeni, které je nasledné
vykresleno. Standardné je tento parametr nastaven na 200. Vice o vykreslovani grafu v kapitole 5 Maple.
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Nastaveni parametra: 5:=300: r:=1: K:= 100: Now:= I00:

Cyklus vvivorent grafo pro jedostlive hodnoiy 5V
Towe & Drawenn 1 dn 200 das
NGO = 50

Me) = Nerit

res[{] := drolve ;;."-’1 t] —r-.‘\’lrb l— S JN{O) =N | mamerie |

]—-"HEL Mt} = N

graf | i] = plots| odeplor]{ res[ i], 1 =0 .20, thicksess = 2, labels = [ "1, "Ny |, fonr = [ Times, roman, 12].
labelfanr= [ Tanes, bald, 12], mumpoiars = 1500 :

el do:

Vykresleni grafu:
plots| display | (seq| graf| 1], 1=1.20] )

10K

il

Ll

20

an

Obrdzek 3.19: Reseni modelu ristu populace pod tlakem nespecializovaného preddtora v pripadé
1. a)

S
b) Nkrit > —:
T

Velikost populace se ustali na hodnoté /V; pri jakékoliv poc¢atecni hodnoté NO > 0,
tj. predator zmensi ustélenou velikost populace (z hodnoty K) — obrazek 3.20
pro nastaveni parametri:

S =300, r =1, K =1000, Ny, =400, NO € {50,100, ...,1000}
= N; =250
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Nastaveni parametru: 5:= 300: r:=1: K:= 1000: N = 400

Cyvklus 1.':|.'I1.'4;|-iru:|'.gr:l T Fﬂ:j:ﬂ.umlh'-:" hosdnoty N :
Towe £ Frawemn 1 o 200 da
NO e 50
3 vin : Ni1) = N
el il = dvak S NI =N} 1-24EL |- - N{O) =M. e | 2
rexli] = daalve) | SN () =r-N{1) [ K ) _1::;, N(1) N(1) £ Nigig™ ) e
N

graf [ i] = plots] adeplor]{res[ £], 1= 0 .20, theickmess = 3, labels= [, "N | fonr= | Times, roman, 12].
labelfonr = [ Tanas, bald, 12, numppoiars = 1500 ) :
o da:

Vukreslemi grafu:
plots| display | (seq(graf[ 1], 1=1.10))

Lo -

et ]

4 ¥ 19 I2 FLl
1

Obrdzek 3.20: Reseni modelu ristu populace pod tlakem nespecializovaného preddtora v pripadé

1. b)

2. S<}1-7"-K

a) Nigit > N2:

Velikost populace se ustali na hodnoté N3 pii jakékoliv poc¢atecni hodnoté NO > 0,
tj. predator zmensi ustélenou velikost populace (z hodnoty K') — obréazek 3.21 pro
nastaveni parametrii:

S =200, r =1, K = 1000, N =400, NO € {50,100, ..., 1000}
= Ny =500, N, =276, N;=T724
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MNastaveni parametru: 5= I200: r:=1: K= 1000;: N = 400;

Cyhilus '|.':|.'I1.'ui'r:|:|'gr:l fa pras jed mad live huslinony Vil
Towe £ Termy 1 s 200 s
NG = 50
( g N(r) = Nt .
: - L ] . prews I
ves| 1] == dealve| | =—N{t)=rN[r):| 1-——=| = g i e L N(O) =N |, numreric |
di K | =M1} Nt} < Nkrit i
Niwit ]
praf {] i= plets] odeplar]{ res| 6], r=0 .20, thickress = 3, labels= | "0, "N |, fom = | Times, romas, 12,
labelfornt = | Times, bold, 121) :
end da:

Vvkresleni grafu:
plocs| display]({ seq( graf[ 1], i=1 201 )

FO /
([10}]
1]

Obrdzek 3.21: Reseni modelu ristu populace pod tlakem nespecializovaného preddtora v pripadé

2. a)

S
b) Z < Nyt < N2:
T

Pokud NO > N, velikost populace se ustali na hodnoté N3. Pokud NO < N,
ustali se na hodnoté N;. Pro NO = N, ztistane velikost populace stejna. Predator
tedy opét zmensi ustalenou velikost populace; nova ustalena velikost populace
vsak zavisi na jeji pocatecni velikosti — obrazky 3.22 a 3.23 pro nastaveni para-
metri:

S =200, r =1, K = 1000, N =400, NO € {50,100, ..., 1000}
= N1=200, N2=276, N3=724

Tuto moznost lze také interpretovat takto: velikost dynamicky stabilizované po-
pulace zavisi na historii. Pokud populace invadovala do prostfedi obsazeného po-
pulaci predatora, je stabilizovana populace mala. Naopak, pokud do prostiedi se
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stabilizovanou populaci invadovala populace predatora, je stabilizovana populace
velka.

Nastaveni parametru: $=200; r:=1: K= 1000: Nog:=250;

Cyklus vwivoreni grafu pro jednotlive hodnoty N
Tor ¢ frame 1 Do 20 do
NG o p 500
= N{t) > Niww

d N(r) -
- — A —— = 'a:'|r v - - <) P | I=_:'H = 3
res| i] := dselve dr.ﬂl[rr rMr) [I. e J .,‘.-;:,_‘]. N{f) N(F] < Niri N{ 0} =NO |, nemeric

graf| ] = plotr| odeplod | (res] o], £=0 20, theckmess = 3, labels = [ "0, "B00" | fonr = [ Tomes, rowman, 12,
labelfonr= | Tares, bold, 12 ). manpotrs = 1500 ;
emdl dixc

Vytvorenm grafu pro bodoota V=%,

K f d=5
Mt —| I= | - — |
= J? r-rJ

res[21] = deolve FETHEH =rNir: ['I: - -""r.:;] }

Vi) = N
NO) = N9 |, rintmerie |
T _Ne) (e} < Mg VO
Niwwr

gral [ 21] = plots| edeplot] {res{ 21 ] £ = 0..20, thickress = 3, labels = [ v, "0 | fonr = | Tines, roman, 12],
labelfons = | Tiwes, bold, 12 ], niempoiss = 1500)

Obrazek 3.22: Vypocet reseni modelu ristu populace pod tlakem nespecializovaného preddtora v pri-

padé 2. b)

Vyvkresleni grafo:
plots| display | ( seq{graf[i], i=1.21) )

oo
HiM

LI

Lt
i
Ll

k-

Obrazek 3.23: Vykresleni teseni modelu ristu populace pod tlakem nespecializovaného preddtora
v pripadé 2. b)
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S

¢) Nit < —:
,

]

Nastaveni parametri: 5= 200: r= 1 K= 1000 :‘._ﬁra t 1_3-15:

ﬂ}iln:1}1vn;rhiirlfﬁPrujrdnuﬂ"m;huﬂpqq;ﬁﬂ:
for ¢ from 1 e 20 do
NO =50
P "‘ﬂ__L 5 N[t} = N
(] 1= O ar N - 1-2380 ) - ] ] o]
ves[ ] 1= drafve dr..'u[ﬂ =N [I B } .nf.--".,r“] Nie) 5 .-"-'b'rr'?[“] = N0 |, numierie
Nirn
graf| 1] == plots| odeplor) (res| £]. r=0 .15, theckmess = 3, labelz= [ ", "Ny |. fonr = | Tones. roman, 12 ],
labelfors= | Tanes, bald, 12], manpoinrs = 1500) :
end o

Vytvoben grafu pro hadootn V= N

NG %.[., ,‘ﬁ}

J ek )

5 NWiry > M

: 4 arir) = Nit) O = :

res[21] = drolve r.m-r-.w:]-[h ] 5 o NUD) = NO |, numeric |
I:il' FE:; ."l”_l:l ."l.[]':l it Nkrd

graf | 21] = plows| edeplor] (res[ 21 ], r=0..15, thickress = 3, labels = [ *r, "Ny |, fonr = [ Tinas, romea, 12],

labelfornt = | Times, bold, 12, mumpoints = 1500) :

Obrdzek 3.24: Reseni modelu ristu populace pod tlakem nespecializovaného preddtora v pripadé
2. ¢)

Vvkreslent grafo:
plote| display || seql graf| £], i=1.21] )
100

A0

Ll

400

200

Q 5 1{r 15 20
i

Obrdzek 3.25: Reseni modelu ristu populace pod tlakem nespecializovaného preddtora v pripadé
2. ¢c)
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Pokud NO > N,, velikost populace se ustali na rovnovazné hodnoté Nj3. Pokud
NO < N,, ustali se na hodnoté 0. Pro NO = N, ztstane velikost populace kon-
stantni. Predator tedy zmensi ustalenou velikost populace nebo populaci vyhubi
v zavislosti na jeji pocatecni velikosti — obrazky 3.24 a 3.25 pro nastaveni para-
metri:

S =200, r =1, K =1000, Niz = 400, NO € {50,100, ..., 1000}
= Ny =276, Nz =724

Ptedeslé moznosti chovani modelu plati pro spojity pfipad (3.16). V diskrétnim pfipadé
(3.15) je situace slozit&jsi. Obrazek 3.26 ilustruje moznost 2. a) (tj. S < }1 17+ K, Nigig > Na)
v diskrétnim piipadé. V levém grafu jsou vykreslena vSechna feseni najednou, v pravém je
vytvorena animace v zavislosti na pocatecni velikosti populace. Miizeme vidét, ze v tomto
pripadé se velikost populace v ¢ase neustali na jedné hodnoté, ale osciluje kolem ni.

Masiavend parametran 5= 30; ri= 32; K= 1000 Nbr = 500: posloupnost = Pactor(20) :  {pripad 2.a)

Cvkdes vwivorend grafi pro jednotlivé hadnary Y-
for | from | 0 20 do

N YJRi] = 50-i:
for ¢ from 2 to 30 do
¢ i g Wit — 1] o] > Nirar )
oeh ok . , N[e=1]0¢] 3 :
NI#)[1] = wvalf] M= 1) [ ) #r-Nfe—a)a[2 - ZR2HE) i A
\ R b D LR B DR
| N 5 |
end dac

postoupmost| ] = reg( [r = 1, N[e][d]].0=1 .30}

graf| 1] = plar| | pasloupman] 1] |, syie = poinr, nmbol = saliderrele, nmbodnie = 20, labels= [ =, "1 |, fomt = | Tomes,
rgemare, |2 |, dadalfoarr = | Tammes, bodd, 12] ) :

el da:

Vikreileni grafa na jedn o Vikreslemi grafa v aninsaci:
ars any | [ g | i, i=1.20)) ofs ay | | seg| ] f=1 .20}, meeguence = frue
display| [ seq( gr 1.20) plots] display || seq 1.20), meg J

& ® ® & & ® &
LD o

A

3

ARRR:

Obrdzek 3.26: Reseni modelu ristu populace pod tlakem nespecializovaného preddtora v diskrétni
podobé pripadu 2. a)

Pii urc¢itém nastaveni parametri se nam dokonce mtze stat, ze feseni modelu bude
dosahovat zapornych cisel, jak ilustruje obrazek 3.27 pro moznost 1. a) (tj. S > i cr- K,

Niit < —). Pri¢inou je pfilis velky ¢asovy krok pro dané hodnoty parametrit modelu.
r
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Mastaveni parameedra; 5= 500: ro=1: K= 1000: Now:=200: posoumost = Fectar|20}: (pripad La)

Cyldies vvivoreni grafi pro jedmoilivé bodnoky W0
For | from | 1o 20 da

N[1][] = 305
for ¢ from 2 to 20 do
i —— 5 Mr=1]]] > N )
Nl i) = evalf| N[e=1][i] +r-Nje=1]{¢]-] 1 = it 1| L] 5 % . . T
( K ] :;l;l-:-r-l-r--.":[a—l.|[||."||.—l [ 1] = Airar
wnd dix

podoupnont] f] o= segl [0 = L. N[r][d]].r=1.30):
grafl ] = plov| | pastoupnosr] i] ], sode= point, fmbol = solideirole, symbalrine= 20, lobels = [ =, "=y |, ford = | Temes,
roman, 12 |, labeifort= | Towes, bald, 12]]

end dac
Vkreslend grafi na jednoa: Vykresleni grafa v anbmach
plocs| dusplay | [ seg{ graf 1], 1= 1 .20] ) oy | display | [ segl geaf] ¢]. 6= 1 200, S wmes = frue)
100y 100
B o]
£ L]
iLh [ .
41060 m
.
2000 o
FF L :
@ 3 18 i3 - 3%
I

Obrdzek 8.27: Reseni modelu ristu populace pod tlakem nespecializovaného preddtora v diskrétni
podobé pripadu 1. a)

3.3 Interagujici populace

Uvazujme obecné diskrétni rovnici (3.13) z predeslého modelu vyjadfujici rist populace
v omezeném prostiedi, tj. rovnici

N(t+h) = N(t) + r-N(t)- (1— @) -h, N(0) = NO (3.20)
a jeji diskrétni variantu
N(t+1) = N(t) + r-N(t)-( —%) N(0) = NO (3.21)
a spojitou variantu
N'(t) = r-N(t)- (1 - %) . N(0) = No. (3.22)



Rovnici neomezeného (exponencialniho) ristu populace

N(t+h) = N(t) + r-N(t)-h, (3.23)
pripadné jeji diskrétni variantu
N({t+1) = N(t) + r-N(t) (3.24)
nebo spojitou variantu
N'(t) = r-N(t), (3.25)

lze povazovat za speciélni pfipad rovnice (3.20), pfipadné (3.21) nebo (3.22), pro K = oo,
nebot

pro jakoukoliv hodnotu N (t).

Nyni pfedstavime nékolik modeli dvou, piipadné tii, interagujicich populaci. Modely
budeme prezentovat v diskrétni i spojité varianté, analyzu jejich feSeni vsak budeme uvadét
spolu s priklady v Maple pouze pro spojity piipad.

3.3.1 Modely dvou interagujicich populaci

Nyni budeme uvazovat dvé populace na jednom tzemi. Ozna¢me Nj(t), resp. No(t),
velikost prvni, resp. druhé, populace v Case t. Pokud by na sebe populace vzajemné neptiso-
bily, vyvoj velikosti kazdé z nich by bylo mozné modelovat pomoci rovnice (3.20); o kterou
z populaci jde, bychom odlisili dolnim indexem u vSech parametrii, tedy

Ni(t+h) = Ni(t) + - Ni(2) - (1 — Nl(t)) - h,
Ny(t +h) = Na(t) + ro- No(t) - (1 - N2—(t)) - h.

Vliv velikosti jedné populace na rist druhé se muze realizovat bud prostfednictvim pro-
stredi, které obé populace obyvaji, nebo primo.

Model, kdy j-ta populace ovliviiuje prostiedi, v némz Zije i-ta populace

Necht i, j € {1,2},7 # j. Kvalitu prosttedi pro i-tou populaci v nasem modelu vyjadiuje
jediny parametr K; — uzivnost (nosné kapacita) prostfedi. Pokud j-t4 populace ovliviiuje
prosttedi, jeho tizivnost jiz nebude konstanta K, ale bude zaviset na velikosti j-té populace.
Konstantu K; nahradime funkei x; argumentu N, (). Vyvoj i-té populace tedy bude popsan
rovnici

Ni(t+h) = Nit) + i Ni(t) - (1-%) h. (3.26)

Nyni budeme specifikovat funkci x;. Ta musi spliiovat dva pfirozené predpoklady:
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e Pokud neni j-t4 populace pritomna, je izivnost prostfedi nezménéna, tedy rovna pu-
vodni hodnoté K;. Presnéji

e Pokud je j-t4 populace velikd, zméni GZivnost prostfedi na hodnotu Cj;, tedy

lim  k;(N;(t)) = Cyy.

Nj(t)—o0

Jednoducha funkce, ktera spliiuje obé podminky, je funkce lomené s linearni funkei v ¢itateli

i jmenovateli, tedy
_ Kl + Cij *Yig Nj(t)

(NG (t 3.27
i (N(0) 1+ 735 - Ny (t) (3:27)
E+ C vy x
1 (x) = zl 5V
+”,r:,j-x
x— At CUYU}C
1 -I-'\;'U.x
d
evai[ﬁmjl{x],x=0]
er_Kr
oty — 5%y
er_Kf
simplify (%)
q‘{gj

Obrdzek 3.28: Vyznam parametru v;;.

V predpisu funkce se objevuje novy parametr «;;. Abychom lépe pochopili jeho vyznam,
ur¢eme derivaci funkce x; v bodé 0 a vysledek vydélme rozdilem C;; — K;. Obréazek 3.28
ilustruje tento vypodet v systému Maple?!.

Parametr v;; vyjadiuje relativni zménu tzivnosti prostfedi pro i-tou populaci zptisobenou
malou (invazni) j-tou populaci vzhledem k celkové mozné zméné uzivnosti prostiedi.

Je pfirozené predpokladat, ze konstanty [;, C;; jsou nezdporné (v prostfedi nemize byt
populace zédporné velikosti) a ze alespon jedna z nich je kladné (prostfedi populaci nékdy
uzivi). Vztah konstant K; a C;; vyjadiuje ekologickou klasifikaci vztahu j-té populace k i-té:

® Kz = Cz'j

J-té& populace je k i-té neutrdlni.

o ;> CZ']'
j-t4 populace je amensdlem?®® populace i-té.

21Pro nézornost a moznost vipoctu v Maple bylo provedeno oznadeni x = N;(t).

22 Amensalismus je populaéni vztah, pfi némz jedna populace uvoliiuje do prostfedi odpadni produkt nebo
specidlni 14tku, kterd populaci jiného druhu ovliviiuje negativné (potlacuje rist a vyvoj, zpiisobi i zénik)
[18].
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o I(; < Cz‘j
j-t4 populace je komensdlem® populace i-té. V této situaci miizeme dale rozlisit:
— K; = 0 — +-t4 populace by bez pfitomnosti j-té neptezila; j-t4 populace je obli-
gdtnim komensdalem populace i-té.
— K, > 0 — i-ta populace pfeziva i bez ptritomnosti j-té; j-ta4 populace je fakultativ-

nim komensdlem populace i-té.

Z rovnosti (3.26) a (3.27) dostavame model vyvoje velikosti dvou interagujicich populaci
ve tvaru soustavy rovnic

Ni(t+h) = Ni(t) + ri- Ny(t) - (1 _ Ni(t) - (1 + 712 N2(t))> h,

Ky + Chz - m12 - Na(t)
(3.28)

No(t+h) = Na(t) + - No(t) - (1_ Na(t) - (1+721'N1<t))> .

Ky 4 Coy1 - 21 - Na(2)
Tuto soustavu rovnic mizeme pro h — 0 konkrétné zapsat jako soustavu rovnic diferen-

cidlnich
Ky 4 Cig - 712 - Na(t) ’

(3.29)
Na(t) - (14721 - Ni(2))
Ny(t) = ro- No(t)- | 1 — .
2( ) 2 2( ) ( Ko+ Cop - o1 - N1(t)
nebo pro h = 1 jako soustavu rovnic diferenc¢nich
Ni(t+1) = Ni(t) + r1-No(t)- | 1 — ,
i ) 1) + 11 Ni(?) ( Ky + Ciz - 712 - No(t)
(3.30)

No(t +1) = Ny(t) + 79+ Ny(t) - <1 - () - (14721 - Nl(t))> ‘

Ky + Cy1 - o1 - Ni(t)

V pripadé komensalismu miize dojit i k tomu, Ze populace komensala pii rostouci velikosti

zvétsuje uzivnost prostiedi nade vSechny meze, %1{11 Ki (N j (t)) = 00. Nejjednodussi funkce,
Nj(t)—oo

ktera modeluje tento jev, je funkce linearni
Ri(Nj (1) = Ki+ i - N(8).
Zde kladny parametr v;; vyjadiuje absolutni narist tZivnosti prostiedi pro i-tou populaci
zplusobeny j-tou populaci o jednotkové velikosti.
Model konkurence (kompetice)

Model konkurence vyjadiuje interakci mezi populacemi zptsobenou sdilenymi pozadavky
na zdroj, ktery je omezené dostupny [20]. Obé populace si timto vzajemné snizuji Gzivnost

2 Komensalismus je popula¢ni vztah, pii némz jedna populace vyuziva jinou bez jejiho poskozovani (jedna
populace mé ze vztahu prospéch, druhé neni ovlivnéna) [18].
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prostiedi. Velikosti obou populaci se ustali na novych rovnovaznych hodnotach mensich,

nez byly hodnoty pro izolované (vzajemné se neovliviiujici) populace.

with| DEraals ] @ & pro piikar DEplor
Rowvnice:

.'-.'m-{j-l-*,d_‘-.".',u:l‘,
d 4 i 1

= =, o E - v
i Bt kb .m[t K, + €, W2-¥,(1) ]

Mk f1+wi-Nin
**'"lﬂ'::'=i‘i'~':1=+-r1-.'~':[n-[t— alt| i ’]:

4 K.+ €, 01 (1]
N ESENERD parapselEis

Fy b L ry s 0.6 J:'! = 100 : K: = ] 5K :
Wi=05%5: ¥ =103 E'u=|‘.il.'|l:-l: f.'” = 1)

Cyvklus vetvoieni geafin pro Jedunotlive hodnoty .i"-'!l: N,

for i from | 164 do

fowr | fircoms | 0ok i

."l'ﬂ.l e 3 = ."I-'ﬂ: 1= s 00

p'q;l"[l'r =1}d 4 j] om .ﬂﬁ?ﬁm“mmt.mm:l-[\’lhr,.'leﬂ o
=i ..15,[ |.‘~'|E|.'l] -ﬁ'ﬂl.fi‘:fﬂ] -.'ﬁ'ﬂ_.lll,m- |r, .\"llrr'l-f-uml'w
= Blgek, labals = [ o0, *3ir |, aumpossy = I:ﬂ-l:l:I,:

grafi] (4= V)4 4 1] = Diplor| | renwice,, rovaice, |, | Ny (2], Nyle) ] ¢
={) ..'IE.[ |.‘-'.|W] '."-'III..i'-':W] ‘.‘l-'li':”..Wl'lwl"'l |i'..i"|"11rlj.fnn:'¢h
= groee, labels = [ 260y | mumpodeis = 1500 :

el do

emdl doc

Vykreibeni grafa:
ploes| display |{ seq{ graf [ 1], 1= 1 .18),
seql grag?d], f=1 18]} )

g B

[T

£

EEBEREE R

-
-
E

[ 3 1) = = = 201

Obrdzek 3.29: Reseni modelu konkurence dvou populaci.

wieh| DErnls | 1 £ pro pidar DEplar
Rovaber:

MoEh 1 b w0
rovRie, b= %."{I{”-rl_l\rﬂ”_[:_ ] { 3 :I]

K, + € H2Nir)
L ADHERS TR ALY
K, +C, 21N, ir) '

ravmice, = %.‘-’!hb =ry N1} [l -

r:._-l-l: r:'ﬂﬂ.-ﬁ-: rl‘-_-:]m! x:.'-!m:
2=l ) =03 -l':_l,|I = o 1:'11 = el 2

Cvkibus vyrvobomi grafo pro jednotlive hodnery .ﬁ‘-ﬂ'l i .‘n'l= H

e i from 1 va S da

for ) from | 1ol do

MO, = 300 NG, =300

palf[{i—1)-534+]] =.£:l5¢_‘;ul'ﬂ.[|'mnlr.rl.rmnﬂ:]. |."|'1[::|,."|.‘=[r]|.:
-'J-.IL|[.\'LIDI--"-'I'J'1"'-‘=lﬂr -.1‘11':]].#“!-- |.¥.1n..v:1=r].
Imecalor = green, labaly= |30, *xar |, diied= 10, avour
= large, rumpossts = 1500, color = back) :

wind i

el doe

Vkreibeni grafa:
plots | diplay | | segl graf | 1], 1=1.9] )
e L i

1400 '~x_ .

.5\ P

i | : P
R Ll 8 F
- s

e |
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Obrdzek 3.30: Reseni modelu konkurence dvou populaci — smérové pole.
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Obrazek 3.29 ukazuje priklad feseni modelu konkurence v Maple. Pivodni Gzivnosti pro-
stfedi jsou rovny 1000, resp. 1500, tj. v pripadé, ze by se populace vzajemné neovliviiovaly
(neovliviiovaly by prostfedi, v nemz ziji), ustalily by se jejich velikosti na zminénych hodno-
tach. Pro model konkurence plati K7 > C15 a Ky > Cy;. V piikladu na obrazku byly zvoleny
hodnoty konstant Ci5 = 600 a Cy; = 1000.

Reseni bylo vypoditano pro riizné pocatecni velikosti populaci N0y, N0y € {300, 600, 900,
1200} tak, aby byly pokryty vSechny vzajemné moznosti. Vidime, Ze feSeni nemé vliv na
pocatecni velikosti populaci a vzdy se velikosti obou populaci ustali na hodnotach C15 a Cs;.

K zobrazeni grafii jsme pouzili pitkaz DEplot?* k vykreslovani feSeni systému diferenci-
alnich rovnic z baliku DEtools. Symbol v je v systému Maple obsazeny, parametr 7;; proto
zadévame s indexy za Feckym pismenem (¢imz vytvofime neobsazeny nazev pro proménnou).
Dvéma do sebe vnorenymi for-cykly vytvarime grafy feseni pro riizna nastaveni pocatecnich
hodnot.

Jednim z parametrt prikazu DEplot je atribut scene, v némz specifikujeme zavislost,
kterou chceme zobrazit. Ve vSech grafech v tomto textu vykreslujeme zavislost velikosti
populace na case. Nastavenim parametru scene miizeme téz zobrazit zavislost velikosti jedné
populace na velikosti druhé spolu se smérovym polem. Tuto moznost ilustruje obrazek 3.30.

Pro zobrazeni jednotlivych feseni muzeme vytvorit animaci podobné jako u predcho-
ziho modelu v diskrétnim piipadé. K programovému kodu z obrazku 3.29 staci pridat kod
z obrazku 3.31.

| fear ¢ from 1 to 16 do
: .r.lll:.'l.'.'i |i I:!.'.'ll":! .:I':;.l!-.'l I' i_l.{-'.'l_,'-l .'.. _lc'l..l.li-\I II ||
| emd dioc

:||'l\.||:.':|| |.|I_IFI.|'H. | Sy | e et | I f=1.161, LR RO = P |

1 H

Obrdzek 3.31: Reseni modelu konkurence dvou populaci — animace.
Model mutualismu (symbidézy)
Symbidza se vyznacuje oboustranné kladnym ovliviiovanim dvou populaci [18]. Obé populace

si v tomto pripadé vzajemné zvysuji izivnost prostiedi. V pripadé ,,omezeného ovliviiovani®
modelovaného rovnicemi (3.29) nebo rovnicemi

24Piikaz DEplot nabizi volitelny parametr numpoints podobné jako piikaz plot. V tomto p¥ipadé viak
byva parametr numpoints standardné nastaven na hodnotu 49.
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NI(t) = - Ni(t) - (1 -

Ny(t) = 12+ No(t) (1 e +ZX( t.)Nl <t>)

Ni(t) - (14 s - N2<t>>>
Ki+Cia-ma- No(t) ]

(alesponi jedna z konstant Ci2, Co; je konecnd) se velikosti obou populaci ustali na novych
rovnovaznych hodnotach. V piipadé ,neomezeného ovliviiovani“ modelovaného rovnicemi

NI#) = - Na(t) (1 - +f112(‘f)N2(t)) ,

Nj(t) = 7y - No(t) - <1 % +]le(t-)zvl(t)>

zélezi na hodnotach parametri vi2, y21. Pokud 715 - 791 < 1, velikosti obou populaci se ustali
na novych rovnovaznych hodnotach. Pokud ~;5 - 791 > 1, velikosti obou populaci rostou nade
vSechny meze. V realité by to znamenalo, ze populace znic¢i svoje prostredi. Tomuto jevu se
iikd ,orgie vzajemné dobrocinnosti.”

Obrazky 3.32 — 3.34 ilustruji rtizné podoby chovani feseni modelu symbidzy. Na prvnim
z nich je znazornéno feseni ,omezeného ovliviiovani“, kdy jsou obé konstanty Cis, Co; ko-
necné a velikosti populaci se ustali na téchto hodnotach. Obréazek 3.33 ukazuje ,neomezené
ovliviiovani“ v pripadé€ vis - 791 < 1, obrazek 3.34 v pripadé vis - 791 > 1.
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Obrdzek 3.32: Reseni modelu symbiozy dvou populaci pro Cra < 00, Ca1 < 00.
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Obrdzek 3.33: Reseni modelu symbiozy dvou populaci pro C1a = Co1 = 00, Y12 - Y21 < 1.
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Obrdzek 3.34: Reseni modelu symbiozy dvou populaci pro C1a = Co1 = 00, Y12 - Y21 > 1.
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Model predace

Obecné 1ze vztah predace definovat tak, Ze jedna populace (kofist) zvétsuje Gzivnost prostiedi
pro druhou populaci (predatora) a soucasné druhd populace zmensuje ristovy koeficient
populace prvni. Zmenseni ristového koeficientu mize byt zpiisobeno jednak vlastni predaci,
tj. fyzickfm hubenim kofisti a tim zvétSenim jeji timrtnosti. Lze ho téz modelovat jako
zmenseni Uzivnosti prostiedi a interpretovat tak, ze kofist nemtiize plné vyuzivat zdroje
prostfedi, nebof se musi pied predatory skryvat. Tento druhy pohled na predaci miiZeme
zformulovat jako model poulaci ovliviiujicich prostfedi, v némz obé populace ziji. Pfitom
prvni populace (kofist) zvySuje uzivnost prostfedi pro druhou populaci a druhd populace
(predator) naopak tzivnost prostfedi pro prvni populaci snizuje. RozliSme dva piipady:

e predator je specializovany — bez populace kofisti nemize prezit (K, = 0),

e predator je nespecializovany — muze prezit i bez populace korfisti, ale dostupnost po-
pulace kofisti ho ovliviiuje (K3 > 0).

V obou pripadech se velikosti populaci ustali na néjaké rovnovazné hodnoté. U tohoto
modelu predator nemtize kotist vyhubit (na rozdil od modelu 3.2, kde byla velikost populace
predatora na populaci kofisti nezévisld) ani v piipadé, Ze zmensi kapacitu prostiedi pro
populaci koristi na nulu, Ci5 = 0.

Alternativni modely predace jsou uvedeny na str. 53 a v podkapitolach 3.3.2, 3.3.3.

Obrazek 3.35 ukazuje feseni modelu predace v pripadé specializovaného predatora.
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Obrdzek 3.35: Reseni modelu predace pro Ko = 0.
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Modely, kdy j-ta populace ovliviiuje relativni pfirustek i-té populace

Necht stéle i, j € {1,2},i # j. Vyvoj i-té populace, na niz ptisobi populace j-t4, budeme
modelovat rovnici stejného typu, jako je rovnice (3.20). Vliv j-té populace na i-tou vyjadiime
zménou relativniho prirastku i-té populace

(120,

Budeme ptedpokladat, ze j-ta populace, pokud s populaci i-tou interaguje, k tomuto pri-
rustku pridava (nebo od ného ubird) néjakou hodnotu. A dale, Ze tato hodnota je tim vétsi,
¢im vétsi je velikost j-té populace. Opét zvolime tu nejjednodussi moznost: budeme predpo-
kladat, ze zména relativniho prirtistku i-té populace je piimo tmérna velikosti populace j-té
a konstantu tmeérnosti oznacime (;;. Parametr (;; budeme povazovat za kladny, druh vlivu
J-té populace na i-tou rozlisime znaménkem. Je-li tedy j-ta4 populace komensalem populace
1-té, bude vyvoj i-té populace popsan rovnici

Nt +h) = Ni(t) + Ni(t) - (7" (1—NZ’T“>> +@j-Nj(t)) b=

Tento model lze jednotné zapsat ve tvaru

Ni(t+h) = N;i(t) + Ni(¢t) - <ri—%-N,»(t)+sij~ﬁij-Nj(t)> - h,

kde

1,  j-ta populace je komensalem i-té
Sij = C . , C
! j-ta populace je amensalem i-té.

Dynamika dvou populaci tedy bude modelovana soustavou dvou rovnic

Ni(t+h) = Ni(t) + DNi(t) - (7“1 — %-Nl(t) + 512 'ﬁl?'Ng(t)) - h,

1

(3.31)
No(t +h) = Na(t) + Ny(t)- (7’2—2-]\[2@)—1—521 - Bon .Nl(t)) h.
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Pro h — 0 dostaneme soustavu Lotkovych-Volterrovych obycejnych diferencidlnich rovnic

MO = 30 (11— 5 0) 41 e Nal0)),
(3.32)

N0 = Na(t)- (12 = 2 Nal0) s - ()]

Model konkurence (kompetice)

Model konkurence v tomto pripadé vyjadiuje situaci, kdy si obé populace vzajemné snizuji
své relativni piirtstky:

Ni(t) = Ni(t) - (7“1 - [7;.—11 “Ni(t) — Pra - N2(t)) :
Nj(t) = No(t) - <r2 - [7;—22 - No(t) — (a1 - Nl(t)) :

Na zékladé vztahti mezi parametry muzeme rozlisit ¢tyii rtizné kvalitativni vysledky
modelu:

o I < ﬁ , Ky < . velikosti populaci se ustali na hodnotach mensich nez pivodni
21 12

uzivnosti — koezistence populaci (analogicky vysledek k predchozimu modelu konku-
rence), obrazek 3.36.
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Obrdzek 3.36: Reseni modelu konkurence pro K; < —— ﬂ , Ko ﬂ
12
o K, 6 , K5 > ——: velikost druhé populace se ustali na piivodni iZivnosti prostredi,
21

12
tj. na hodnoté K, velikost prvni populace se ustali na hodnoté 0, tj. prvni populace
vymfie (konkurenéni vylouceni proni populace), obrazek 3.37.
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Obrdzek 3.37: Reseni modelu konkurence pro K; < —— ﬂ , Ko ﬂ
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Obrdzek 3.38: Reseni modelu konkurence pro K1 > —, Ko < —
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o K| > 5 , Ko < —: velikost prvni populace se ustali na ptivodni Gzivnosti prostiedi,
21

12
tj. na hodnoté K, velikost druhé populace se ustali na hodnoté 0, tj. druha populace
vymie (konkurencm vyloucent druhé populace), obrazek 3.38.

1
o K| > /6 , Koy > —: jedna populace vymfe, velikost zbyvajici se ustali na pivodni
21 12

uzivnosti prostiedi. Ktera populace vymfe, zavisi na pocatec¢nich hodnotéach, jak do-
kumentuje obrazek 3.39. Pro zjisténi, ktera z populaci vymre a pfi jakych pocate¢nich
hodnotéch jejich velikosti, miizeme opét vyuzit animace zobrazujici jednotliva feseni,
viz obrazek 3.40 .
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Obrdzek 3.39: Reseni modelu konkurence pro K1 > —— 5 , Ko /6
12

Model predace

Prvni populace (kofist) zvySuje relativni pfirtistek druhé populace (dravce), ktera prvni
populaci hubi a tim jeji relativni pfiriistek snizuje:

(1) = M) (n—— N(t) - 512'N2(t)>,



fowr 1 frooms 1 0o 16 di

aimace] 1] 1= plovs] display | [ (g ], gral|41})
eml dic

plu-h'|d'ﬂp'q}'lhqlmm'| il f= 1 ..1%],

L EERCE =

84} 10 - !

a y
3 13 13 m
[ §

[ W11} = = = NN}

2

P21

1

B2

Obrdzek 3.40: Animace TeSeni modelu konkurence pro K1 > , Ko >
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Obrdzek 3.41: Reseni modelu predace pro Ko < SATy
12
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Ponévadz konstanta K> je ve jmenovateli, musi byt nenulova, tj. Ko > 0. Jedné se tedy
o nespecializovaného predatora, ktery miize pfezit i bez uvazované populace kofisti, tj. ma
néjaké alternativni zdroje potravy.

”
Pokud Kj < —1, populace koexistuji, jejich velikosti se ustali na néjakych hodnotach —

BIQ

e o RS "
u populace koristi mensi nez K, u populace dravce vétsi nez K,. Pokud Ky > ﬁ_’ dravec
12
korist vyhubi. Popsané pripady ilustruji obrazky 3.41 a 3.42.
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Obrdzek 3.42: Reseni modelu predace pro Ko > Sy
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3.3.2 Model dravec-korist Leslieho typu

Budeme predpokladat, ze populace predatora zmensuje relativni prirtistek populace ko-
fisti a ze populace kofisti zvétsuje tzivnost prostiedi pro populaci predatora. Velikost po-
pulace koristi vlastné urcuje velikost tzivnosti prostfedi pro populaci predatora. Pokud by

tedy byla populace kofisti neomezena, byla by neomezena i Gzivnost. Za téchto predpokladii
a pri oznaceni

Ni(t) ... velikost populace kofisti v ¢ase t,
Ny(t) ... velikost populace predatora v ¢ase t

dostavame model vyvoje velikosti populaci ve tvaru
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Nl(t+ h) = Nl(t) + Nl(t) : (7“1 — =" Nl(t) — Q12 Ng(t)> . h,

No(t +h) = Ny(t) + 7o No(t) - (1 — Nz(t.) ) - h.

V pripadé Ky = 0 se jedna o specializovaného predatora, v piipadé K, > 0 o nespecializo-
vaného. Pro h — 0 dostaneme soustavu diferencialnich rovnic?®

1(t) = Ni(t) - (7“1 K Ni(t) — o2 - Nz@)) ;

é(t) = T'Q-Nz(t)- (1— K2+721‘N1(t)

with | DEroals | ¢ 8 pro pftkar DEplot Vykreileni grafi:

piaty| dinplay ] [ seg( graf| £ 0=1.3],
Rovndce: soql graf2[ 1], i=1 .3}
d .. . "o . ._
roTice, | F..IIH-."-Iﬂrl-[r.l R_—l-.‘-ll_rl “;.-"'1':“[”|'
4 P N (1) o
FOVHISE, = N (] e A )| 11— s - s
LA ¥ L K, +21-N (1] L
m
Mastaveni parametra; L}
Pl pym0S K o 1000: K, = 1500:
& =00001: M =03: (k]
]
Cykius vytvobeni grafii pro jedsotlive bodnoty V8, 5 N8, : =
- N
For 1 Ercam | 1a 3 ala
] ] L] [ | 5]

."-'l!i'l = M f2 .'l.'-!J;. = TO0-[4 - f]:

p.ujl]i = ﬂ.r_.d:' I.nm'lﬂﬁll.:rn“n;r_.|.|-."|-5‘|J:I._"|.':|_I|].F-'-ﬂ i
||."|-'|II}I-."-'-Ell_..'l-'_-.illll-."-'I!i'_.||.:-cm-i.‘.."t'||,r||.[mm'|:r--b.lu-cl'.
Labely= [ *, "N(1)"], mampomrz = 1500 : w1 = = = N1}

erafdl i) : E'Ep1'-?.'|: | FETIE POV | |.'~'|1r|-."-':|4 ] |. r=g.1n0,
| |.‘t'|| ) = .'ﬁ'{ll_..'ﬁ':.illll -."n'ﬁ'_. | |.:-n"rr¢ = [?.."t'_..(rl |.|'mu|'w-§'ﬂ'rr.
Fabels = | *0, "M |, rowpoiiez = 1500 :

end do

Obrdzek 3.43: Reseni Leslieho modelu pro Ko < ANy
012

r
Analogicky k predeslému modelu predace populace koexistuji v ptipadé K, < R pii-
Q12
r
padé Ky > —L dravec kofist vyhubi (tato moznost mize nastat jediné v pfipadé nespeciali-
Q12
zovaného predatora, Ky > 0).

Z5Model popsany témito diferencidlnimi rovnicemi nazyvame modelem dravec-kofist Leslieho typu [21].
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Obrdzek 3.44: Reseni Leslieho modelu pro Ko > l.
12

3.3.3 Model dravec-korist Gauseho typu

Budeme predpokladat, ze velikost populace kofisti, pokud by byla pfitomna populace
predatora o neménné jednotkové velikosti, by se vyvijela podle rovnice

Ni(t)
Ky

Ni(t+h) = Ni(t) + ri- Nio(t) - (1 — ) +h = p(N:(1)) - h,
stejné jako populace pod konstantnim tlakem nespecializovaného predéatora (viz podkapi-
tola 3.2). Vyraz p(/NV1) vyjadfuje mnozstvi kofisti, které za jednotkovy ¢as zni¢i populace
predatora o urcité velikosti. Tu miizeme povazovat za jednotkovou, pokud mé populace ko-
Fisti velikost Ni(t). Funkce p = p(N7) se nazyva trofickd funkce nebo funkciondlni odezva
preddtora na populaci kotisti o velikosti Ny [10].

Populace predatora o velikosti Na(t) tedy za jednotku ¢asu zniéi Ny - p(N7) kofisti. Vyvoj
velikosti populace kotisti proto bude popsan rovnici

Ni(t+h) = Ni(t) + r1- Ny(t) - <1—NI1<—“)> b= No(t)-p(Ni(1)) -h. (3.33)

O predatorovi budeme predpokladat, Ze je specializovany (bez pfitomnosti kofisti nemtize
prezit). Vyvoj velikosti jeho izolované populace by tedy bylo mozno modelovat rovnici (3.23)
se zapornym rustovym koeficientem, tj. rovnici

No(t+h) = No(t) — 5 Na(t) - h.
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Déle budeme predpokladat, ze mnozstvi kotisti No(t)- p(N1 (t)) -h znic¢ené populaci predatora
za Casovy interval délky h se s néjakou efektivitou ¢ pfeméni v populaci predatora. Z tohoto
predpokladu dostaneme rovnici popisujici vyvoj velikosti populace predatora, ktery zni¢enou
korist transformuje do prirtistku své velikosti; tato rovnice je tvaru

No(t+h) = Ny(t) — 6-Na(t)-h + c- Na(t) - p(N:(t)) - h (3.34)

Limitnim pfechodem h — 0 dostaneme z rovnic (3.33) a (3.34) model vyvoje velikosti po-
pulaci kofisti a dravce jako soustavu dvou obyéejnych diferencidlnich rovnic?

Ni(t) = r1- Ni(t) - <1— Nf?—@) — Ny(t) - p(M(2)),

Ny() = Na(t) - (= 6+ c-p(Ni(1)) ).

Jeste je tfeba specifikovat trofickou funkci p. Mtizeme pouzit stejnou funkeci jako v modelu
vyvoje populace pod tlakem nespecializovaného predatora, tj.

S
‘N . N < N,
Nkrit o kit

p(N) = (3.35)
S . N> Nkrit-

Tato troficka funkce byva v ekologické literatute nazyvana Hollingova typu I. Funkce podob-
ného prubéhu, tedy konkavni a takova, ze p(0) = 0 a lim p(x) = 5, avSak diferencovatelna

(hladka) se nazyva Hollingova typu II. Nejjednodussi takova funkce je lomend

Ny
Ny)=S5" ;
p( 1) N1+0_’

kladny parametr ¢ ma podobny vyznam jako Ny,. Plati totiz

p'(0) = pro funkci typu I, p'(0) = 5 pro funkci typu II.
Nkrit g

Necht funkce p je nejprve trofickd typu I. Obrazky 3.45 a 3.46 ukazuji, Ze pro § > ¢ - S
vymie populace dravce a pro § < c¢-.S obé populace koexistuji pti libovolnych nenulovych
pocatecnich hodnotach.

V pripadé, ze funkce p je troficka typu II, populace dravce opét vymie pro § > ¢ - S.
Jestlize 0 < ¢ - S, obé populace koexistuji tak, ze se jejich velikosti ustali, pokud navic

Ki—o -0
§>c- 9 =2 , nebo kolisaji, pokud 0 < c¢- S - :
1+ 0 1t+o
pripadt poskytuji obrazky 3.47 — 3.49.

. Grafické znazornéni zminénych

26Model popsany témito diferencidlnimi rovnicemi nazyvame modelem dravec-kofist Gauseho typu [8].
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Obrdzek 3.45: Reseni Gauseho modelu v pripadé, Ze p je trofickd funkce typu I pro § > c- S.

[eh Dl 1| 8 g i Dlpdar

M‘lﬁ-l::ﬂﬂ'l L=l
il = L
Himmboa: I LT
R WA LY .'l'lirl EgE
by = TP =N [' = “'i-'l“ ] ~ain T e M Cxbw |
& .'d_lrll = Now e
o = = : i -
i, j!;-.-rln:l .1'_.1r|‘ dtr L.'Im .'l'ltvlﬂ..'t-} o
L ——— -
Al R mitest Fe): Neew M §al g [y _?
Oyl wymdom grale poo pedmaivd boduoiy N8 0 V8,0 ] i i W L]
Jeifrem | e de 'l
M v A Ny o B 8~ ]
] = DEa] | rerviin, iemindy | [ N 10R AT, =0 B0, | [ N 100 = M0, V100 — TR
—:“llﬂ.n'l-ll*’i. ?"t"'] i = sl el = | "7, "W ). hﬁﬂ-lfﬂ;-
AT o= DM | rorvsn ity | [ MLl ML [0 =0 BB, | [N 130 = N9, N30
-J.'H::!,lf-.l-ll. J.'Jlibl.l'-luhilpuquqﬁﬂwgu'lnaﬂmi.
sl da

Obrdzek 3.46: Reseni Gauseho modelu v pripadé, Ze p je trofickd funkce typu I pro § < c- S.
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Obrdzek 3.47: Reseni Gauseho modelu v pripadé, Ze p je trofickd funkce typu II pro § > c- S.
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Obrdzek 3.48: Reseni Gauseho modelu v pripadé, Ze p je trofickd funkce typu II pro § < c¢- S
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Obrdzek 3.49: Reseni Gauseho modelu v pripadé, Ze p je trofickd funkce typu II pro § < c¢- S
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3.3.4 Spolecenstva n druht — Lotkiuv-Volterrav systém

Opét budeme vychéazet z modelu neomezeného ristu jedné populace ve tvaru
N({t+h)=N(t)+r-N(t)-h, (3.36)

v jeho spojité
N'(t) =r-N(t) (3.37)

60



nebo diskrétni
N({t+1)=N(t)+r-N(t) (3.38)

variante.

Uvazujme spolecenstvo tvorené n populacemi (biologickymi druhy, pfipadné vyssimi &
nizsimi taxonomickymi kategoriemi), které se mohou vzéjemné ovliviiovat. Chceme modelo-
vat vyvoj velikosti jednotlivych populaci v c¢ase. Oznacime

N; = N;(t) ...velikost i-té populace v Case t,
r; ...rustovy koeficient i-té populace.

Vzéajemné ovliviiovani populaci budeme modelovat tak, ze ristovy koeficient i-té populace
r; z&visi na velikostech vSech populaci tvoricich spolecenstvo (véetné i-té), tedy

T’iZT’Z'(Nl,NQ,...,Nn), z':1,2,...,n.
Zvolime tu nejjednodussi moznost, tedy zavislost linearni,

T :al—i-Zbl] N]
j=1

Jednotlivé koeficienty lze interpretovat nasledovné:

a; ... Vnitini koeficient ristu i-té populace. Pokud a; > 0, izolovana i-ta populace by v da-
ném prostiedi rostla, pokud a; < 0, izolovana i-t4 populace by v daném prostiedi
vymirala.

bi; ... Sila vnitrodruhové konkurence nebo kooperace. Pokud b;; < 0, jedna se o vnitrodruho-

vou konkurenci, pokud b; > 0, jedna se o vnitrodruhovou kooperaci.

b;j ... Sila vlivu j-té populace na rist -té.
b;; > 0 ... j-t4 populace je komensalem i-t¢é,
b;j <0 ...j-t4 populace je amensalem ¢-té,
bi; = 0 ... j-t4 populace je k i-té neutralni.

Timto zptisobem dostaneme model vyvoje spolecenstva ve tvaru n rovnic

Nyt + h) = Ni(t) + Ni(t) - <a,» + En: bi; Nj(t)> h, i=1,2,...,n. (3.39)

Obvykle je pouzivan spojity pfipad

N{(t) = N;(t) - (ai + zn:b,-j : Nj(t)) , 1=1,2,...,n, (3.40)

znamy jako Lotkiv-Volterriv systém.
Napriklad model vyvoje dvou konkurujicich si populaci
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Ni(t) = Na(t) - (m — 2 N () = for - Nl(t)) .

je typu (3.40). V ném je

T ]
a1 =T, by = _F’ bio = —512, Q2 = T2, ba1 = —521, by = —?-
1 2

Pov§imnéme si, Ze za systém typu (3.40) lze povaZzovat také model ristu jedné populace

N'(t)=r-N(t) - (1 - %) : (3.41)

. r
zdejen=1,a,=r, a1 = ——.

K
Nékdy je vyhodné, aby vsechny parametry modelu byly kladné. V takovém pripadé po-

lozime?”

a; = |a;|, s; =sgn(a;), Bij = |bij|, 0i; = sgn(bi;)

a systém (3.40) zapiSeme ve tvaru

N,L/(t) = Nz(t) . (Si -+ ZO’Z‘]‘ : ﬁij . Nj<t)> s 1= 1,27 Lo, n.
j=1

Nyni predstavime tii rtizné modely souziti ti1 populaci. Situace je jesté komplikovanéjsi
nez diive, modely obsahuji vice parametri, a je tak vice moznosti, jak mohou vypadat jejich
feSeni. U kazdého modelu si proto ukazeme jen néjaky zajimavy piiklad.

Model konkurence tii populaci

Model konkurence tii populaci je popsan systémem rovnic

Ni(t) = Ni(t)- (ar = Bu1 - Ni(t) = fra - Na(t) — Bus - Na(t)),
Ny(t) = Ny(t)- (ag — Por - Ni(t) — Poa - Na(t) — fPog - N3(t)),
Ni(t) = Ns(t)- (a3 — P31+ Ni(t) — Bo - Na(t) — Bss - Na(t)).

Necht koeficienty spliiuji podminky

b asfs sl

(0 (6] (6]
P . s sbis _ a1lfn 2l
a1 P22 Qg 33 ai B

>1, —
’ aq (33 ’ as B ’ as B2

<1,

2Tsgn je znaménkova funkce, tj. sgn(z) = 1 pro z > 0, sgn(z) = —1 pro z < 0, sgn(z) = 0 pro z = 0.
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Obrdzek 3.50: Reseni modelu konkurence t7 populaci pro kladné pocdtecni hodnoty velikosti kazdé
z nich — generujict kdd.
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Obrdazek 3.51: Zobrazeni 1eseni modelu konkurence tii populact pro kladné pocdtecni hodnoty veli-
kosti kaZdé z nich — grafy.
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Obrazky 3.50 a 3.51 ilustruji vytvoreni grafi feseni modelu a jejich zobrazeni pro rtzné
nenulové pocatecni velikosti populaci. Grafy feseni jsou vykresleny pro kazdou populaci
zvl4st. Mizeme pozorovat, Ze pro libovolnou pocateni hodnotu se velikost populace vzdy
ustéli na stejné hodnoté. Obréazek 3.52 ukazuje pro jedno zvolené nastaveni (kazda populace
mé jinou pocatecni velikost) velikosti vSech t¥i populaci v ¢ase najednou. Piipad, kdy jedna
z populaci neni ptitomna (tj. jeji po¢atecéni velikost je nulovd), je zobrazen na obrazku 3.53.
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Obrdazek 3.52: Reseni modelu konkurence t7 populaci pro kladné pocdtecni hodnoty velikosti kazdé

z nich — jedno vybrané resent.
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Obrdzek 3.53: Reseni modelu konkurence t7 populaci v pripadé nepritomnosti jedné z nich.

Z4dné dvé z konkurujicich si populaci nemohou koexistovat, viechny t¥i dohromady ano.
Jedné se o priklad, kdy komplexnéjsi spolecenstvo (tii konkurujici si populace) je ekolo-
gicky stabilnéjsi (populace dlouhodobé koexistuji), nez spolecenstvo méné komplexni (dvé

konkurujici si populace).
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Predator Zivici se dvéma konkurujicimi si populacemi

Tento model popisuje systém rovnic

Ni(t) = Ni(t)- (041 — Bi1 - Ni(t) — Bra - Nao(t) — Pis - N3(t))7
Ny(t) = Na(t)- (042 — Ba1 - Ni(t) — Bz - Na(t) — B3 - Ns(t)),
Ni(t) = Ns(t)- (— s+ fs1- Ni(t) 4 B2 - Na(t)).
V tomto pfipadé N7 = Ni(t) a Ny = Ny(t) oznacuji velikosti konkurujicich si populaci
kofisti, N3 = N3(t) oznacuje velikost populace predatora.
Zajimava volba parametri muze byt

oy = 1, Qg = 2, 3 = 15, ﬁll = 0005, ﬁlg = 00001, 613 = 003,

Bo1 = 0.01, Bae = 0.005, B3 = 0.02, 31 = 0.03, [35 = 0.002.
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Obrdazek 3.54: ReSeni modelu preddtora Zivictho se dvéma konkurujicimi si populacemi za pritom-
nosti preddtora — generugjici kod.
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Obrdzek 3.55: Reseni modelu preddtora Ziviciho se dvema konkurujicimi si populacemi za pritom-
nosti preddtora — grafy Tesent .
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Pokud N3(0) > 0 (populace predétora je ve spolefenstvu pfitomnd), je tlim Ni(t) >0
—00
a také 1tlim Ny(t) > 0, tj. ob& konkurujici si populace piezivaji — obrazky 3.54 a 3.55).
—00
Zobrazena jsou opét jednotliva feseni, posledni z grafii ukazuje vSechna tii feseni najednou
(kazda populace mé jinou pocatecni velikost).
Pokud N3(0) = 0 (ve spolecenstvu se nevyskytuje predéator), pak pti jakékoliv volbé pocé-
tecnich velikosti populaci kofisti takovych, ze N1(0) > 0 je tlim N5 (t) = 0 (druhé z populaci
—00
kofisti je konkurencné vyloucena populaci prvni). Tuto situaci znazortiuje obrazek 3.56.
Tomuto jevu, kdy populace preziva ve spoleCenstvu pouze za pritomnosti predatora,
se v ekologii ¥ik& koezistence zprostiedkovand preddtorem (predator mediated coexistence).
Predator je v tomto smyslu obligatnim komensalem své kofisti.
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Obrdzek 3.56: Reseni modelu preddtora Zivictho se dvéma konkurujicimi si populacemi za nepti-
tomnosti preddtora.

Predator Zivici se dvéma nekonkurujicimi si populacemi

Model je popséan systém rovnic

N{(t) = Nit)- (041 U ER N3(t))’
Né(t) = No(t) - (042 — a3 - N3(t))a
Ni(t) = Ns(t)- (— s+ fs1- Ni(t) + Os2 - Na(t)).

V tomto piipadé opét Ny = Ni(t) a Ny = Ny(t) oznacuji velikosti populaci kofisti,
N3 = Nj(t) oznacuje velikost populace predatora. U populaci kofisti nenastava mezidruhova
ani vnitrodruhova konkurence; takova situace mtize nastat v ptripadé, ze zdroje pro populace
koristi jsou prakticky neomezené.

P1i volbé parametrii

ap =3, ag=2,a3=1,013 = %, Pas = %, P31 = }l’ B3g = %,

66



wiEh | [ foals i pro prilas IEplat

pfour | disday || sep| el L i 1 5] ] | peo | afivptany | o ey ] d ) = B L5 )
R mben: .
al 1 1
TR T "-':l.' Nl L —- N ]
d . ’ koo 5
i i ar Myl ed =Nyl | 2 — 5] |
1 .
o Voirl =N 8] o N (] I T L WIEN
1 de ) "Rl
|
) ywivohenl gra ro jednotlhvé nisiy . 3 y 14
ki vy grafi pro jednotihe boduoty ¥, Vi, 3 ¥, |
Feer i fromm D 1 £ da
M, =g M, = — o N, = : e, 3y 4
I - ¥ i L]
iy | d+ 1 DhE o] | Porveiest, , romiid,, roveied | [N D0 (0D [ Falim) —_—

T N i . L 3 1 I}
oyl =l 11 “': U] =, \'.' Rt g L Ly oy | ety | | neapl a8 a | r=1 .3 i | afupsn | pe e 1 |,
st ® |8, N (1] |, Mnecoder = MWack, fabels 1% ™E" Y - i= | %], istguensd = b |

i+ 1 DEmar] | resminee, , Foveicd,, Fovied |, | Wl rfs Nk 1
W e P [ [0 = N, R0 = L W - N 1
| L v |
powrt = |8, N, (2] |, Pinecoder = bus, fabels . ] 2 i
grg] i 4 1| = DEplan] | ronmics,, Favii, revmie, ¥ PR N[ 1 ol
S T - UL I LU S L ST TR T By ;
111 | LR 3 | Ll
st & | 8, N (8] ], fnooder = prae, Gadle = [0, “REE]) 1
radd da |
T
T wkas. pro sl e enimaces r grafin |
Fist om0 1o = s ] 'I H
amimari [ phata | dspda | { el ¢ | T | 4], 2@ 6] 1) i i a "
Flad i ¥
ETH |

Obrdzek 3.57: Reseni modelu preddtora Ziviciho se dvéma nekonkurujicimi si populacemi pro
NI(O) =D NQ(O) =6— % p)NS(O) =6.
a pri pocatecnich hodnotach

Nl(O) =P, NQ(O) =6— - P, Ng(O) = 6,

[\CR V]

kde p je libovolné ¢islo z intervalu [0, 4], velikosti v8ech populaci ztstavaji konstantni, jak do-
kumentuje obrazek 3.57. Posledni z graft je tvofen animaci vykreslujici vSechna tii feseni
soucasné v zavislosti na pocatec¢nich hodnotach.

Pti stejnych parametrech, ale jinych kladnych poc¢ate¢nich hodnotach, vsechny populace
dlouhodobé prezivaji a jejich velikosti kolisaji. Tuto situaci znazoriiuje obrazek 3.58. Jsou
v ném zobrazena zvI4st jednotliva Feseni, posledni graf ukazuje vSechna t¥i FeSeni soucasné
pro poc¢atecéni velikosti populaci: N1(0) = 2, N2(0) = 2, N3(0) = 4.

Pokud nepatrné zménime jeden z parametri «q, (i3, jedna z populaci kofisti vymfe.
Pfi zvétseni a; nebo zmenseni 13 vymie druha populace; pii zmenseni a;; nebo zvétseni ;3
vymie prvni populace. Analogické tvrzeni plati pro zmény parametri as, (J23. Na obrazku
3.59 mizeme pozorovat jednotliva feSeni v piipadé zvétSseného parametru oy (a; = 3.1).
Pro pocateéni hodnoty N;(0) = 1, N2(0) = 2, N5(0) = 6 jsou zobrazena vSechna tii FeSeni
soucasne.

V tomto pripadé dlouhodobé koexistuji vSechna tii mozna ,,podspolecenstva“ dvou druhi,
spolecenstvo tvorené tfemi druhy pouze pii specidlni volbé parametrii. Komplexnéjsi spole-
¢enstvo tedy neni tak ekologicky stabilni jako spolecenstva méné komplexni.

Uvedené tfi modely spolecenstev naznacuji, ze vztah komplexity a stability spolecenstev
neni nijak jednoduchy. Nékdy jsou komplexnéjsi spolecenstva stabilnéjsi nez spolecenstva
méné komplexni, jindy naopak. Je tedy nutné upresnit nebo specifikovat ,konvenéni nazor*
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Obrdzek 3.58: Reseni modelu preddtora Ziviciho se dvéma nekonkurujicimi si populacemi — rizné

pocdtecni hodnoty.
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Obrdzek 3.59: Reseni modelu preddtora Ziviciho se dvéma nekonkurujicimi si populacemi — rizné
pocdtecni hodnoty, jedna z populaci vymird.

ekologie, ze vétsi slozitost spolecenstva vede k jeho vyssi stabilité, ktery vychazel z praci
MacArthura[22] a Eltona [5] a byl zastavany i v autoritativni Odumové ucebnici [25]; po-
drobné je tato problematika diskutovina v monografii [3, kapitola 23].
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4 Modely se zahrnutim neurcitosti

V predchozi kapitole jsme si ukazali nékolik prikladii matematickych modeli. Model je
pritom vzdy zjednodusSenim pozorovaného systému, a obsahuje tak prvky, kterym rikame
neurcitosti. V prvni kapitole jsme si neurcitosti ovliviiujici model rozdélili do tii kategorii.
Nyni se podivame blize na nékteré populacni modely predchozi kapitoly z pohledu datové
neurcitosti, respektive neurcitosti v parametrech modelu. Pro jednoduchost budeme vzdy
uvazovat pouze spojity pripad.

4.1 Analyza neurditosti

Nejpouzivan€jsimi pristupy k reprezentaci neurcitosti v hodnotach parametri modelu
jsou [11], [14], [32]:

1. Intervalova aritmetika — uziva se k popisu datové neurcitosti vznikajici bud nepfesnosti
méfeni, nebo existenci nékolika alternativnich metod (technik) k odhadu parametri.
Cilem intervalové analyzy je odhadnuti mezi vystupu modelu na zakladé mezi vstupi.
V tomto piistupu se o vstupech nepredpoklada zadna dalsi znalost, pouze ohraniceni
hodnot, jakych mohou nabyvat. Kazdy neurcity vstup je tak chapan jako interval,
typicky [z; — e, x; + €], kde z; je ,jakasi“ stfedni hodnota pfislusného parametru, ktery
miuze nabyvat libovolné hodnoty z uvedeného intervalu. Pritom neméame k dispozici
informaci o pravdépodobnostnim rozlozeni téchto hodnot.

Hlavni vyhodou intervalové analyzy je schopnost popisovat neurcitosti bez znalosti
pravdépodobnostni struktury vstupt. To je soucasné i nevyhodou, nebot charakteri-
zace neurcitosti na vystupu je opét pouze prostfednictvim intervalu. V ptipadech, kdy
zname pravdépodobnostni rozlozeni hodnot vstupt, neni tento typ analyzy doporuco-
van [11], [26].

2. Fuzzy teorie — metoda umoznujici provadét analyzu neurcitosti v pripadech, kdy jsou
neurcitosti zptisobeny vagnosti ¢i nejasnosti. Pouziva se pii zachazeni s parametry,
které jsou konstantni (nendhodné), neni mozné je méfit, ale jejich hodnota je znama.
Casto se pfitom jedna o nematematickou hodnotu (napi. ,asi dvé“, ,tmave zeleny®
atp.). Fuzzy teorie je vhodnéjsi ke kvalitativnimu posuzovani nez pro kvantitativni
odhad neuré¢itosti [11], [14].

3. Pravdépodobnostni analyza — nejrozsitenéjsi metoda popisu neurcitosti v modelech.
Jednotlivé parametry jsou chapany jako nahodné veli¢iny s prislusnym pravdépodob-
nostnim rozlozenim hodnot, kterjch mohou nabyvat. Cilem pravdépodobnostni ana-
Iyzy je urceni pravdépodobnostniho rozlozeni hodnot vystupu modelu. Pravdépodob-
nostni analyza ma dva hlavni kroky. Prvnim je urceni pravdépodobnostniho rozlozeni
hodnot vstupnich parametrii. To je zpravidla ziskavano z odborné literatury, rozhod-
nutim experta, ¢i z empirickych dat. Druhym krokem analyzy je stanoveni propagace
neurditosti (pravdépodobnostnich rozlozeni) modelem.
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4.2 Analyza citlivosti

S analyzou neurcitosti je izce spojena tzv. analyza citlivosti. Zatimco pii analyze neur-
Citosti charakterizujeme veskeré neurcitosti na vstupu a chceme ziskat celkovou neurcitost
na vystupu modelu, pfi analyze citlivosti zkoumame, jak konkrétné ovliviiuji vystup jednot-
livé parametry modelu. Metody analyzy citlivosti rozdélujeme na lokalni a globalni. Lokalni
metody urcuji, jak citlivy je vystup modelu na zmény vstupnich parametri v ,tésné bliz-
kosti“ néjaké jejich reprezentativni hodnoty (typicky stfedni hodnoty intervalu nejistoty).
V modelech, kde néktery z parametri nemé zadnou standardni hodnotu (a mize nabyvat
sirstho spektra hodnot), vyuZzivame globalnich metod analyzy citlivosti. Vysledky analyzy
napovi, které parametry je dulezité kontrolovat (a znéat tak co nejpresnéji jejich hodnoty)
6], [32].

V tomto textu se budeme zabyvat pouze analyzou lokalni citlivosti, ¢tenare se zadjmem
o informace k analyze globalni citlivosti odkdZeme napfiklad na [29].

Ptedpokladejme pro jednoduchost model popsany rovnici

dy(t, x
B2) _ flott.z), (4.)
kde y(t,x) je hledani funkce (feseni), t ¢as, © = (x1,22,...,2m)7 je m-rozmérny vektor

parametri modelu, f funkce v proménné y(¢,x). Efekt zmény parametri je mozné popsat
Taylorovym rozvojem

dy(t,
y(taz—i—Am)—ytm—l—E y z) j—f—g g Gxé?x Az - Axy -, (4.2)
J

=1 j=1

kde Ax = (Axy, Amg, ey Azy,)T. Parcidlni derivace 8y(t w) se nazyvaji lokdlni citlivosti prv-

y(7)

niho rddu, vyrazy Taios. S€ nazyvaji lokalni citlivosti druheho radu atd. Ne vzdy jsme schopni

urcit lokalni mthvostl analyticky. Pro jejich vypocet proto existuje nékolik numerickych me-
tod, z nichZz zminime metodu kone¢nych diferenci.

Metoda kone¢nych diferenci

Nejjednodussi zpiisob vypoctu lokalni citlivosti je zalozen na nahrazeni derivace jeji apro-
ximaci:

Ay(t,x) _ylt,x1,..., 75 + Ay, ..., x) — y(t, )
&ch - ij ’

j=1,...m. (4.3)

Tato procedura byva téz oznacovana jako metoda hrubé sily nebo neprimd metoda [28].

4.3 Neomezeny rust populace Zivych organismu

Prvni model, ktery jsme vytvorili, pfedstavoval neomezeny rust populace. Popisovala jej
rovnice (3.5)
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s pocatecni podminkou

Obecné feseni rovnice je tvaru:

N(t) = NO - ela=D1, (4.5)

Pro zobrazeni konkrétniho feseni jsme uvazovali populaci zajice polniho, o némz jsme z do-
stupnych zdrojt [23] zjistili idaje o porodnosti a véku doziti. Ziskané informace v sobé
pfitom zahrnovaly neuréitost (viz str. 25):

vek doziti: 10-12 let
porodnost:  3-4 krat ro¢né 1-7 mladat (tj. 3-28 mladat roéné)

Pro koeficienty porodnosti a timrtnosti v pfipadé ,mési¢niho kroku® ve skutec¢nosti plati:?®

a €[0.125,1.17), b€ [0.007,0.0083].

4.3.1 Analyza neurcitosti

Parametr NO jsme zvolili sami ,ndhodné“. Budeme tedy uvazovat, Ze jeho hodnota je
presna a do analyzy neurcitosti jej zahrnovat nebudeme. Vzhledem k povaze informaci o pa-
rametrech se jevi jako nejvhodnéjsi analyza intervalovou aritmetikou.

Intervalova aritmetika

Praci s intervalovou aritmetikou v systému Maple umozinuje balik Tolerances. S jeho
pomoci definujeme parametry a, b jako intervaly. Reseni N (t) pak bude ,intervalova“ funkce,
tj. funkce, jejiz funkéni hodnotu pro libovolné ¢ bude tvorit interval hodnot. Zapis intervalové
funkce N(t) v Maple muze byt nepfehledny a matouci. Pti praci s balikem Tolerances proto
musime byt obezfetni, viz obrazek 4.1.

Intervalovou funkci N (t) nemtizeme vykreslit jako ,klasickou“ funkci. Pfesto mame néko-
lik moznosti k jejimu zobrazeni. Jednak mtizeme funkci ,rozdélit na vice klasickych funkei
(napf. nejmensi, stfedni, nejvétsi, ...) a ty vykreslit do jednoho grafu, abychom znazornili
prubéh funkce pro néjaké vyznamné hodnoty parametrii z jejich intervald neurcitosti. Napfti-
klad obrazek 4.2 ilustruje funkci N (¢) pro nejnizsi a nejvyssi hodnotu rozdilu a—b (¢arkované
kiivky) a stfedni hodnotu rozdilu @ — b (plna kiivka).

Dalsi moznost je vykreslit funkci trojrozmérné jako funkci dvou proménnych. Prvni pro-
ménnou bude ¢as ¢, druhou proménnou bude parametr, jehoz vliv na feseni chceme pozorovat.
Na obrazku 4.3 je jako druhy parametr zvolen rozdil a — b, ktery oznac¢ime r, jak jsme zavedli
jiz diive.

28Na str. 22 jsme uvazovali koeficient porodnosti z intervalu [0,1.17] (sniZili jsme tedy dolni mez aZ na 0),
abychom mohli pti vykreslovani feseni pozorovat i situaci, kdy a < b. Tato situace pro ziskané idaje o zajici
polnim nenastane, ale z obecného pohledu, jak se feseni modelu mutze chovat, je podstatna.
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Obrdzek 4.1: Reseni neomezeného ristu populace s balikem Tolerances.
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Obrazek 4.2: Vykresleni jednotlivych reseni z intervalu neurcitosti.
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Obrazek 4.3: Vykresleni Tesent jako funkce dvou parametri.

Fuzzy teorie

Fuzzy mnoziny jsou rozsifenim klasickych mnozin. Fuzzy mnozina modeluje pfiblizné
neurc¢ité hodnoty, které mohou byt ¢isla i nominalni hodnoty (napf. ,skoro zeleny, mirné
do modra“). Zatimco u klasickych mnozin prvek do mnoZiny bud patfi, ¢i nikoliv, u fuzzy
mnozin mize prvek nalezet do mnoziny jen ¢astecné. Klasickou mnozinu jednoznacné urcuje
jeji charakteristickd funkce, kterda nabyva hodnot 0 nebo 1. Naproti tomu fuzzy mnozinu
popisuje tzv. funkce prislusnosti p nabyvajici libovolné hodnoty z uzavieného intervalu [0, 1].
Pro pocitani s fuzzy mnozinami pfedstavujicimi ¢iselné hodnoty existuje nékolik typt fuzzy
aritmetiky, napfiklad fuzzy obdoba intervalové aritmetiky, kdy se intervalova aritmetika
aplikuje na intervaly na hladinach = 0 a u = 1. Tento typ aritmetiky vyuzijeme i v nasem
ptipadé [12].

Ve chvili, kdy obdrzime o parametrech modelu néjakou dalsi informaci, naptiklad: pri-
mérné plozeni novych jedinci je nejbéznéjsi, zatimco mezni ptipady (3, resp. 28, mladat
rofné) se témér nevyskytuji, mizeme koeficient porodnosti chépat jako fuzzy mnozinu.
V tomto pripadé bychom mohli koeficientu porodnosti prifadit fuzzy mnozinu, jejiz funkce
prislusnosti ma trojuhelnikovy tvar s vrcholem v bodé priimérného plozeni. Podobnou tva-
hou (napi. ze vék doziti je nej¢ast&ji 10-11 let, 12 let pouze vyjime¢né) bychom piifadili
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koeficientu timrtnosti fuzzy mnozinu, jejiz funkce ptislusnosti ma tvar pravouhlého lichobéz-
niku (v némz neni pfitomna svisla usecka, aby se jednalo o zobrazeni).

Zminéné uvahy nyni provedeme. Praci s fuzzy mnozinami v systému Maple umoznuje
toolbox FuzzySets. V nasem pfipadé vystac¢ime bez néj, pricemz funkce pfislusnosti bu-
deme definovat po ¢astech pomoci ptrikazu piecewise. Na obrazku 4.4 tak definujeme funkce
prislusnosti pro fuzzy mnoziny koeficientu porodnosti a a koeficientu timrtnosti b. Jelikoz se
ve skutecnosti jednd o fuzzy ¢isla, kterda potfebujeme odecist (uréit rozdil a — b), musime
vytvorit funkci prislusnosti r pro fuzzy mnozinu rozdilu a — b. Na tomto misté vyuzijeme
intervalovou aritmetiku k urceni bodt na hladinach 4 = 0 a 4 = 1, v nichz dochézi ke zméné
smérnice funkce p. Na hladiné p = 0 tak ziskame dva body reprezentujici nejnizsi a nejvyssi
moznou hodnotu rozdilu a — b:

0.125 —0.0083 = 0.1167, 1.17—0.007 = 1.163,
na hladiné ;4 = 1 analogicky body
0.6475 — 0.0083 = 0.6392, 0.6475 — 0.0076 = 0.6399.
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Obrazek 4.4: Definice koeficienti porodnosti a umrtnosti jako fuzzy mnoZin.

Diky analytickému ptedpisu (4.5), feSeni modelu, mizeme vytvorit také funkci prislus-
nosti pro fuzzy mnozinu funkce N(t). Tato funkce prislusnosti je ¢asové zavisla, pficemz
mé stale stejny lichobéznikovy tvar (pro rizna t) a body, v nichz se méni smérnice funkce
prislusnosti, vychazi z bodu pravé urcenych pro fuzzy mnozinu r. Ziskame tak body

NOQ - (0-125-0.0083)-t  pr(y . ,(0.6475-0.0083)t  £r() . ,(0.6475-0.0076)-  £r() . o(1.17-0.007)-

Na obrazku 4.5 je definovana fuzzy mnozina N(t) jako funkce dvou proménnych. Pro ¢a-
sové body t = 1 a t = 5 je nasledné vykreslena. Velmi kratky interval na hladiné py = 1
zpusobuje, ze funkce piislusnosti ma na pohled spise trojahelnikovy tvar.
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Ziskana fuzzy mmnozina pro N(t) ndm k4, jak miize feSeni ve zvoleném case vypadat,
tedy kolik jedinct populace v tomto ¢ase mtize mit. Oproti intervalové aritmetice je kazdy
udaj podporen hodnotou prislusnosti, tedy mirou moznosti.

Vyiverms ey mnoziny reiena modedu:
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Obrdzek 4.5: Resent jako fuzzy mnoZina.

Pravdépodobnostni analyza

Pti pravdépodobnostni analyze chiapeme jednotlivé parametry modelu jako nahodné veli-
¢iny, kterym pfiradime pravdépodobnostni rozlozeni hodnot, jichz mohou nabyvat. V nasem
pripadé budeme postupovat podobné jako v pripadé uziti fuzzy mnozin. Za nahodné veli¢iny
budeme povazovat koeficienty porodnosti a imrtnosti. Budeme pritom opét vychazet z udaji
o zajici polnim, které jsme ziskali z literatury. Koeficientu porodnosti pfitadime trojihelni-
kové rozlozeni hodnot na intervalu [0.125,1.17] s maximem v bodé 0.6475, ktery odpovida
praumérnému plozeni. Pro koeficient imrtnosti neméame v systému Maple k dispozici lichobéz-
nikové rozlozeni. Mame dvé moznosti, jak to vytesit. Bud rozlozeni vytvorime, pficemz jeho
parametry ur¢ime z toho, Ze integral z hustoty rozloZeni (tj. obsah plochy mezi funkei prav-
dépodobnostniho rozlozeni a osou z) je roven 1. Nebo pouzijeme néjaké existujici rozlozeni
nejvic ,,podobné“ tomu, které chceme. V nasem piipadé bychom pro koeficient iimrtnosti
zvolili napfiklad trojihelnikové rozlozeni hodnot na intervalu [0.007,0.0083] s maximem v
bodé 0.0076, ktery odpovida primérné timrtnosti.

Druhym krokem pravdépodobnostni analyzy je stanoveni sifeni neurcitosti. To provadime
generovanim ,dostatecného“ mnozstvi n hodnot ndhodnych veli¢in a naslednym vyhodno-
covanim modelu. Ziskame tak pravdépodobnostni rozlozeni hodnot feseni modelu. ,,Dosta-
tecné“ n se pohybuje v fadech tisicti az milionti, jeho hodnota zavisi na vice faktorech. Pii
provadéni pravdépodobnostni analyzy se zpravidla postupuje tak, ze se zvoli n na zakladé
zkuSenosti a moznosti (pfipadné potfeb) a vygeneruji se dvé skupiny po n vygenerovanych
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Rovnice modelu a jeji Feseni: %N(f) =(a — b)-N(2), N(D) =NOM>N(IJ =ppele b

Nacteni baliku Statistics: with(Statistics)

Vytvoremi nahodnych velicin pro koeficient porodnosti a amrtnosti:
A = Random Variable (Triangular(0.125 117, 0.6475)) B = Random Variable (Triangular(0.007, 0.0083, 0.0076)) -

Vygenerovani hodnot, nastaveni pocatecmi velikosti populace:
koef o = Samp!e(ﬂ, 105] : kagf b = Samp!e(B, 105] : AN = 100 :

Vypocet reseni N(t) a jeho vykreslemi prot =1 a ¢=3:

reseni [ = Vecior[lﬂs] : reseni_ N = Vecfor(lﬂs] :

for i from 1 to 10° do for i from 1 to 10° do

resesi_J[i] = NO- o boaf ali] — kogf Bl ]} reseni_5[i] = Bl Foaf ali] = kogf bli]) -5

end do: end do:

Histogram (reseni_I, averageshifled = 4) Histogram (resemi_5, averageshifled =4)
0,010

0,00020 -

0,00% -
0,006 0,00015
0,004 - 0,00010

0,002 0,00005 -

000 10000 15000 20000 25000 30000

120 140 160 120 200 220 240 260 220 300

Obrazek 4.6: Pravdépodobnostni analyza neurcitosti.

hodnotéch. Pokud se shoduji zakladni statistické parametry (stfedni hodnota, rozptyl) obou
skupin, je n povazovano za dostatecné. Pokud se statistické parametry lisi, je nutné zvysit
pocet generovanych hodnot.

Obrézek 4.6 ilustruje provedeni pravdépodobnostni analyzy v Maple. Nejprve vytvotime
nahodné veli¢iny koeficientii porodnosti a timrtnosti (které oznac¢ime velkymi pismeny). Pro
oba koeficienty pouzijeme jiz implementované trojihelnikové rozlozeni pravdépodobnosti.
Piikazem Sample vygenerujeme 10° hodnot kazdé z ndhodnych veli¢in a 105krat pro né
vyhodnotime feseni modelu v pripadé ¢t = 1 a v pripadé ¢ = 5. Piikazem Histogram zobra-
zime histogram ziskanych Feseni (parametrem averageshifted zvysime pocet vykreslenych
sloupctt). Z vysledki mizeme pozorovat, jak se v ¢ase méni pravdépodobnostni rozlozeni
hodnot feseni. V case t = 1 miizeme jesté mluvit o priblizné trojuihelnikovém, v ¢ase t = 5
se histogram podoba spise log-normalnimu rozlozeni hodnot.

4.3.2 Analyza citlivosti

Predchéazejici analyzou neurcitosti jsme kvantifikovali celkovou neurcitost v feseni mo-
delu. Nyni zjistime, jak je feseni citlivé na hodnoty jednotlivych parametri. Jelikoz mame
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analyticky predpis feseni (4.5)

N(t) = NO - ela=0,

mutzeme urcit lokalni citlivosti parametri p¥imo z definice (4.2). Nés zajima predevsim veli-
kost citlivosti, takze budeme lokalni citlivosti chapat jako absolutni hodnoty z definovanych
vyrazil. Oznacme citlivosti pismenem s, index necht znac¢i parametr, jehoZ citlivost uvazu-
jeme. Potom:

a—b)-t
. — ON(t,a,b,NO)| _|INO-e" _NO ¢ el
da da
a—b)-t
. (9N(t,g})b, NO)| _|9NO 52( | NO - ¢ elad,
oo ON(t,a,b,NO)| _ INQ - ela=b)t _ bt
ONO ONO

Lokalni citlivosti jsou casové zavislé. Citlivosti koeficienttt imrtnosti a porodnosti jsou

stejné, citlivost pocatecni velikosti populace je pro ¢ > NLO nizsi nez citlivosti zbylych para-

metri. Chovani modelu tedy ovliviuji nejvice koeficient porodnosti a koeficient imrtnosti.

4.4 Omezeny rist populace

U nésledujicich modelti provedeme pouze analyzu citlivosti, nebof k analyze neurcitosti
jiz nemame dostatecné tdaje. Uvazujme nyni modifikovanou variantu piedchoziho modelu,
kterou jsme odvodili v sekci 3.1.4.

4.4.1 Analyza citlivosti

V pripadé omezeného ristu populace jsme dospéli k feseni

B NO - (a—10)
"~ NO-c— (NO-c—a+b)-elab)t’

N()

Pomoci systému Maple miizeme jednoduse ziskat citlivosti jako parcialni derivace funkce
N(t,a,b,c, NO) zavislé na parametrech, vysledné vyrazy vSak budou stézi interpretovatelné,
jak muzeme vidét na obrazku 4.7. Vyhodnotme proto citlivosti pro ,,primérné“ nastaveni
parametri, které jsme pouzili jiz diive: a = %,b = ﬁ,c = ﬁ,NO = 100, a pro t = 10
(obrazek 4.8). Vidime, Ze v tomto pfipadé je nejcitlivéjsi parametr ¢, tedy linedrni ¢len
koeficientu tmrtnosti. Pocatecni velikost populace je opét nejméné citlivy parametr, coz
odpovida chovani modelu (nebot feseni se ustali na stejné hodnoté pro libovolnou pocateéni

velikost populace).
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Vypocet parcialni derivace:
MO (2 — B)
Ba NOe—(N0e—a+ &) gl it
NO MO =B) (e TPy (os—a+ b)eeT TR
NOc— (Woc—a+b)e @781 (Woe— (W0 —a+ b) e~ @b 1)?

Uprava ziskaného vysledku:
simplifi( %5)
- ! 5 (w0 (-Noe +e710
[—NOC + e":a_b]iNOc — e":a_b]ia —+ e_':a_b]!b]
—ptle Bt 2y gt @ By @B e e_':a_bltsz]]

“Hiype 4 et @M g e

Dalsi zjednodusujici uprava ziskaného vyrazu:
coﬂecf[%, gl@ =kl f]
N0 ((W0e+atNDe—ta* +3ath—biNoe —ib%) e '#78 _nog)

- 2
[(NOC —a+ &) e_'-a_b]f—NOc]

Obrdzek 4.7: Vypocet obecného predpisu pro citlivost koeficientu porodnosti v pripadé omezeného
rustu populace.
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Obrazek 4.8: Vypocet citlivosti jednotlivych parametri v pripadé omezeného ristu populace.
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4.5 Populace pod tlakem nespecializovaného predatora

4.5.1 Analyza citlivosti

Posledni model, u néjz provedeme analyzu citlivosti, je model riistu populace pod tlakem
nespecializovaného predatora, viz sekce 3.2. Pfi analjze neomezeného ristu populace jsme
vystacili s obecnym analytickym predpisem citlivosti, u omezeného ristu populace jsme
pro vyvozeni zavéri museli urc¢it citlivosti pro konkrétni numerické nastaveni parametri,
stale jsme vsSak citlivosti pocitali jako parcidlni derivace funkce feseni modelu.

V tomto pripadé jiz nemame analyticky predpis feseni modelu, musime proto pocitat
citlivosti numericky (pfiblizné), coz provedeme metodou konecnych diferenci. Podle (4.3)
tak pro citlivost parametru x; ziskdme nésledujici predpis:

oy(t,x)  y(t, o1, ...,xi1, 2 + Az, Tivay ooy T) — y(t, @)
Sy = ~ .
: ox; Az,

Jak velkou diferenci k vypoctu pouzit zavisi na modelu a jeho parametrech. Obvykle se
voli diference 1 % nebo 10 % z hodnoty prislusného parametru. Abychom zamezili vlivu ve-
likosti absolutni hodnoty uvazovaného parametru®, vynisobime ptredpis (4.6) jeho velikosti
(tj. x;). Zcela analogicky (abychom zamezili vlivu velikosti absolutni hodnoty feseni) naopak
ptedpis (4.6) podélime touto hodnotou (tj. y(¢, x)). Celkové tak pocitame tzv. normalizova-
nou citlivost modelu y(t, ) na parametr z; danou pfedpisem:

(4.6)

Ay(t,z) _ylt,xr, . Tim, T + Az, gy, oy ) —y(t, ) 2y
Sy, = ~ . .
! @J]Z sz y(t,:z:)

(4.7)

Mize se stat, Ze pfi¢teni urcité diference k hodnoté parametru zpusobi jinou (velikostni)
zménu Feseni modelu nez odecteni stejné diference od hodnoty parametru. Zpravidla se proto
uréi zmeéna zpusobena pfictenim diference (y(t,z1,...,xi—1,T; + Az, Titq, ..o, ) — Y(t, x))
i jejim odec¢tenim (y(t, z1, ..., i 1,2; — Az, Tiv1, ..., Tm) — Y(t, x)) a do vztahu pro citlivost
se vezme prumeér téchto hodnot. Stejné jako diive nas bude zajimat velikost citlivosti, takze
budeme navic uvazovat absolutni hodnoty ze zminénych vyrazt. Ziskdme tedy:3°

.~ E(lyt,z1, i, @ £ Axy i, o wn) —yt@)|)

(4.8)

Metodu koneénych diferenci provedeme pro obé zminéné diference (1 % a 10 %), pii-
slusné citlivosti rozlisime dals$im indexem. V pfipadé Az; = 0.01 - x; budeme index citlivosti
definovat predpisem

E(ly(t, x1, oo zic1, v £ A2, Ty, oo, T) — y(E, x)])
y(t, x)

100, (4.9)

Sz 1% —

nebot Ax—xl = 100. Analogicky pro Az; = 0.1 - x; budeme index citlivosti definovat predpisem

Ely(t, @1, oy i1, @i = Do, Tiga, -, T) — y(t, @)])
y(t. z)

- 10. (4.10)

Sz;,10% —

2tento vliv je zpiisobeny vyrazem Ax; ve jmenovateli piedpisu (4.6)
30 B(y) znadi stiedni hodnotu (v tomto piipadé priimér) z moznych hodnot ¥,
tj. napt. E(f(z; £ Az;)) = 1 - (f(@; + Az;) + f(zi — Awy))
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Model riistu populace pod tlakem nespecializovaného predatora je popsan rovnici

N'(t) = r-N(t)- (1_$> ) N

Nyni vypocitame lokalni citlivosti parametri v ptripadé, ze

S

, .

1
S<Z'T'K7 Nkritg

K tomu vyuzijeme stejné nastaveni parametri, jaké jsme zvolili pri analyze feseni na obrazku
3.24:

S =200, r=1, K =1000, Ny = 150

Pocatecni hodnoty zvolime tii rizné:

B 4.8
r-K

K
NOy = 100, N0, = - - <1 —4/1 ) = 276, NOs; = 700.

Citlivosti pritom budeme pocitat pro ¢as t = 15, v némz ma sledovana populace priblizné
ustalenou velikost. Z prostorovych divodi ukazujeme pouze vypocet citlivosti parametru
r (vnitiniho koeficientu ristu populace) pro N(0) = NO; = 100 (obrazek 4.9). P¥i vypoc-
tech citlivosti parametri r, S a K musime mit na paméti, ze hodnota N0y je pomoci nich
definovana, tj. pti zméné kteréhokoli ze zminénych parametri musime urcit téz odpovidajici
hodnotu NOs.

Pro vypocet feseni modelu pouzijeme ptikaz dsolve s parametrem numeric pro nume-
rické FeSeni. Vysledek pro ¢as t zadany do kulatych zavorek ziskame ve tvaru [t = ..., N(t) =
...], v némz jsou misto te¢ek numerické hodnoty. Jestlize z néj chceme ziskat pouze numeric-
kou hodnotu funkce N(t), musime do hranatjch zavorek za ptikaz specifikovat, ze chceme
druhy udaj. Piikazem rhs z néj pak vezmeme pravou stranu, tj. pozadovanou numerickou
hodnotu.

Seznam vypoctenych hodnot citlivosti pro jednotlivé parametry za riznych pocatec¢nich
podminek nabizi tabulka 4.1. Ve druhém sloupci tabulky najdeme hodnoty s, 194, ve tfetim
5z,.10%- Vidime, Ze nejcitlivéjsi je pocatecni podminka pro N0,. Pocatecni velikost populace
N0, je specificka a velmi citliva. Pro N(0) = N0, totiz velikost populace zstava konstantni,
ale pro sebemensi zménu N (0) populace bud vymfe, nebo se jeji velikost ustéli na jiné (vyssi)
hodnoté.

Z hodnot lokalnich citlivosti zjistime, které parametry jsou nejcitlivéjsi, a jejichz hodnoty
tak potifebujeme znat co nejpresnéji. Soucasné vsak musime mit na paméti zavislost lokalni
citlivosti na daném nastaveni (vSech) parametri, kterou mizeme pozorovat i v tabulce 4.1.
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Obrdzek 4.9: Vipocet citlivosti parametru r, vnitiniho koeficientu ristu, v modelu ristu populace
pod tlakem nespecializovaného predatora pro N(0) = NO;.

Tabulka 4.1: Lokalni citlivosti parametrid modelu ristu populace
pod tlakem nespecializovaného preddtora.

Parametr, poc¢ateéni podminka A=1% | A=10%
Vnitni koeficient ristu (r), N(0) = NO; | 14.15 18.76
Vnitini koeficient ristu (r), N(0) = N0 1.62 1.71
Vnitini koeficient ristu (r), N(0) = NO3 0.62 0.65
Hladina nasyceni (S), N(0) = N0 19.22 31.79
Hladina nasyceni (S), N(0) = N0, 1.62 1.65
Hladina nasyceni (5), N(0) = NOs 0.62 0.63
Uzivnost prostiedi (K), N(0) = NO; 0.23 0.23
Uzivnost prostiedi (K), N(0) = N0y 0.23 0.23
Uzivnost prostiedi (K), N(0) = N03 1.62 1.64
Kriticka velikost (N ), N(0) = NO; 1919 | 26.96
Kritickd velikost (Niyit), N(0) = NO2 0.00 0.00
Kriticka velikost (Nt ), N(0) = NO; 0.00 0.00
Pocateeni velikost (N(0)), N(0) = NO; 0.77 0.77
Pocatecni velikost (N(0)), N(0) = N0, 115.75 12.91
Pocateeni velikost (V(0)), N(0) = NO; 0.00 0.00
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5 Maple

5.1 Uvod

Systém Maple je vykonny program vhodny k feseni komplexnich matematickych pro-
blémii. Patti do skupiny systémil pocitacové algebry, umoziuje symbolické i numerické vy-
pocty a slouzi predevsim k vytvotreni specidlnich dokumentt, prezentaci, interaktivnich vy-
pocetnich modult v prostredi Maple. Systém Maple téz obsahuje komponenty podporujici
vyuku matematiky.

Vyrobcem systému je kanadska spolecnost Maplesoft Inc., jejiz webové stranky3! posky-
tuji Siroké informace o systému a jeho dalSich pfibuznych programech jako je MapleSim,
MapleNet, Maple T.A. a mnoho dalSich nastroji a programt. Webové stranky mimo jiné
obsahuji tzv. Aplikacni centrum (Application Center), z néjz si muze kazdy zaregistrovany
uzivatel stahnout ukazkové programy demonstrujici pouziti systému Maple pfi feSeni mnoha
ruznych matematickych i technickych problému. Poskytuji i tzv. Studentské centrum (Stu-
dent Center), kde si zaregistrovany student muze stdhnout mnoho studijnich materiala.
Dalgimi vyznamnymi zdroji informaci o Maple jsou diskuzni férum uZivatelt Maple®? a web
distributora Maple pro Ceskou a Slovenskou republiku®?, kde je vétsina dokumentt v éeském
jazyce.

V nasledujicim textu se budeme zabyvat dosud posledni verzi Maple 14. Se systémem je
mozné pracovat nékolika rtiznymi zptsoby, které volime pii spusténi programu ze startova-
ciho menu pocitace nebo kliknutim na pfislusnou ikonu na plose.

5.1.1 Standardni zapisnik (Standard Worksheet)

Grafické uzivatelské rozhrani Maple zvané Standard Worksheet se spusti ze startovaciho
menu pocitace vybérem polozky Programy > Maple 14 > Maple 14 nebo kliknutim
na ikonu Maple 14 na plose. Toto prostiedi poskytuje veskeré moznosti systému Maple
a pomdahé vytvéaret elektronické dokumenty (zapisniky) zobrazujici matematické vypocty,
matematické texty a komentare spolu s propracovanou pocitacovou grafikou. Nékteré vypo-
dokument poskytoval uzivateli potfebné informace. Jelikoz vytvorené dokumenty jsou inter-
aktivni, tj. v jistém smyslu ,,zivé“, muze si uzivatel sdm upravovat preddefinované hodnoty
parametri, vyhodnocovat prikazy, a ziskavat tak nové vysledky.

Menu zapisniku Maple ma tfi vodorovné listy: hlavni menu (zcela nahote), ndstrojovou
listu (pod hlavnim menu) a kontextovou listu (pod néstrojovou listou), déle palety (svisly
blok na levé stran&®') a vlastni pracovni pole — dokument, do néj7 zadavame piikazy, texty,

3http: //www.maplesoft.com

32http: //www.mapleprimes.com

33http://www.maplesoft.cz

34Palety se automaticky zobrazuji v levém bloku. Prostiedi systému nabizi blok pro palety i po pravé
strané obrazovky (automaticky zavieny), kam je mozné nékteré (ale i v8echny) pfesunout.
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provadimme vypoctové a grafické akce. Vlastni pracovni pole je mozné zobrazit pies celou
obrazovku skrytim palet, nastrojové listy a kontextové listy (kliknutim na pfislusné polozky
v zalozce View hlavniho menu).

L e (1]

Ukska prostfedi Standard Worksheet systéma Maple 14
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Obrdzek 5.1: Maple 14: Prostredi Standard Worksheet
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Obrdzek 5.2: Maple 14: Prostredi Classic Worksheet

83



5.1.2 Klasicky zapisnik (Classic Worksheet)

Classic Worksheet se spusti ze startovaciho menu pocitace vybérem polozky Programy
> Maple 14 > Classic Worksheet Maple 14 nebo kliknutim na ikonu Classic Worksheet
na plose. Tento zapisnik Maple je urcen predevsim pro méné vykonné pocitace s omezenou
paméti. Neposkytuje také vSechny funkce, pfikazy a moznosti systému Maple jako Standard
Worksheet. Pted verzi Maple 10 byl tento typ zapisniku jediny mozny.

5.1.3 Prikazovy radek a kalkulacka Maple

Se systémem Maple mtizeme pracovat i pouze v rezimu tzv. prikazoveho radku, ktery se
spousti ze startovaciho menu pocitace vybérem polozky Programy > Maple 14 > Com-
mand-line Maple 14 a je urcen k fesSeni rozsahlych a slozitych tloh. K dispozici nejsou
zadné grafické prvky.

Déle je mozné pouzivat (a vytvaret) tzv. maplety, tj. grafickd uzivatelskd rozhrani ob-
sahujici okénka, textova pole a dalsi vizualni prvky umoznujici pouhym klikdnim spoustét
vypocty. Kalkulacka systému Maple je specialni typ mapletu, ktery je k dispozici pouze
pro opera¢ni systémy Windows. Spousti se ze startovactho menu pocitace, kde se vybere
Programy > Maple 14 > Maple Calculator.

5.1.4 Document Mode, Worksheet Mode

Ve zbyvajici ¢asti kapitoly budeme uvazovat rozsitené prostiedi Standard Worksheet.
V tomto prostifedi je mozné pracovat ve dvou zakladnich rezimech: Worksheet Mode a Do-
cument Mode. Prvné jmenovany odpovida prostiedi Classic Worksheet, v némz je kazdy
ptikaz Maple uvozen symbolem [> a musi byt ukon¢en dvojteckou (vysledek se nezobrazi)
nebo stfednikem (vysledek se zobrazi na dalsim fadku uprostied). Otevira se v zédkladnim
menu jako New, kde se vybere Worksheet mode. Druhy jmenovany rezim poskytuje pte-
hlednéjsi zapis prikazti a matematickych vzorci bez ,prebytecnych® symboli. Pii otevieni
nového souboru v zakladnim menu New je automaticky spustén praveé tento rezim Document
mode.

ZapiE v redmu Documen Made Zams v redmi Workshee! Mode

Tente texi je v redum Tecr Made ~
Stiskem Klivesy Enter jinse sc dosiab na dalis fhdeke Tenlo best e tek v refuni Tecd Mode
Ma nddodigichm fdku ic plepneme 4o sehrnis Math Mode

¥ redvern Alark Mol

136128 . plikiag
H2000 phibar

rotvelx” = Tx + 11=10) - 25124
i1 000

= ISEe125;
FZ000

Obrdzek 5.3: Rezimy zdpisu.

K piikaztim mame moznost zapisovat komentéafe, a to uvedenim symbolu miizky (#)
pred text, ktery ma byt komentafem (viz obrazek 5.4).
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256-125 # néfaky komentdf
32000

> 256*%*125; # néjaky komentir
32000
[>

Obrdzek 5.4: Zapis komentare v prikazovém rezimu

Obvykle je zapisnik nastaven do jednoho rezimu, ktery je mozné zvolit pii otevirani no-
vého souboru v hlavnim menu (File > New > Worksheet mode nebo File > New >
Document Mode). Existuje v8ak i moZnost pfepinat mezi rezimy v ramci jednoho zépis-
niku, kdy je ¢ast vytvorena v jednom rezimu, ¢ast v jiném. Z Document Mode se prepneme
do Worksheet Mode kliknutim na ikonku [> v nastrojové listé (pod hlavnim menu). Naopak
z Worksheet Mode se do rezimu Document Mode prepneme vybérem polozky v hlavnim
menu (Format > Create Document block).

5.1.5 Math Mode, Text Mode

Pro rozliseni ptikazli a obyc¢ejného textu v rezimu Document Mode slouzi kontextova lista
zapisniku, kde mame na vybér Text Mode a Math Mode. Math Mode odpovida piikaziim (po
stisku klavesy Enter dojde k jeho vyhodnoceni), v Text Mode piSeme texty dokumentu po-
dobné jako napf. v textovém editoru Word (po stisku kldvesy Enter prejdeme na novy fadek
bez jakéhokoli vyhodnoceni). Volit rezim zépisu mizeme bud kliknutim mysi (v kontextové
listé nad dokumentem jsou uvedeny nazvy predstavujici jednotlivé moznosti) nebo vybérem
polozky v hlavnim menu (Edit > Switch to Text/Math Mode). Totéz lze rychleji provést
jedinou klavesou F'5.

V rezimu Worksheet Mode 1ze pro text i pro prikazy pouzit oba druhy zapisu. Pro psani
textu je nutné kliknout na ikonku T v nastrojové listé nebo zvolit polozku v hlavnim menu
(Insert > Text). Podobné pro zéapis piikazu jazyka Maple je nutné kliknout na ikonku [>
v néstrojové listé nebo zvolit polozku v hlavnim menu (Insert > Maple Input). Pti otevieni
nového souboru je zapisnik automaticky nastaven na psani ptikazi.

5.2 Zakladni ovladani systému

V této casti si ukazeme, jak systému Maple zadavat jednoduché piikazy. Budeme proto
predpokladat, Ze zapisnik je jiz nastaven pro psani piikazt (Math Mode).

Zakladni operace: pro s¢itani pouzivame symbol plus (+), pro od¢itani minus (—), pro né-
sobeni (*), ale pozor, pro déleni musime pouzivat pouze lomitko (/), dvojtecka (:) m4 jiny

vyznam (viz dale).

Zadani zlomku: zadame ¢itatel, lomitko (/) a jmenovatel. Pro opusténi zapisu jmenovatele
sta¢i stisknout Sipku doprava (ve zlomku je téZ mozno pohybovat se Sipkami).

Zadani mocniny: zadame zaklad, symbol st¥iska (") a exponent. Pro opusténi zapisu ex-
ponentu je opét mozné pouzit Sipku doprava.
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5.2.1 Vyhodnoceni prikazu

Prikaz vyhodnotime stiskem klavesy Enter. Vysledek se zobrazi na dalsim radku upro-
stfed. V diivéjsich verzich (méné nez 10) systému Maple bylo nutné piikaz ukoncovat stied-
nikem, aby se provedl. Tato moznost nadéle zistala (tj. zadame-li za piikaz stfednik, ,nic
nepokazime®) a v nékterych situacich je dokonce jedind mozna — napi. textovy rezim (Text
Mode) ptikazi v Worksheet Mode nebo pii psani piikazi v prostiedi Classic Worksheet.
Z predeslych verzi Maple se uchovala i funkcionalita symbolu dvojtecka (:), kterd po za-
fazeni za prikaz a nasledného stisku klavesy Enter potlac¢i zobrazeni vysledku na dalsim
fadku (tj. pfikaz se provede, ale na obrazovku se nic nevypise). Proto neni mozné dvojtecku
pouzivat jako operator déleni. V- Document Mode je navic mozné zapisovat ptrikaz i s vysled-
kem na jeden tfadek. Po napsani prikazu k tomu staci namisto stisku klavesy Enter pouzit

klavesovou zkratku ,,Ctrl + =“.

Jak bylo zminéno dfive, interaktivni dokumenty v Maple jsou
,zivé“. Tim mame na mysli skutecnost, ze i v jiz dfive vytvoreném
programu s vyhodnocenymi piikazy otevieném po libovolné dlouhé
dobé muzeme kterykoli vyraz upravit, znovu vyhodnotit (stisknout
Enter nebo ,Ctrl + =“) a dostaneme novy (spravny) vysledek.
Oznacime-li mysi nékolik (libovolné mnoho) piikazi a stiskneme
ikonku ! (vykfi¢nik) z néstrojové listy, vSechny oznacdené piikazy
budou postupné vyhodnoceny. K vyhodnoceni vSech prikazi v do-
kumentu slouzi ikonka !!! (tfi vykii¢niky).

Maple obsahuje vice nez tisic symbolli, pomoci nichz miizeme
tvorit matematické vyrazy. Patfi mezi né pismena a ¢islice, jimiz vy-
tvafime jména (posloupnost znakt za¢inajici pismenem, za kterym
miize nasledovat kombinace pismen, ¢isel a vybranych symboli), re-
alna cisla (celd, raciondlni, s desetinou teckou nebo v notaci pohyb-
livé fadové ¢arky), komplexni ¢isla (sestavajici z redlné a imaginarni
¢asti), aritmetické, booleovské a jiné operatory (+, — !, /, *,[ , lim,

. ), konstanty (7, e, ...), imaginarni jednotka, nekone¢no, ma-
tematické funkce (cos(z), sin(3), ... ) a proménné (pojmenované
jménem ...). Velkou pfednosti systému Maple je jeho schopnost
symbolickych matematickych vypocti (tj. prace s vyrazy). Nékteré
z matematickych symboli, které mizeme pouzit, nejsou na klaves-
nici, a tak se zadavaji bud z palety nebo pomoci svych nazvi.

5.2.2 Palety

Palety jsou pojmenované ,,obdélnicky“ s nabidkou preddefinovanych
symbolti, zapist, vyrazi apod. (obrazek 5.5), zpravidla pfi levém
okraji zapisniku. Kazda paleta obsahuje symboly prislusné skupiny.
Napriklad paleta s nazvem Ezpression nabizi nékteré zakladni ma-
tematické vyrazy, paleta Greek pismena fecké abecedy atd. Stan-
dardné zistéava nékolik palet nezobrazenych. V hlavnim menu (View
> Palettes) mizeme seznam zobrazenych palet upravit tim, Ze né-
které pridame, odebereme, ale tfeba i jinak sefadime. Totéz lze pro-
vést jen za pomoci mysi. Piidrzenim levého tlacitka vybranou paletu
presuneme na jiné misto, stisknutim pravého tlacitka vyvolame stej-

o Fareories ;i.;

:'1-1"_'_' A NS

fnar | oesalar ) landa )

ek,
_h-{wmirrhds

e iniks (5]
I ik (FP5)
s

I Comporents

| B S

'I

Obrazek 5.5: Palety

nou nabidku, jako bychom postupovali pfes hlavni menu. Kliknuti levého tlacitka mysi na
nékterou z palet zobrazi (pfip. skryje) symboly, které paleta nabizi. Vlozit z palety symbol
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do zapisniku pak staci pouhym kliknutim, pripadné ,pretahnutim“ s pomoci levého tlacitka
mysi. Obecné barevné zvyraznéné symboly ve vyrazu je mozné déle specifikovat (upravovat)
dosazenim hodnoty, s niz potfebujeme pracovat.
10
Nyni ukdzeme, jak vlozit napiiklad vyraz > 2°. Pro jeho zapsani potiebujeme celkem
dva rtzné symboly: sumu a mocninu. Sumaéililsymbol nalezneme v paleté Expression.
Kliknutim na tuto paletu ji otevieme (na obrazku 5.5 je jako jedind oteviend) a vybereme
z ni pritomny sumacni symbol. Po jeho vloZeni do zapisniku pak jednoduse prepiseme obecné
symboly (k, n a f) pozadovanymi hodnotami. Pohybovat ve vzorci se mizeme pomoci Sipek
na klavesnici, s vyhodou lze vyuzit klavesy Tab, pritom k upravé vyrazu mizeme pouzivat
i v8echny ostatni klavesy jako napf. Delete, Backspace, mezernik, ... Znak f prepiSeme
mocninnym vyrazem. To miZeme provést bud vlozenim dalsiho symbolu z palety Expres-
sion (symbol a’) a naslednou tipravou (specifikaci hodnot a, b), nebo uZitim jiz zndmé klavesy
pro tvorbu mocnin — st¥isky (7).

5.2.3 Nazvy symbolu

Mimo palet miizeme k zapisu symboli uzivat jejich nazvi. Napiiklad symbol 7 vlozime
zapsanim jeho nizvu Pi®*®, pro odmocninu je vyhrazen nazev sqrt, takZe \/z vlozime na-
psanim sqrt (x). Pfi vkladani symboli pomoci nazvl nebo pii tvorbé prikazi mize prijit
vhod funkce ,dokoncovani“. Ta se vyvola stisknutim klavesy Esc, nebo klaves ,,Ctrl +
mezernik“. Pro zadani symbolu pak staci napsat jeho ivodni pismeno (pismena) a pomoci
klavesové zkratky néasledné z vyskakovaciho okénka zvolit pozadovanou hodnotu. Na obrazku
5.6 je ukazka nabidky pro dokonceni zapisu pismen so.

solve a0k
solve solvaiegn)
solve solve (egn, x)
solve (system) solval [egnl egnd, ), (x], 22, .. })
solve_group (DETools) (symmetry generakor and variables) DETools [solve group )i {Bst), (%0 ])
solvefor sobvefor
<ark sart
sort (list) SorE(Baf)
irlt {with ordeting Function) sorf(bsf 1 T
4 3

Obrazek 5.6: Funkce automatického dokoncovdni.

5.3 Napovéda

Népovéda je vyznamnou soucasti systému Maple a pomaha jeho uzivateli velmi rychle
pochopit a vyuzivat prostifedi Maple. K dispozici je nékolik rtiznych typt napovédy.

35Maple rozlisuje mals a velké pismena. Napiiklad zapis Pi piedstavuje Ludolfovo éislo 7 i s jeho hodnotou,
zatimco zapis pi pfedstavuje pouze symbol (fecké pismeno) 7.
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5.3.1 Maple Help

Vyvolanim Maple Help se zobrazi zdkladni stranky napovédy se vSemi dostupnymi
informacemi. Je v nich mozné jednak vyhledavat pozadované téma, ale také prochézet jed-
notliva témata jako v manuélu. Na obrazku 5.7 je okno napovédy oteviené na informacich
k ptikazu discont.
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Obrazek 5.7: Hlavni ndpovéda systému Maple.

5.3.2 Tour of Maple, Quick Reference, Quick Help
Polozka Take a Tour of Maple poskytuje interaktivni prehled systému (jeho nejdiile-

vvvvv

vz

tabulku nez predchozi napovéda. Standardné se objevuje v kazdém novém zapisniku pii pravé
strané v podobé ¢erného okénka (pokud toto nastaveni nezrusime). Po zavieni je mozné ji
vyvolat stiskem klavesy F'1, ¢i jako polozku v hlavnim menu.

5.3.3 What’s New, Startup Dialog

K dispozici je téz prehled rozsifeni stavajici verze Maple oproti predchéazejici verzi (do-
stupné pires Help > What’s New). Napovéda Startup Dialog obsahuje tipy pro praci
se systémem Maple. Zobrazuje se vzdy po spusténi systému (pokud toto nastaveni nezru-
sime).

5.3.4 Manuals, Resources, and more

Vyvolanim Manuals, Resources, and more prejdeme do dalsi oblasti napovédy, z niz
popiseme tTi nejdilezitéjsi casti.
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Maple Portal

Od ptedchézejici verze (tedy Maple 13) je k dispozici tzv. Maple Portal. Spustit jej
muzeme samostatné (Maple Portal mé vlastni ikonu na plose) nebo pfes napovédu v hlavnim
menu (Help > Manuals, Resources, and more > Maple Portal). Maple Portal slouzi
jako pomocnik vS§em novym (a nejen tém) uzivateltim systému Maple. Je v ném mozné rychle
najit detailni popis prace se systémem Maple od feseni nejjednodussich problémt az po velmi
slozité tlohy.
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Obrdzek 5.8: Maple Portal.

Applications and Examples

Z napovédy je mozno vyvolat i spustitelné soubory (tj. jiz vytvofené programy) demon-
strujici moznosti systému Maple. Vyvolame je pies ndpovédu v hlavnim menu (Help >
Manuals, Resources, and more > Applications and Examples) a pak kliknutim na
zvoleny priklad.

Manuals

Z napovédy je mozno vyvolat i anglické manudly User manual, Introductory Pro-
gramming Guide, Advanced Programming Guide a Getting Started with Maple
Toolboxes podrobné popisujici moznosti systému Maple. Vyvolame je pres napovédu v hlav-
nim menu (Help > Manuals, Resources, and more > Manuals) a pak kliknutim na
zvoleny manuél.

5.3.5 Pomocnici, instruktori a feSené ulohy

Systém Maple poskytuje také jiz pripravené ,pomocné nastroje pro feseni tloh. Jsou to
tzv. Pomocnici (Assistants), Instruktori (Tutors) a Ulohy (Tasks), které vyvolame z hlav-
niho menu (Tools > Assistants nebo Tools > Tutors anebo Tools > Tasks). Pomocnici
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(Assistants) maji napt. nastroje pro hledani funkéni zévislosti v datech, optimalizaci funkci,
feseni diferencialnich rovnic a dalsi. Pro dany typ tlohy maji implementovano nékolik ¢asto
pouzivanych algoritmi. Po vyvolani provedou uzivatele nastavenim a specifikaci parametri
ulohy a zvolenou metodou tlohu vyfesi. Instruktori (Tutors) provedou uzivatele FeSenou
problematikou pomoci jednoduchych nazornych piikladt. Ulohy (Tasks) zobrazuji na pii-
kladech, jak Fesit rtizné tlohy. Zobrazi se vyvolanim z menu (Tools > Tasks > Browse).

5.4 Provadéni vypoctu

Maple provadi pfesné numerické vypocty s celymi, raciondlnimi i iracionalnimi ¢isly.
Kazdy zadany matematicky vyraz se snazi co nejvice zjednodusit (napf. zlomek zkrétit
a prevést na zakladni tvar, upravit algebraicky vyraz, ...), ale ne za cenu ztraty presnosti.
To znamend, Ze napiiklad racionalni ¢isla (zlomky) udrzuje stale v jejich zdkladnim tvaru. Po-
dobné s konstantami 7, e a dalsimi, s odmocninami a jinymi vyrazy pracuje jako se symboly.
Timto je zarucena absolutni presnost numerickych vypoctt i v pripadé, kdy nepracujeme
pouze s celymi ¢isly.

Jsou vsak situace, kdy potfebujeme znat ptibliznou hodnotu realného nebo racionalniho
¢isla v pohyblivé Ffadové c¢arce. K tomu slouzi prikaz evalf, jenz vrati zaokrouhlenou hod-
notu svého argumentu na pocet platnych cifer mantisy specifikovany systémovou proménnou
Digits. Ta je standardné nastavena na hodnotu 10. Vsechny vypocty, pii nichz je nutné za-
okrouhlovat ¢isla, provadi proto Maple s presnosti na 10 platnych mist. Proménnou Digits
miizeme nastavit na takika libovolné pfirozené cislo. Omezeni, jak vysoké toto ¢islo mize
byt, zjistime piikazem kernelopts(maxdigits). Pro pfedstavu uvedme, Ze pro Maple 14 je
toto Cislo 268 435 448, tedy vice nez 268 miliont platnych cifer, s kterymi dokaze systém
pocitat.

Pi

T
Digits
10
evalf (Pi)
3.141592654
evalf (Pi, 5)

3.1416

evalf (Pi, 20)
3.14159263358979323835

Obrazek 5.9: Prikaz evalf.

Aniz bychom ménili nastaveni proménné Digits, mtizeme zobrazit libovolny vyraz s poza-
dovanou presnosti pouze pomoci piikazu evalf. Piikaz je mozné pouzit s jednim nebo dvéma
parametry. Jediny zadany parametr znamena, ze tento zadany vyraz bude vyhodnocen na
pocet platnych mist specifikovany v proménné Digits. Pfidany druhy parametr fekne funkci
evalf, na kolik platnych mist ma vyraz vyhodnotit, viz pfiklady na obrazku 5.9.

S dffve zminénou napovédou souvisi symbol ? (otaznik). Otaznik spolu s nézvem pii-
kazu otevie napovédu na strance tykajici se zadaného piikazu. Tedy napft. piikaz 7evalf
otevie hlavni napovédu systému na strance popisujici syntaxi a sémantiku piikazu evalf
spolu s priklady jeho pouziti. Zapsanim dvou otaznikli na zacatek prikazu otevieme tutéz
stranku napovédy ve ,sbaleném® tvaru osnovy, v niz je mozné oteviit (odkryt) libovolné
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casti. Nakonec je tu jesté moznost zadani tii otaznikd pred prikaz, coz otevie napovédu na
prikladech pouziti tohoto ptikazu.

Maple rozeznava presna ¢isla (mezi néz patii i zminéné symboly 7 a e, zlomky atp.)
a cisla typu Floating-Point, nebo-li ¢isla v pohyblivé fadové carce. Jestlize systému zadame
vyraz, v némz néktery z jeho podvyrazt bude typu Floating-Point, mize Maple na cely
vyraz pohlizet jako by byl tohoto typu a bude vysledky vypoctt zaokrouhlovat. To nejlépe
uvidime na dalsich prikladech na obrazku 5.10.

2,3 _13 2 =
Sro= ale 3+ 1.5 =2.166666667
J2 43 =2 +/3, ak J20 + /3 =1.414213562 + /3

Obrdzek 5.10: Presnd cisla a c¢isla typu Floating-Point.
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Obrazek 5.11: Provedeni vypoctu pomoci kontextové nabidky.

5.4.1 Prikazy

Pro provedeni vypoctu mame zpravidla vice moznosti. Tou zakladni, ktera je k dispozici
ve vSech verzich systému, jsou prikazy jazyka Maple. Chceme-li napiiklad vypocitat odmoc-
ninu z ¢isla 2.5, zapiseme v systému Maple piikaz sqrt (2.5). Stejného vysledku dosdhneme
pouzitim symbolu pro odmocninu z palety Expression. Pokud chceme urc¢it nejmensi spo-
le¢ny nasobek ¢isel 10, 12 a 15, miizeme vyuzit ptfikazu lecm, nebo zapsat ¢isla na tadek
za sebe (oddélend ¢arkami) a pres pravé tlacitko mysi zvolit z kontextové nabidky Apply
Function > Least Common Multiple, viz obrazky 5.11, 5.12.
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sqrt(2.5) = 1.581138830
J2.5 =1.581138830
lem (10,12, 15) =60

integer lcm

10,12, 15 ——— 60

Obrazek 5.12: Rizné moznosti v provedent vypoctu.

5.4.2 Oznaceni vysledkii

Kazdému zobrazenému vysledku se v zapisniku pfirazuje ¢iselné oznaceni, které se zapi-
suje zcela vpravo na fadek s odpovidajicim vysledkem. Oznaceni je mozné potlacit (tj. ne-
zobrazovat), znovu vyvolat, pfipadné upravit jeho format v hlavnim menu (Format >
Equation Labels > ...). Diky oznaceni se mizeme na ptedeslé vysledky odvolavat a po-
uzivat je pii tvorbé dalsich piikazi. V ukédzkach vytvorenych dokumentti (prezentovanych
v tomto textu) je oznaceni vysledki vzdy potlaceno. Pouziti oznaceni ilustruje obréazek 5.13.

Pokud chceme napiiklad pricist ¢islo 10 k vysledku s oznacenim (2), pak napiSeme ,,10
+ “ a pres klavesovou zkratku ,,Ctrl + L“ vloZime poZzadované oznaceni (tedy do ,vy-
skakujiciho okénka“ zadame ¢islo 2 a potvrdime (OK)). Misto klavesové zkratky ,,Ctrl +
L* je mozné pouzit horni menu (Insert > Label...). Upozornéme, Ze zapis (2) vytvoreny
(pouze) na klavesnici pfi tvorbé piikazu Maple nepochopi, pro vlozeni oznaceni do pfikazu je
tfeba dtisledné pouzivat predesly postup s ,vyskakujicim okénkem* zobrazenym na obrazku
5.14.

2
3~ 6
_16 @
3
83
24 2)
5—n
55— R 3
10+ @)
34 )

Obrazek 5.13: Oznacent vysledki.

Maple dale nabizi moznost odkazovat se na posledni t¥i vysledky (v tomto ptipadé je
jedno, zda byly zobrazeny ¢i nikoliv, a zda maji n&jaké oznaceni) pomoci symbolu % (pro-
cento). Jedno procento (%) piedstavuje posledni vysledek, dvé procenta (%%) predposledni
a t¥i procenta (%%%) pred-predposledni. Upozornéme, ze vysledek ziskany témito prikazy
zavisi na poradi vykonanych piikazi, ne na jejich umisténi v zapisniku! Tedy nap¥. % vypise
posledni vysledek ziskany predchozim (¢asové) vykonanym piikazem.
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Insert Label x|

Type: IEquatiu:un j

Identifier: I

(o] 4 Cancel |

Obrazek 5.14: ,,Vyskakujici okénko* pro zaddni oznacent.

2
= +5
5+
17
3
8-3
24
5-®
5—n
%, %%, %%%
17
5—m, 24,
E? » 3

Obrazek 5.15: Vyuziti procent pri odkazovdni se na predchozi vysledky.

5.4.3 Prirazeni hodnot do proménnych

Odkazovat se na vyrazy mtzeme také po jejich pritazeni k néjaké proménné. Operatorem
pfifazeni je (dvoj)symbol := (dvojtecka + rovnitko).

Namisto (dvoj)symbolu := muZeme k pfifazeni pouzit piikaz assign. Tak, jak miZeme
vyrazy do proménnych pfifazovat, mizeme téz prifazeni zrusit (tj. odebrat proménné ulo-
zenou hodnotu). Zminéné provedeme priikazem unassign nebo piifazenim nazvu proménné
v apostrofech (obrazek 5.16).

Pritazovat hodnoty miizeme i do tzv. systémovych proménnych. Jiz jsme se setkali s pro-
ménnou Digits, ktera vyjadiuje pocet platnych mist, s nimiz Maple pocita. [lustraci na ob-
razku 5.17 mtzeme srovnat s obrazkem 5.9.

Odstranit ulozenou hodnotu v systémové proménné nelze. Do systémovych proménnych
miizeme hodnoty pouze prirazovat, nebo soucasné vratit piikazem restart nastaveni vSech
systémovych proménnych na jejich ptivodni hodnoty. Provedeni piikazu odstrani vSechny
uloZzené hodnoty v paméti (tedy i nami definované proménné, nactené baliky atd.). Piikaz
restart se proto pouziva zpravidla na pocatku reseni nové tlohy, zejména pak na zacatku
kazdé prace se zapisnikem (aby se pfedeslo tomu, Ze budeme pouzivat proménnou, v niz je
z diivéjska ulozena pro nés nespravna hodnota).

5.4.4 Baliky

Knihovna piikazii jazyka Maple je rozdélena na hlavni knihovnu a tzv. baliky3¢. Piikazy,
s nimiz jsme se doposud setkali, patii do hlavni knihovny, a mtzeme je tak pouzivat ihned

36Kromé pojmu balik se v ¢estiné pouziva také termin knihovna.
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a e
a c
ai=2 assign(e, 2)
2 ¢
a 2
2 unassign('c')
¢
b ¢
b a
bi=3a 2
6 a="g'
b a
6 @
a

Obrazek 5.16: Pritazeni hodnot do proménnijch a odstranéni uloZené hodnoty.
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readf [Pi)

341392653 580 TOR AR

Obrazek 5.17: Proménnd Digits a prikaz evalf.

po spusténi systému. Naproti tomu vétsina prikazt nalezi do balikid, které musime pied
pouzitim prislusného piikazu bud nacist do dokumentu pomoci piikazu with, nebo zadat
prikaz spolu s ndzvem baliku. Nacteni baliku pomoci ptikazu with umozni pouzivani vSech
prikaz z prislusného baliku. Naopak zadani prikazu spolu s nazvem baliku je nutné provadét
pii kazdém pouziti tohoto piikazu, pokud balik nena¢teme (piikazem with).

Napriklad ptikazy pro praci s vektory a maticemi nalezi do baliku LinearAlgebra.
Jestlize chceme tedy pouzit prikaz Eigenvalues pro nalezeni vlastnich ¢isel matice, nacteme
nejprve balik LinearAlgebra, jak dokumentuje obrazek 5.18.

Jednotky

Praci s jednotkami umoziiuje balik Units. Pii vypoctech tak nemusime pracovat jen
s Cisly, ale mizeme jim pfirazovat i jednotky. K vlozeni jednotek do zapisniku vyuzijeme
palety Units. Obrazek 5.19 ilustruje pouziti jednotek pfi vypoctu gravitacni sily ptisobici
v tthovém poli Zemé (tj. gravitacni zrychleni je rovno piiblizné 9.81 ms~2) na téleso o hmot-
nosti 10 kg. Vidime, Ze Maple umi jednotky také zjednoduSovat (resp. upravovat na jiny
tvar). Ke zjednoduseni vyrazt pfitom slouzi piikaz simplify.
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1 2 1
Matice i =| 6 -1 0
-1 -2 -1

with( Lineardlgebra) :

Eigenvalues (Matice)

Obrdzek 5.18: PouZiti balik.

Fi= 10[[kg]]-9.81[[Lj]]!
98.10 [kz] =]
B

simplify (%)
98.10 [M]

Obrdzek 5.19: Pouziti jednotek.

Maple rozpoznava jednotky riiznych soustav a velikosti, s nimiz umi pracovat a vzajemné
je prevadét. Pro prevod jednotek je k dispozici specialni nastroj zvany Units Calculator.
Spustit jej muzeme z hlavniho menu pies Tools > Assistants > Units Calculator...,
ukéazku poskytuje obrazek 5.20.

Pokud chceme pouzit jednotku, ktera neni v paleté Units, mtizeme si ji vytvorit sami
tak, ze pridame jednotku s ndzvem unit a nazev prepiSeme. V systému Maple 13 je imple-
mentovano celkem 568 jednotek (tzn. v paleté Units je pouze nékolik vybranych).

-
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Obrdzek 5.20: Units Calculator.
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Védecké konstanty

Balik ScientificConstants poskytuje hodnoty fyzikalnich konstant a chemickych vlast-
nosti latek spolu s jednotkami a neurcitostmi v téchto hodnotéach. Piikazem GetConstant
zobrazime informace o dané konstanté, viz obrazek 5.21 pro gravitacni zrychleni v tthovém
poli Zemé a Newtonovu gravitacni konstantu.

¥ Biln.

SATE 18 ]

Obrazek 5.21: PouZiti baliku ScientificConstants.

g = GetValue(Constant('g") ) - GetUnit ( Constant('g") )

9.80665 | -
g L
m o= 10kg]:
F=m-g
T 1l
F=98.06650 [kg] HT
) 4
simplify (%)

F=9%.06650 [IV]

Obrdzek 5.22: Prdce s vedeckymi konstantami.

Piikazem GetValue ziskdme (pouze) numerickou hodnotu konstanty, piikazem GetUnit
(pouze) jednotku — obrazek 5.22.

5.4.5 ReSeni rovnic

Pro feseni rovnic ma systém Maple piikaz solve a nékolik piikazii k nému pribuznych
zavislych na typech rovnic, viz tabulka 5.1.

Tabulka 5.1: Prikazy pro Tesent rovnic

Typ rovnice

Prikaz pro reseni

Rovnice a nerovnice

solve, fsolve

Obycejné diferencialni rovnice dsolve
Parcialni diferencialni rovnice pdsolve
Rovnice v oboru celych cisel isolve
Rovnice v oboru celych ¢isel v kone¢ném télese | msolve
Linearni integralni rovnice intsolve

Systémy linearnich rovnic

LinearAlgebra|LinearSolve]

Rekurentni rovnice

rsolve

Pomoci interaktivniho prostiedi Standard Worksheet mtzeme Tesit rovnice téz pomoci
kontextové nabidky. ZapiSeme rovnici a pravym tlac¢itkem mysi zvolime pozadovany piikaz.
Obrazek 5.23 ilustruje nékteré ptiklady Feseni rovnic.
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Ptikazy pro feseni rovnic nemusi vzdy zobrazit vSechna feSeni. Pokud je chceme zobrazit,
pridame prikazu solve nepovinny parametr AllSolutions, viz obrazek 5.24.

Ravmboe

salue(x® + 3x + 6=0)
3.3
N e T T P T P ||
M epnvmbor
sodvelx® # 82 # 6 < 0)
il Mape| Chova| -3 ), G| =1 )
SoiTE

TR R R Tt | =3 <x1x< =1

Rekurentni rovndce
readve [ [N+ T =1 ¥ a—=")- N{e), NTO) =NOT, MED )
MO (1 4a=b)

Nit+01li=(1 +.:—n|-.‘.'|:|..i‘-:'-:tl:--4‘.’.-Mr e rl | +.:-—:'|I

Diferencialna rovnice
daolve| | -:T Mit) = (@ = b)-Nir), ¥10) =20] |

M) =k g "

setwe DE a— 8T
M) =Noe' 1

% Mt} = (@ — 5)-Nit}, N[0] =N

Obrdzek 5.23: Ukdzka TeSent riznych druhi rovnic pouZitim jednak prikazu, jednak kontertové na-
bidky.

goved | sl x ] =gosix )]
1
= N
A4
soteelmmix ] = conix ], AV Scfegions )
1 -
— x4+ 8 _FI-
i
aboes| ZF)
Taginally H&, cenamed Za-:
ig samimed Bo BE: InEsger
. el miforptend e,
i [ ZF-imeger )

Obrdzek 5.24: Zobrazeni vech Teseni rovnice.

Symbol _Z2~ na obrazku 5.24 pfedstavuje libovolnou celo¢iselnou proménnou. Ze jde
o celociselnou proménnou pozname podle toho, Ze se v symbolu vyskytuje pismeno Z. Po-
dobné by vyskyt napiiklad pismena C znacil proménnou komplexni. Cifra 2 v symbolu
proménné oznacuje poradi, v jakém byla proménnd v zapisniku zavedena. A nakonec znak
~ vyjadiuje, Ze proménnd spliiuje né€jaky predpoklad. Jaké predpoklady proménna spliuje
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pritom zjistime prikazem about, piipadné zapisem proménné a po kliknuti pravym tlacit-
kem mysi zvolenim What Assumptions z kontextové nabidky. V zobrazeném ptikladu na
obrazku 5.24 je predpoklad celoc¢iselnosti proménné prebytecny.

Déle muzZe piikaz solve zobrazit vysledek se strukturou RootOf vyjadiujici kofen (tj. fe-
Seni) rovnice v nevyhodnoceném tvaru. Refeni pak vyhodnotime bud piikazem allvalues
(pro symbolické vyjadfeni), nebo piikazem evalf (pro numerické vyjadieni) — obrazek 5.25.
Vedle prikazi mtzeme téz vyuzit pravého tlac¢itka mysi, zvolit z kontextové nabidky polozku
All Values (pro symbolické vyjadieni) a ziskany vysledek pfevést na numerickou hodnotu
zvolenim Approximate > 10 (pro 10 platnych mist) z kontextové nabidky.

Solve(x4 —2x0+ 2=0)
RoorOf(_Z4 -2 _23 +2, mdex=1), RoorOf(_Z4 -2 _23 +2, ma’ex=2),
RoorOf(_Z4 -2 _Z3 +2, ma’ex=3), RoorOf(_Z4 -2 _Z3 +2, ma’ex=4)

allvalies ({%})
1

evalf (%)
{-0.5290855140 — 0.7429341359 I, - 0.5290855140 + 0.7429341359 1,

1.529085514 — 0.2570658641 I, 1.529085514 + 0.2570658641 I}

Obrazek 5.25: Tvar zobrazent 1eseni rovnice.

Soive(x2 < 0)
infolevel[salve] :=1:

Solve(x2<0)
solve: Warning: no solutions found

Obrdazek 5.26: Proménnd infolevel a ,prdzdny vypis® prikazu solve.

Symboly _Z ve struktufe RootOf nyni nepiredstavuji celo¢iselnou proménnou (nebot za
pismenem Z nenésleduje ¢islo), nybrz proménnou libovolnou (tj. i komplexni). Struktura
RootOf z obrazku 5.25 tedy zastupuje koien rovnice z* —2- 2% +2 = 0.

Systém Maple po zadani prikazu vypise zpravidla pouze Teseni, piipadné chybova hla-
Seni ¢i varovani. U pfikazu solve (a nejen u néj) toto chovani zptisobuje ,prazdny vypis“
v pripadé, ze Maple zadné feseni nenasel. Pro vypis podrobnéjsich informaci o pribéhu vy-
hodnoceni piikazu a vysledcich slouzi proménnd infolevel. MtZeme ji nastavit bud pro kazdy
prikaz samostatné, pficemz do hranatych zavorek za proménnou vlozime nézev prislusného
prikazu, nebo ji nastavime vSem pfikaziim soucasné na stejnou hodnotu uvedenim slova all
do hranatjch zavorek. Proménna miize nabyvat hodnot 1, 2, ..., 5. Cim vy$si hodnota je
pritazena v proménné infolevel, tim vice informaci o vyhodnoceni ptikazu obdrzime. Stan-
dardné neni proménna nastavena na zadnou hodnotu, coz v podstaté odpovida nastaveni
proménné na hodnotu 0. Pouziti proménné infolevel dokumentuji obrazky 5.26 a 5.27.
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Obrazek 5.27: Proménnd infolevel a prikaz solve.

5.5 Funkce

Definovat funkci miizeme raznymi zpisoby. Pti zaddvani (pouze) na klévesnici napiSeme
nazev funkce, symbol pro pfifazeni (:=), argument funkce, Sipku vpravo a funkéni pfedpis.
Sipku piitom vytvofime jako poml¢ku nasledovanou uzavirajici lomenou zévorkou (sym-
bol ,v&tsi nez“). Checeme-li tedy vytvofit funkci f(x) = 22, zapiSseme do zdpisniku piikaz
f:=x->x"2.

Pro zjednoduseni mizeme vyuzit palet. Bud je mozné pii vytvareni piikazu pouzit Sipku
z palety Arrows, nebo miizeme vzit celou Sablonu piikazu vytvoreni funkce z palety Expres-
sion a modifikovat v ni pozadované symboly. Vytvaret pritom mtzeme funkce libovolného
po¢tu proménnych. V prostiedi Standard Worksheet (s nimz celou dobu pracujeme) mtizeme
funkci vytvortit téz zapisem bez Sipky: f (x) :=x"2. Po odkliknuti ptikazu musime v nasledné
zobrazeném vyskakujicim okénku potvrdit, ze se jedna o definici funkce.

Funkéni hodnotu v daném bodé ziskdme zapisem nazvu funkce spolu s hodnotami para-
metri v zavorce (nemusime pritom zadavat pouze numerické hodnoty).

Diilezité je rozeznavat funkce od vyrazi. Jestlize vytvorime vyraz, napriklad x~2, a pfi-
fadime jej k néjaké proménné, napi. g, jedna se stale pouze o vyraz. Hodnotu g pro x = 5
nemuzeme proto urcit jako funkéni hodnotu v bodé 5, ale musime pouzit vyhodnocovaciho
prikazu eval, pfipadné do z prifadit hodnotu 5, viz obrazek 5.29.

Funkce (i vyrazy) miZzeme téz definovat po ¢astech pomoci piikazu piecewise. Argu-
menty v zavorce signalizuji vzdy nejprve interval nasledovany funkéni hodnotou na tomto
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Obrazek 5.28: Definice funkce.

intervalu. Posledni interval jiz zapisovat nemusime, staci funkéni hodnota, Maple ji doplni
ve zbyvajici mnoziné zatim nedefinovanych bodi. Je mozné téz sestrojit funkci, ktera je de-
finovana pouze na libovolné podmnoziné realnych ¢isel. Pokud ma funkce definovana po ¢as-
tech pouze dva ritzné predpisy, mizeme k jejimu vytvoreni vyuzit symbolu oteviené slozené
zévorky z palety Expression.

o 5)*

if

LM

Obrazek 5.29: Rozdil mezi funkci a vyrazem.
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Obrazek 5.30: Funkce definovand po castech.

5.6 Kresleni a animace

Interaktivni prostredi Standard worksheet nabizi hned nékolik moznosti k vykresleni grafu
funkce. Nejrychlejsi a zfejmé nejjednodussi je zadat do zapisniku vyraz z funkéniho predpisu,
kliknout na néj pravym tlacitkem mysi a z kontextové nabidky zvolit Plots > 2-D Plot
(v pripadé funkci jedné proménné). Zvolenim Plots > 3-D Plot z kontextové nabidky spolu
se specifikaci proménnych zobrazime funkce dvou proménnych.

Dale muzeme vyuzit pomocnik Plot Builder, a to dvéma zpisoby. Bud opét zapiSeme
do dokumentu vyraz z funkéniho predpisu, klikneme pravym tla¢itkem mysi a zvolime Plots
> Plot Builder, nebo zamifime do hlavniho menu a vybereme Tools > Assistants > Plot
Builder... . V prvnim pfipadé se objevi okénko Interactive Plot Builder (obrazek 5.31),
v némz upiesnime typ vykresleni. Pokud uvazujeme funkci jedné proménné, obvyklou volbou
je 2-D Plot. Mizeme vSak volit i jiné jako naptiklad vykresleni v polarnich souradnicich (2-
D polar plot). Obdobné je tomu u trojrozmérného vykreslovani funkei dvou proménnych.
Kliknutim na tlacitko Plot graf zobrazime v dokumentu.

V druhém pripadé, kdy Plot Builder vyvolame z hlavniho menu, se ndm objevi okénko
(viz obrazek 5.32), do néjz zadame vyraz z predpisu funkce, kterou chceme zobrazit (zadani
nam umozni tla¢itka Add, resp. Edit), a proménné (pokud vyraz obsahuje pouze proménné,
systém je vyplni sdm). Kliknutim na tla¢itko OK piejdeme do jiz zndmého okénka pro zvoleni
typu vykresleni (obrazek 5.31).

Nakonec mame moznost k vykresleni grafu funkce pouzit ptikaz plot v pripadé funkce
jedné proménné a prikaz plot3d pro funkci dvou proménnych. Piikazu plot3d musime zadat
i rozsahy hodnot, kterjch mohou proménné nabyvat. Pti trojrozmérném vykreslovani se graf
standardné zobrazuje bez soufadnych os (obrazek 5.33). Obéma piikaztim (plot, plot3d)
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F1: Interactive Plot Builder: Select Plok Type |

—Select Plok Type and Functions

Bllald + Edit Functions |

~Select Plot

2-D plat

2-D polar plat

3D conformal plat of a complex-valued Function
2-D conformal plot of a complex-valued Function
2-D complex plot

3-D complex plot

—Select Yariable Purposes, Ranges, and Flok Option:

Ix Axis Ix V| I—ID o IID
Jptions | Preview |

On 'Plok’ return plot command 'l

Cancel |

Obrazek 5.31: Zvoleni typu vykreslent v Plot Builder.

ET,] Interactive Plot Builder: Specify Expressions ll
File:
— Expressions
Add
Edit |
Remaoyve |
 Wariables

Add

Remaye |

Obrazek 5.32: Okénko pro zaddni vyrazu z predpisu funkce a proménngch v Plot Builder.

muzeme na vykresleni zadavat jak funkce, tak vyrazy.

Pii vykreslovani je k dispozici nékolik atributt ménicich podobu grafu. Opét je nékolik
moznosti, jak atributy zadavat. Pii pouziti pomocnika Plot Builder se v okénku Inter-
active Plot Builder (obrazek 5.31) objevuje tla¢itko Options. Kliknutim na toto tlacitko
pfejdeme na okénko (viz obrazek 5.34) umoziujici nastavit parametry vykresleni jako jsou
rozsah hodnot zavisle i nezavisle proménné, barva a styl vykreslované ktivky, titulek grafu,
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Obrdzek 5.34: Okénko Plot Builder pro nastaveni parametri grafu.

legenda atd. Uzitecné je navic tlacitko Preview umoziujici predbézné si prohlédnout sou-
Casny stav a nasledné pokracovat v dalsim nastavovani atributii vykresleni grafu.

P¥i pouziti piikazu plot (resp. plot3d) muZeme totéz provést specifikaci nepovinnych
parametru jako jsou thickness pro tloustku kiivky, color pro jeji barvu, discont pro zob-
razeni nespojitosti, labels pro popisky os, legend pro tvar legendy u obrazku, axes pro
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nastaveni soutfadych os a dalsi. Ukazku pouziti ptikazu plot s nastavenim nékterych nepo-
vinnych parametrt nabizi obrazek 5.35.

pi.:-l.'[.::i. x==5% 5 codor=blue, thickress =5, legend
= "Giraf finkee x°27, labelz = [ "x", "] )

—

i
e Cruf Fakee 172 |

Obrazek 5.35: Vykresleni grafu pri specifikaci nékterych nepovinnych parametri.

[ 3¢ Enboratbive Plok Bulder; Spoily Erpressisms

Herriren

U S

Obrdzek 5.36: Zaddni vyrazu z predpisu funkce v Plot Builder.

[ u vytvoreného grafu lze upravovat jeho vzhled. Jednak mtizeme na graf kliknout pravym
tlacitkem mysi a z kontextové nabidky vybirat vlastnosti grafu, které jsme mohli ménit
jiz dfive, nebo mizeme vyuzit kontextové listy tésné nad dokumentem. Po kliknuti levym
tlacitkem mysi na graf se ve zminéné listé zobrazi nastroje skupiny nazvané Plot. K dispozici
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je téz skupina s nazvem Drawing. Nastroje v téchto skupinach umoznuji do hotového grafu
pridavat text, kreslit, ¢i jinak upravovat.

[ et ik B el it Ty _=:
Select Mot Types sred Punctions.
T — e s
Tder] el
T
& ke peok
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2:[x ponferreal pick o & pomblas-raied Puncon

2D ot il
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(7] _cme |

Obrazek 5.37: Zvoleni druhu vykresleni (animace) v Plot Builder.

V systému Maple mizeme téz vytvaret animace. Animace se sklada z nékolika grafi,
které jsou po spusténi zobrazené v sekvenci za sebou. Vytvorime ji bud piikazem animate
z baliku plots, nebo pomoci Plot Builder. Obrazky 5.36 a 5.37 ukazuji nastaveni Plot

Builder pro vytvoreni animace, obrazek 5.38 ilustruje tentyz pfiklad na pouziti piikazu
animate.

withl prafs )
arimate| plof, [A¥en{x), x=-10. 10].A=0_2 ]
A= 30000

]

=
T
ol 1
a
B — T
i
o

Obrdzek 5.38: Animace vytvotend prikazem animate.

Ukonceni Plot Builderu, resp. provedeni prikazu, umisti do dokumentu ,,prazdny* graf.
Kliknutim na néj zobrazime skupinu néstroji v kontextové list€é s ndzvem Animation.
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Pomoci téchto nastroji mizeme animaci spustit, zménit jeji rychlost, podivat se na libovolny
snimek animace atd.

Animace mtizeme upravovat stejné jako grafy (vytvorené piikazy plots, plots3d), tj. mé-
nit tloustku, barvu a druh kiivky, soufadné osy, legendu apod. Navic médme k dispozici
nékolik nepovinnych parametri, diky nimz mizeme naptiklad urfit pocet grafii, z nichz se
animace sklada, nebo kolik grafti mé zistat trvale zobrazenych (po spusténi animace).

5.7 Prace s neurcditostmi

Pro préaci s neurcitostmi nabizi systém Maple nékolik nastroji. Jejich pouziti zavisi zpra-
vidla na mnozstvi informace, kterou mame.

5.7.1 Intervalova aritmetika

V piipadg, ze zname pouze velikost (intervalu) neurcitosti, vyuzivame intervalové aritme-
tiky implementované v baliku Tolerances. Proménné (resp. konstanty) definujeme spolu s
intervalem chyby (neur¢itosti) pomoci symbolu &+— a pracujeme s nimi jako s ,,oby¢ejnymi*
proménnymi (resp. konstantami), viz obrazek 5.39.

with ( Tolerances) :
¢:=35 &+ - 0.05

5.00 + 0.0500
b =2 &+ - 0.03

2.00 £+ 0.0300
a+b

7.00 + 0.0800
a-b

10.0 + 0.250
@ —3-b+1

20.0 + 0.590

Obrdzek 5.39: Intervalovd aritmetika s balikem Tolerances.

5.7.2 Scientific Error Analysis

Balik ScientificError Analysis umoznuje pracovat s veliCinami, které maji néjakou
stfedni hodnotu a p¥ifazenou neur¢itost (resp. chybu). Na rozdil od intervalové aritmetiky
je nyni interval neurcitosti prokladan normalnim rozlozenim hodnot se stiedni hodnotou ve
stfedu intervalu a smérodatnou odchylkou rovnou délce poloviny intervalu. Navic je mozné
pritazovat veli¢indm korelaci (linedrni zavislost) mezi sebou. Veli¢iny definujeme piikazem
Quantity, propagaci chyb danym vyrazem urc¢ime piikazem combine, korelaci nastavime
prikazem SetCorrelation. Ilustraci poskytuje obrazek 5.40.

5.7.3 Fuzzy Sets Toolbox

Toolbox FuzzySets neni standardni soucasti systému Maple, a je nutné jej dokoupit. Po
instalaci funguje jako klasicky balik ptikazt, ktery umoznuje vyuzivat fuzzy logiku a kon-
struovat a pouzivat fuzzy mnoziny. Fuzzy mnozina mtze byt definovana obecné na libovolné
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with| ScientyficErrordnalysiz | ;

8 i= Chavetiay| 3, 0005 )
Eheareticy (5, 0.09)

b = Cuarriy(2, 0.00)
Chumatity (2, 003 )

combing| s + b, errarz]
Crugnrane | ., 0. 0500 EE0E

combene | 2-b, errora))
Croantehe | 10, 0.1R02TTSERE
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Puantehy [ 20, 05080354318 )

EeiCarvelstron(a, b, 1)

combine| 2 + b, drrarz |
Craatine | V., 0. 00D00 00000 §

combone| @-B, errors )
Cheantely [ 10, 02500000000 )

SpCareeizion(a, b, -5 )

combend] @ + b, errars]

Cheamrene | T, 0, ) SEEDERIM )
combrne| a-b, errara

Crezmrnpe | 10, 0. 1FEERTRELE

Obrdzek 5.40: Prace s balikem ScientificErrorAnalysis.

with [ FiszySeis| Real Domarn | )
| 1,
PrmA(1,1,3) e b
L1} rol
n
F=1 rel
-r+3 r<3
1 atherwize .

ploe Fe, 0.4, thicknes =3

LB
0
07

[

Fel = PuzzySet(x 3, 0,1 £ 2 +e, Injx — 2},

e THIFE)
L] L o |
fr=2) r=514s
| rEd+te

i =
- athe Fwise

ploe( Fz2, 0,13, thiskners =3 )

107

Obrdazek 5.41: Konstrukce fuzzy mnoziny a jeji zobrazend.




mnoziné objektd U, je vSak mozné (a ¢asto vhodné) omezit balik FuzzySets pouze na
mnozinu realnych cisel. K dispozici je nékolik konstruktori fuzzy mnozin, pricemz ten nej-
univerzalnéjsi je témér totozny s piikazem piecewise pro tvorbu po ¢astech definovanych
funkeci.

Obrazek 5.41 ilustruje nacteni baliku FuzzySets s omezenim na mnozinu redlnych ¢isel
a konstrukci dvou rtznych fuzzy mnozin s naslednym vykreslenim jejich funkci ptislusnosti.
V prvnim pfipadé (vlevo) je pouZit konstruktor A vytvafejici fuzzy mnozinu s funkei pii-
slusnosti, jejiz tvar odpovida tomuto feckému pismenu. Napravo je fuzzy mnozina vytvorena
pomoci obecného konstruktoru (ktery je analogicky k prikazu piecewise).

ploc] [ Fz, Fe2, Fr wmbon Fel), 013, torclneer |ploe( | Fr, Fzl, Frintersect F22 ], .15, thickmess

m [ 1,1, 3], cadorm !:_.;r\:'-rlr. b, 7ed] ) m 1, 1.3, colarm |.E_'-"-rr-1. Biiie, nr:l"r' |
I - .
| |
|
|
] |
u | |
|
[ |
| |
LT f |
| i
| 1
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| |
| Il
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I ""\_\
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Obrdzek 5.42: Zobrazeni sjednoceni a pruniku fuzzy mnozin.

proel | Fe, Complemena| E2 ) |, 0.5, thickiesr=[1,3 ],
coser= | greem, red ] |
i =
ox
M -
04
03
[ ! T T 1
Q 1 F 3 4 -]

Obrazek 5.43: Komplement fuzzy mnoZiny.
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S fuzzy mnozinami mizeme provadét mnozinové operace. Na obrazku 5.42 jsou vyznaceny
operace sjednoceni (vlevo) a prunik (vpravo) pravé vytvorenych mnozin. K dispozici pfitom
mame i dal$i mnozinové operace jako jsou odecitdni mnozin, komplement mnoziny (v uni-
verzu) a dalsi. Ukdzku komplementu fuzzy mnoziny predstavuje obrazek 5.43. Na obrézcich
5.42, 5.43 jsou vzdy vykresleny funkce pfislusnosti pivodnich mnozin i téch vyslednych (po
aplikaci dané operace). Vysledné mnoziny jsou zndzornény tlustou ¢arou.

Balik FuzzySets poskytuje téz prostredky tzv. defuzzifikace, tedy prifazeni ¢iselné hod-

YV

)

pomoci atributu method=area), viz obrazek 5.44.

Deflzzify ( Fz)
2
Defuzzify ( Fz2)
9 1 2.1 2 1, 4+ et
5 3 £
?+Te +7(4+ej—?(2+ej+e [ I + I ]
e4 +e e—4
3+ -
¢
evalf (%)
5.813027376
Defizzify ( Fz, method = area)
2.000000000
Defizzify ( Fz2, methad = area)
5.718281828

Obrazek 5.44: Defuzzifikace.

5.7.4 Balik Statistics

Pro praci s nastroji matematické statistiky a analyzy dat je urcen balik Statistics. Nabizi
sirokou skalu piikazti, mezi nimiz jsou i ptikazy pro vytvareni ndhodnych veli¢in mnoha riz-
nych pravdépodobnostnich rozlozeni a praci s nimi. Z pohledu neurcitosti se zamérme praveé
na generovani nahodnych veli¢in, jez vyuzivame pfi Monte Carlo simulacich. Na obrazku
5.45 muzeme vidét nacteni baliku Statistics a baliku plots, ktery potiebujeme k pouziti
prikazu display. Definujeme nahodnou veli¢inu s lognormalnim rozlozenim pravdépodob-
nosti (se stfedni hodnotou 1340 a smérodatnou odchylkou rovnou 0.6) a vykreslime jeji
hustotu. Nasledné vygerujeme 10 realizaci této veliciny, kterym priradime piikazem Rank
poradi (od nejmensi hodnoty). Poté vygenerujeme 1000 realizaci definované ndhodné veli-
¢iny, opét vykreslime jeji hustotu, tentokrat spolu s histogramem vygenerovanych hodnot.
Piikazy Mean a Variance urc¢ime stiedni hodnotu a rozptyl vygenerovanych hodnot.

5.8 Zaklady programovani

Doposud jsme vykonavali pfikazy jednotlivé. Systém Maple obsahuje téz programovaci

vvvvvv
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Obrdzek 5.45: Prdace s balikem Statistics.

5.8.1 Podminény prikaz if

Syntax:
if podminkal  then  prikazyl
elif podminka2  then  prikazy2
elif podminka3  then  prikazy3
else  prikazyN
end if

Jak mtzeme vidét na obrazku 5.46, v podminéném piikazu nemusi byt pouzity vsechny
prvky uvedené vyse. Podminku tvoti vzdy vyraz, u né€jz je mozné rozhodnout, zda je pravdivy,
¢i nikoliv. Prikazi, které se maji provést pfi splnéni podminky, mtze byt vice. Od sebe je
oddélime stfednikem, pfipadné dvojteckou.

P1i vytvafeni prikazu na vice fadkt pouzijeme k prechodu mezi fadky soucasného stisk-
nuti klaves Shift a Enter. Stisk samotné klavesy Enter by zptsobil vyhodnoceni rozepsa-
ného prikazu.
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3 3

if A<5 then print("A je mensineZpét.") endif
"A je mensi neZ pét.” if (4<5andB<3)

then prist("A i B jsou mendi neZ pét.")

A:=6
6 elif (A< 5and 3 > 35)

then prist("A je mend ne? pét, B je vEti nebo rovno p&ti.")

if A<35 thenprint("A je mendi neZ pét.")
else prirt("A je vEts nebo rovno péti.") elif (4> 5and B < 5)

end if then prisi("A je mendi neZ pét, B je vEté nebo rovno péti.")

"A je vEt¥ nebo rovno pét."”

else prirt("A 1B jsou vétii nebo rovny péti.")

if A=6 then B:=7,:=8§ F:=156.89 endif

- end if

8
156.89

"A je men#i neZ pét, B je vétsi nebo rovno péti”

Obrdzek 5.46: PouZiti podminéného prikazu if.

5.8.2 Cyklus for
Syntax 1:

for iterator from  pocatek by prirustek to konec do prikazy
end do

Syntax 2:

for promenna in wyraz do prikazy end do

for ; from 1 to 5 do print(£) enddo for  from 10 by -1 to 3 do
1 if fsprime(7) then print(i)
4 end if
end do
? 7
16 5
25 3

for i from 1 by 3 to 10 do prmr(iz) enddo ooy = 22,97, 222,397, 622]

1 [22,97,222,397,622]
16
49 for 1 in seznam do pri’nr[\fl'-l-—:i) end do
100 3
10
15
20
25

Obrdazek 5.47: Pouziti cyklu for.

Na ptikladech (obréazek 5.47) opét vidime, ze nemusime vyuzit vSech prvkia obecné syn-
taxe prikazu. Zejména pokud neuvedeme prirustek, bude system pracovat s hodnotou pri-
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rustku rovnou jedne. Piikazi, které se maji v jednom priichodu cyklem provést, mize byt
opét vice (a musi byt od sebe oddéleny stfednikem, ¢i dvojteckou).

5.8.3 Cyklus while
Syntax:

while podminka do prikazy end do

Na obrazku 5.48 je pomoci cyklu while ¢islo 112 celociselné délené dvéma, dokud je
zbytek po déleni rovny nule (zbytek po déleni uréime pfikazem irem).

x =112
112

while irem(x,2)=0 do x!Z% end do

56
28
14

7

Obrazek 5.48: PouZiti cyklu whaile.

5.8.4 Iterativni prikazy

Maple obsahuje nékolik iterativnich piikazi, které jsou optimalizovany pro urcité speci-
fické operace. Jejich prehled nabizi tabulka 5.2.

Tabulka 5.2: Prehled iterativnich prikazi

Prikaz Funkce

seq vytvori posloupnost

add vypocita numericky soucet

mul vypocita numericky soucin

select vybere operandy, které vyhovuji podmince
remove vybere operandy, které nevyhovuji podmince

selectremove | vypiSe zvlast operandy, které vyhovuji podmince, a operandy,
které ji nevyhovuji

map aplikuje operaci na operandy vyrazu

zip aplikuje binarni operaci na operandy dvou seznamt ¢i vektort
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Obrazek 5.49 ilustruje pouziti prikazi seq, add, map a zip na jednoduchych ptikladech.

m;-{:zdjni..ﬂ nqt:-{:—-f.l-p.+.‘l-;]
1.4, 2, 16, 25 *1'11'9_:!'!

seq( e, 180 [ 7,11, 13, 24])

i
mapix—=x", |7, 11, 13, 24
49, 111, 168, 576 ! l )

[ 45, 121, 1, 276 ]

addf( 1%, =1 .5)

mpllep)l —=x+pr [1,.23] (4 5.6]]
53 [$,7.9]

add( 1%, cim [ 7, 11, 13, 24])

:lpf'+'.1l. 1|J.|- ["*l srﬁ't]
Q14

(% 7.92]

Obrazek 5.49: PouZiti iterativnich prikazi.
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Summary

This book entitled Introduction to Mathematical Modelling Using Maple is primarily in-
tended for students and teachers of the study program Computational Biology at the Faculty
of Science, Masaryk University; however, it can be used by anyone interested in mathema-
tical modelling. The book provides a short theoretical basis in the field of mathematical
modelling, as well as several solved practical examples using the modern information and
communication technology (ICT) tool Maple.

The first chapter introduces mathematical modelling. It gives the definition of a mathe-
matical model, reveals the parts of the model, describes model types, shortly presents ICT
tools for work with mathematical models, and also mentions the notion of uncertainty in
mathematical models.

The second chapter presents methodology of mathematical modelling. It summarizes
the general principles in the mathematical modelling and characterizes the mathematical
modelling concept using ICT. The steps of creating the model are also mentioned here.

The third chapter illustrates several models from the field of population dynamics. The
first basic model of unlimited population growth is shown in detail at each step of the model
development. Then the limited population growth model and the population growth under
the predator pressure model follow as modifications of one population growth model. Further,
the models of interacting populations are presented. Competition models, Symbiosis models,
Predation models, or the classical predator-prey models of the Leslie type or Gausse type are
illustrated for the models of two interacting populations. The community of three or more
species model is shown in several examples at the end of the chapter. Each example in this
chapter is accompanied by a graphical illustration and by a Maple source code solving the
example. All the models are presented in both discrete and continuous form; however, for
the illustrations and computations of model of more than one population growth only the
continuous case is used.

The fourth chapter analyses data uncertainties of the unlimited population growth model
by means of three different methods: interval arithmetic, fuzzy sets, and probability analy-
sis. The sensitivity analysis of three models (unlimited population growth model, limited
population growth model, and population growth under the predator pressure model) is
performed here as well.

The final chapter is focused on a short introduction to Maple, release 14. This version
of Maple is also used here in the basic manipulation as well as in more complex tasks when
dealing with mathematical models.
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